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Computer Proficiency License (CS-001) 
Lecture 01

Introduction to Training Environment & Computer Basics 

1. Introduction

CPL stands for Computer Proficiency License, also known as VU-CPL. It is a computer based
training course offered to all who are interested in learning of the usage of computer applications,
after going through this course you will become comfortable and confident about computer usage. 

You can become proficient in the knowledge of computer utilization by using DVDs/CDs that are
designed specifically for this course. It has six modules.

Module 1 – Introduction to Computers
Module 2 – Using the computer and managing files 
Module 3 – Word processing 
Module 4 – Spread sheets
Module 5 – Presentation
Module 6 – Information and communication

2. Objectives 

The objective of the above mentioned six modules is to provide sufficient knowledge about the
computer and its utilization for you to perform your daily computer related tasks .with ease and 
confidence.

3. Training Environment of CPL 

Software being installed for this course has its own training environment. It is divided into different
parts for understanding and ease of use. Details of these areas are explained as under. 

1- Table of contents/Index area

Left side of the screen is called table of contents or index area where you will find lesson names
and subsections. You can browse these subsections using spacebar. To go back to previous
lesson use “backspace” key where as to repeat the same lesson, “enter” key is used.

2- Instruction area

The center-bottom bar is used for instructions during the lesson. 

3- Subtitle of lesson and duration

The top-center area is used for subtitle of lesson with its running duration in minutes.

4- Module Number

Module number is written at the top-right corner. For example, if you are using module 3: Word 
processing then the module number displayed will be ‘3’

5- About, help and exit buttons

At the left-bottom corner you will see three buttons.

Virtual University of Pakistan 
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About button shows the some basic information about the VU-CPL. Help button will open a new 
screen with instructions to run the modules. You can close the module by clicking at the exit
button.

6- Lesson presentation area or lesson screen

This is center area, where lessons contents, such as, text, animation and graphics is displayed.

4. What is computer? 

Computer is an electronic device that takes data, instructions and information as input and
produce output (information) after processing it.

It is a machine that process thousands of instructions in less than a second and produces outputs
as instructed or programmed.

5. Advantages of computers 

1- Efficiency

Machines are more efficient than humans. They can perform millions of calculations with less 
effort in no time.

2- Reliability

Work done by computer is more reliable than one done by humans. Computers perform
according to the instructions given to it that makes output or results produced by these more
accurate and reliable. For example, a computer can do millions of error free calculation in less 
than a second.

3- Storage

Computers give you an advantage of storing large amount of data in one place. For example you
can store the data of whole library in one computer.

4- Fast results

Computers are capable of doing many difficult tasks in very short time. Everyday the processing
speed of computers is increasing to make them work faster. Latest computers are capable of 
performing thousands of instructions and calculation in less than a minute which used to take
hours with old PCs. 

6. Basic terms for computer 

Input

Whatever goes into the computer is called input. For example text, graphic sounds etc. In every
day life the example for input is a voting slip in a ballot.

Input Devices

An input device is any peripheral (piece of computer hardware equipment) used to provide data
and instruction to computer, for example keyboard and microphone. Every day life example is a
hand that is used to put the voting slip in a ballot box. Thus hand is input device for ballot box.

Virtual University of Pakistan 
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Output

Anything that comes out of a computer is called output. For example sound of a playing video in
computer is the output. 

Output Devices

An output device is a hardware used to get the output from the computer. For example head
phones are output device and used for listening sound in computer.

Processing

Computer is given the data and instruction as input, which is processed to create output in the
form of information. Data is a raw form of symbols, numbers, images etc, whereas information is
an organized, meaningful and useful form of the data. 
For example, some data (student roll number, name, total marks, obtained marks etc) from the 
mid exam is entered. Computer process the data, and creates a report of pass and fail students.
This report is more organized and useful for us, and thus information rather than just data.

Storage

Storage, also referred as memory, is the ability of computer to store data, information or 
instructions. It can save digital data on RAM, hard disks or removable memory.

Storage Devices

Storage devices are used to store data when they are not being used in memory. The most
common types are floppy disks, hard disks and CD-ROM and DVD.

Hardware

Hardware refers to the physical elements of a computer. Examples of hardware in a computer are
the keyboard, the monitor, the mouse and the processing unit.

In contrast to software, hardware is a physical entity, while software is a non-physical entity.
Hardware and software are interconnected, without software; the hardware of a computer would
have no function.

Software

How does computer use its hardware? 

The term software refers to programs or sets of instructions that the computer uses to perform
computer operations. Software can also be described as a collection of routines, rules and
symbolic languages that direct the functioning of the hardware. Software is capable of performing
specific tasks, as opposed to hardware which only perform mechanical tasks what they are
mechanically designed for.
We can think or write instructions, but can not touch them.

Characteristics of software

Software is intangible (you can not hold it like hardware).
It is weightless.
It does not exist as hardware.

Virtual University of Pakistan 
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Software is use to operate the computer.

7. Types of Computers 

There are five basic types of computers.

Super Computers

Are the fastest computers, and because of their speed and memory, are capable of performing
operations that would not be practical for PCs or mainframes.

Advantages of super computers

High speed
Most Accurate
Most Expensive
Examples

Cray, ASCII white, Earth simulator etc

Mainframe Computers

Mainframes are computers where all the processing is done centrally, and the user terminals are
called "dumb terminals" since they only input and output (and do not process).

Mainframes are computers used mainly by large organizations for critical applications, typically
bulk data processing such as census. Examples: banks, airlines, insurance companies, and
colleges.

Examples
PTC, PIA, Banks and other organizations in Pakistan use main frame computers

Mini Computers 

These are powerful, expensive, comparatively less speed computers than mainframes, that are 
made for more complex procedures and are intended for one user at a time. Some of the
complex procedures consist of science, math and engineering calculations and are useful for
computer design and manufacturing.

Personal Computers

PC is an abbreviation for a Personal Computer, it is also known as a Microcomputer. Its physical
characteristics and low cost are appealing and useful for its users. Throughout the 1970s and 
1980s, home computers were developed for household use, offering some personal productivity,
programming and games, while somewhat larger and more expensive systems (although still low-
cost compared with minicomputers and mainframes) were aimed for office and small business
use.

Portable Computers

A portable computer is a small personal computer designed for mobile use. A portable computer
integrates all of the typical components of a desktop computer, including a display, a keyboard, a
pointing device (a touchpad, also known as a track pad, or a pointing stick) and a battery into a
single portable unit.

Virtual University of Pakistan 
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8. Summary

In this lecture we learnt: 
What is computer? How it is used in our daily life? 
Advantages of computer
Basic computer terms e.g storage, output, input etc 
Types of computer

9. Exercise 

In our daily life there are many devices that act as either input device or output device. List any 
five such input and output devices from real life. 

Search the market and identify two input and output devices that use the input data into the 
computer and get the output from computer, other than one mentioned in this lesson.

Virtual University of Pakistan 
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Computer Proficiency License (CS-001) 
Lecture 02

Input

1. Objectives 

The objective of this lecture is to provide answers to the following questions:
What is a keyboard?
What are different keys on keyboard?
What is their functionality?

2. Keyboard

It is an input device to give computer some input. It is like pen in writing. It is called keyboard
because it is comprised of a board with keys installed. Every key send unique information to
computer.

3. Keyboard types

There are different types of keyboards. Standard keyboard is the most commonly used keyboard.
Key arrangement can be different for these keyboards. Some may have special keys for other
tasks than just typing. These special keyboards are usually used for multimedia purposes like
video editing, sound design etc. 

4. Basic Keyboard keys

There are usually 104 keys on standard keyboard. Pressing the key once and releasing it is
called a key stroke.

Character keys

These are used to enter alphabetic characters. These characters become uppercase when 
pressed with shift key or caps lock is on.

Numeric keys

There are 10 numbers or numeric keys (1, 2, 3 to 9 and 0) on standard keyboards. These are
used in the same fashion as typewriters’ keyboard to enter numbers. These become symbols or
punctuation marks when pressed with the shift key.

For example

1- Shift + 8 will print * 
2- Shift + 4 will print $ 

Special keys

Shift, Alt and Control(ctrl) keys are special keys and when pressed with other keys, perform
special operations. For example ctrl+c will copy the selected file or text, shift+ character key will 
print that character in capital.

Escape keys

Virtual University of Pakistan 
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It is used to escape/exit from certain type of applications.

Function keys

F1, F2, …. F12 are called function keys. These are used for different purposes. For example F5 
is used to refresh the web page in internet browser. F1 will open help window.

Arrow keys

There are four keys(arrow Keys) for cursor navigation.
Left arrow key, Right arrow key 
Up arrow key, Down arrow key

Numeric key pad 

On the right side, a separate area is reserved for numeric keys, mathematical operational keys(+
, - , * , /) , enter, dot and Num Lock key.

Space Bar 

It is horizontal wide key, in the lower most row. It generates space between two characters.

Punctuation keys

These are keys to enter punctuation and are located  on the right side of alphabet keys. 

Enter key

Enter or return key cause cursor to go to next line, form or window to perform its default function.

Application key

It launches the menu with the keyboard rather than the usual right mouse button.

Toggle keys

Caps lock, Num lock and Scroll lock keys are toggle keys. At the top right corner, there are three
small lights to show the status of these locks. When pressed one, corresponding light is turned
on.
The keys on numeric key pad act as numbers and dot. When this key is pressed again and the 
corresponding num lock key light is switched off, the key act as arrow keys, home key, pg up, pg 
down and end keys. 
Characters become capital when the caps lock is on.
Scroll key modifies the functionality of arrow keys. When the scroll lock is on, the arrows keys 
would scroll the window instead of moving the cursor.

Print screen key

It is the key which is used to save (capture) all the contents of the screen in a temporary area.

Insert key

Key use to insert or overwrite character(s) within a word is called insert key. The key acts as 
toggle key. If it is in the insert state than any character pressed while the cursor is placed within a 

Virtual University of Pakistan 
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word gets inserted. If the key is pressed and it is in the overwrite state than any char pressed
while the cursor is placed with get overwritten. 

Home key / End key

It is used to go to start (home key) or end (end key) of the document.

Page up key / Page down key

It is used to go to previous (page up key) or next (page down key) page.

Delete key

The key used to delete characters.

Backspace key

The key used to delete the preceding characters.

Special keys

Alt, Ctrl and shift keys are non-typing keys. They don’t print anything when pressed. These when
pressed with other keys, modify the usual operation of that key.
For example Alt + F4 close the active window.

Tab key

Tab key is a typing key and used to put more than one space within characters or words.

5. Summary

In this lecture we have learnt: 
What is keyboard? What is its use? 

 Keyboard types
Standard keyboard keys
Character keys, Numeric keys, Bracket keys, Punctuation keys, Backspace key, Delete 
key, Tab key, Caps lock key, Num lock key, Scroll lock key, Insert key, Page up/down
keys, Functional keys, Special keys

6. Exercise 

Practice the usage of character keys placed on the keyboard by writing
A quick brown fox jumps over a lazy dog

Write the names and numbers of all the functional keys on your keyboard.
State the difference between typing and non-typing keys.
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Computer Proficiency License (CS-001) 
Lecture 03

Input Devices 

1. Objectives 
The objective of this lecture is to provide the answers to the following question:

What is a computer mouse?
What are its different forms?
Some other pointing devices than mouse
Input devices for image, sound and video

2. Pointing devices 

Devices used to point things at the computer screen are called pointing devices. For example
mouse, track pad etc 

Mouse

Mouse is a pointing device that works by detecting motion relative to
its supporting surface. Furthermore:

There are many types of computer mouse available in the market. 
They usually have different shapes or buttons, but they work almost
in the same fashion.

Mouse Buttons

There are two buttons on standard mouse
1- Right mouse button  2- Left mouse button

Mouse Pad is a surface used to sense the mouse motion.
Mouse Pointer/Arrow/Cursor shows the position and motion of mouse on screen.

Track Pad

Track pad (also known as touchpad) is a pointing device consisting of a sensitive surface that 
translates the motion of a user’s finger to a relative position on screen.

Track Ball 

Trackball is a pointing device with a ball placed in a socket with 
sensors to detect the rotation of the ball in 2-D. 

3. Other input devices 

Microphone

Virtual University of Pakistan 
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Microphone is used to input the sound to computer. It is used in motion pictures, radio and 
television broadcasting etc. 

Scanner
Scanner is a device that scans images, papers etc to store them in computer for later use. 

Digital camera/Web cam 

These are input devices that input still images or video to computer.

4. Summary

In this lecture we have learnt: 
What is computer mouse?
How to do clicking, double clicking, right clicking and dragging with mouse?
What is mouse pointer? 
Some other devices e.g track pad and track ball 
Input devices for image(Scanner), sound(Microphone), Video(Digital camera, webcam) 

5. Exercise 

Survey the market and find four different models of microphone that are used to input the voice 
into computer. Write their names and numbers.

What are the different devices through which we can input video to a computer?

Virtual University of Pakistan 
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Computer Proficiency License (CS-001) 
Lecture 04

Output

1. Objectives 

The objective of this lecture is to provide the answers to the following questions:
What is output?
What are the types of output?
What are the commonly used devices? 

2. Computer Output 

It means taking something out from computer.

3. Types of Output 

In general computer output is of 2 types 

1. Soft copy
2. Hard copy

4. Forms of Output

Text, Image, Sound, Multimedia (2 or more forms are combined for example text, image, sound) 

5. Output devices 

Printer – Print text or image being safe in computer on paper
Monitor – Output display
Speakers – Output sounds being played in computer
Multimedia projectors – Output multimedia

6. Printer and its types

Printer

It is an output device that prints image or text being safe in computer. The output is hard copy.

Types of printer 

1- Dot matrix

Dot is a spot of ink, whereas the matrix is a particular arrangement of dots.
It works like a typewriter and consist of pins. A pin makes a dot and combination
of dots forms characters and illustrations. Printing speed of a dot matrix printer is 
around 300 char/sec. 
Examples are Epson LQ 58 E, Microline 420

2- Line printer

Virtual University of Pakistan 
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It works like Dot matrix printer, just it prints a complete line at a time. It contains a
chain of pins that helps to print an entire line. It is superior in speed and quality.
Usually a line printer prints 200 lines/min.
Examples are Tolly T6218, Printrox P5220

3- Laser printer

It produces high quality graphics by using the same technology as in photocopy
machine. It prints a complete page at a time and works like a photopier. It can
print upto 6 pg/min. For printing laser printers use powder ink that is available in
cartridge. These printers are quite expensive.
Examples are HP laser jet 4300, Samsun ML 1710 

4- Inkjet printer

It has nosals which make dots to print. Inkjet printers are low in cost.
For example Lex mark Z35 Color Inkjet printer, Epson stlys C82 Color inkjet 
printer

7. Monitors and its types

Whatever is on screen is called display. Monitor is like TV and it output the softcopy of software
and programs in computer. Like regular TV, it has some buttons as well that includes Power
button and display adjustment buttons. 

Types of monitors

1- CRT monitors

These are cathode ray tube monitors and commonly used for personal use.
Examples are Philips Professional Brilliance 107P, Samsun syncmaster 551v

2- LCD monitors

Liquid crystal is used for the screen which is also used in scientific calculator. It got 
advantage over CRT monitors due to look, lightweight and compact size. These can
be adjusted in less space.
Examples are Samsung Synmaster LCD, Sony LCD monitor

8. Speakers

Different types of computer speakers are available in the market. These speakers work very
much like regular speakers.
Examples
 Yamaha 51
 Logitec z-640

9. Multimedia projectors 

Enlarge display and sound to have it on some screen. It works like a magnifying glass.
Examples

Epson Powerlite 8118 
Toshiba Digital Multimedia

Virtual University of Pakistan 
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10. Summary

In this lecture we have learnt: 
What are Computer Output and output devices?
Types of output
Commonly used device e.g Printer, Monitor, Speaker 

11. Exercise 

Find out the different sized that are available for 
LCD monitor, CRT monitor

Economical printer is which has less running expenses as compared to others. Figure out which
printer type is more economical and write its name and model. 

What is meant by built in speaker? 

Virtual University of Pakistan 
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Computer Proficiency License (CS-001) 
Lecture 05 

Storage

1. Objectives 

The objective of this lecture is to provide information about: 
 Computer storage

Types of storage
Commonly used storage devices

2. Storage 

Process of storing information in computer is called storage. The devices used to store data are
called storage devices.

3. Advantages of storages 

Information at different places can be saved in computer and can be re-used when needed.

4. Types of storage devices 

1 -Primary storage devices
2- Secondary storage devices

4.1 Primary storage devices 

Storage devices which are installed at the mother board are called primary storage devise. It is 
also called memory.

Types of primary storage

There are two types of primary storage devices
1- ROM 2- RAM 

ROM
ROM stands for read only memory. It is a storage device from which only stored information can
be read. It can’t be modified, delete or removed. It is like something written on stone that can not 
be removed or changed once written. It is permanent storage devise and data remains safe on 
ROM even when computer is off.
It contains information related to computer startup process which is written at the time of memory 
manufacturing. Computer cannot start without ROM.

RAM
RAM stands for random access memory. It is like something written on sand which is temporary
and would be erased. It is temporary memory, also called volatile memory. RAM stores
information which is currently processed by computer. When power off, it loses all the
information. Data can be read, stored, modified or delete from the RAM. 

Size of storage 

Byte is the unit for measuring memory. 1 byte means 1 character

Virtual University of Pakistan 
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For example Pakistan is consisting of 8 bytes. 

Byte is small unit 
1024 bytes = 1 kilo byte (kb) 
1024 kilo bytes =  1 mega byte (mb) 
1024 mega byte =  1 giga byte (gb) 

4.2 Secondary storage devices 

Why is secondary storage devices needed?

RAM stores info temporary, whereas we can’t store information on ROM. So we need some place
to store information, even when computer is off. It is also called non-volatile storage devices. For 
example floppy disks, hard disks, compact disks, magnetic tape etc. 

Advantages of secondary storage devices

1- More data can be stored as compared to primary storage devices
2- Information remains there even if power is switched off. 

Types of secondary storage 

1- Magnetic disks 2- Optical disks 

Magnetic disks 

Floppy disk and hard disks are considered in this category. 

Floppy disk 

Floppy means soft and disk means something flat and circular
A floppy disk can store up to 144 MB of data. 
Data is stored in circular tracks.
Floppy disk is covered by hard casing (shutter, magnetic, liner, shell, and notch)
If notch is opened than floppy disk becomes write protected that means that can’t be written on
the floppy disk and can only be read. You can write something about the content of floppy disk at 
the sticker attached at the casing. But use soft tip pen to avoid damage to the disk inside the
casing. Floppy is light weight, low cost, commonly used and biggest advantage of floppy is 
portability. It must be used with care or information saved can be wasted. It should keep away 
from magnet to safe from damage. The disk should not place in high temperature areas.

Floppy drive is used to read/write data on floppy disk. 

Hard disk

It is made of hard material, sealed in casing. More than one hard disk can be sealed in a casing
to increase the storage capacity in computer. Data is stored in circular form. Storage capacity of 
hard disk is very high and high volume of data can be stored here. Hard disk is more durable than 
floppy drive but it is not as portable as floppy. Don’t bring near magnets and should not place in
high temperature area.

Optical disks 

Virtual University of Pakistan 
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It is called optical disk because laser beam is used to read and write the data. Diameter is 4.25
inch whereas width is less than 1/20th of an inch. It is easily portable device.

There are four types of optical disks

1- CD ROM

CD stands for compact disk and ROM stands for read only memory. It is read only storage 
device, mostly used for audio, videos etc. 600 MB to 800 MB data can be stored. It is easy 
portable devices. CDs should not be scratched.

2- Write once read many(WORM)

It acts as CDROM after data is written on it once. It is used to store data, information.

3- Re-writeable CDs

CDs which can be read and write many times are called re-writeable CDs.

4- DVDs 

DVD stands for digital versatile disk. It was invented to store video only that is why previously
it was called as digital video disk. Its capacity is much greater.

DVD ROM – Data can be read from it, but can not be written, changed or deleted.
DVD RAM – It works like re-writeable CDs. Data can be read, written, stored or removed 
from it. Storage capacity is huge from 4.7 GB to 9.4 GB. It is easily portable.

4.3 Other storage devices 

Magnetic tape

It is like an audio cassette. Data is saved in line. Data saved first would be read first. It has huge
storage capacity. Keep it away from magnet to save from damage.

5. Summary

In this lecture we learnt about: 
Different storage devices (RAM, ROM)
Magnetic devices (HD, FD) 
Optical devices (CDs. DVDs)
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Computer Proficiency License (CS-001) 
Lecture 06 
Hardware

1. Objectives 

The objective of this lecture is to provide information about: 
 Computer hardware

Location where different hardware component are placed in computer
Purpose of various hardware components

2. Computer Hardware

Hardware refers to the physical elements of a computer. Examples of hardware in a computer are
the keyboard, the monitor, the mouse and the processing unit 

3. System Unit 

It refers to the box that encapsulates the processor, motherboard, CD and floppy drives, Hard
drives, memory, ports etc. 

4. Terms related to system unit 

Following are the terms for external parts of computer casing
.
Computer casing is the box that houses the computer
Power button is used to switch on the computer.
Restart button is used to restart (shutdown first and than automatically starts again) the 
computer
Lights shows the running status of the computer
CD ROM is the input device used to read data from CDs.
Floppy Drive is the input device used to read data from floppy 

Ports
It is an interface that links computer with other peripherals and monitor.

Keyboard port is a socket used to connect keyboard to computer.
Mouse port is a socket used to connect mouse to computer.
Serial port is a socket on a computer that is used to connect scanner, mouse etc. It got 9 
pins.
Parallel port is a socket at the back of the computer to connect printer. It got 25 holes. 
Pin sockets are used to connect speakers, microphone.
RJ11 jacks used to connect phone wires to computer.

Power connector is a socket used to supply power in computer
Power cable is used to supply power to monitor. 
Drive bay is a place where hard drives are installed using screws
Power supply provides power to processors, mother board etc 
Mother board
Processor is a brain of computer and does all the processing.
Fan is used to cool down the processor to avoid it from being damaged
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RAM chip is random access memory used by computer system to keep the running program
here.

Interface cards

Sound card is the interface used  to produce sound via speakers
LAN card is use to develop a network (more than one computer connected to each other) 
Modem is used to connect internet with computer

5. How does computer works?

Following diagram explain how a computer works In a very generic form. Data goes into memory
as input and from there it goes for processing. After processing it goes back to memory, from
memory it is sent as out put or it is stored.

Input
Memory

Process
Output

Storage

       Fig. 6.1

6. Summary

In this lecture we learnt information about:
Various hardware components of computer
System unit lights, buttons on it, front panel 
Ports such as serial ports, parallel ports, USB ports, RJ 11 ports, Pin sockets
Drive Bay, Power supply, Motherboard, Card slots, RAM slots, Processor, Fan 

7. Exercise 

1. If you have a computer, first detach all peripherals (keyboard, mouse etc) and then attach 
again

2. Write down difference between serial and parallel ports of computer
3. What is RJ11 jack and why it is used in computer?
4. Write down the difference between motherboard and processor
5. Visit the market and find out the varieties of system units.
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Computer Proficiency License (CS-001) 
Lecture 07 
Software

1. Objectives 
The objective of this lecture is to provide information about: 

What software is? 
Types of software 
Tasks performed using software.
What software version is?

2. Computer Software

Software is a set of instructions. It can not be touched. Hardware does not work without software. 
It gives instructions to hardware to perform some functionality. 

Software versions
Software are developed and are periodically updated. When a software is updated and a new
copy of this updated is available in the market it is called a new version of a software,  for 
example  Win 95, win 98, win NT, win 2000, win XP 

3. Types of computer Software

There are three basic types of computer software.
1. System software
2. Utility software
3. Application software

3.1 System Software

It maintains and control computer hardware. There are two kinds of system software. 

1. Operating system
2. Device drivers

1- Operating System

Operating systems manage and coordinate the activities of the computer hardware and other
software.

2- Device Drivers

It manages hardware. Like a driver of a car. Operating system tells what to do to driver and than
driver is responsible for action. For example operating system knows which driver to access when
a print is required and than printer driver is responsible to take the print. 

3.2 Utility Software

It manages hardware, operating system or application software and perform specific task. It 
performs tasks like maintenance, troubleshooting, virus scanning etc. Disk scanner and antivirus
are example of utility software. 
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3.3 Application software

Software belongs to this category helps in daily life tasks like calculation, presentation, text 
editing etc. This is most commonly used type of software. 

1- Word processor

It is complex form of text editors that use to provide use the basic functionality of saving, editing,
updating, formatting text. These got spell and grammar checkers. MS word is most common and
widely used word processor. 

2- Spread sheet

It helps in accounting and finance work. It contains cells (Rows and Columns) that contain a
value. Different formulas can be applied on these values using by default functions.
MS Excel is most common used software for developing spread sheets.

3- Presentation software

MS PowerPoint is presentation software that is used by business people, educators, students and
trainers to present some idea or information in form of text, image or sound. It consists of pages
or slides that may be arranged in a consistent style to give a feel of presentation.

4. Microsoft

It is the one of the biggest software companies in the world. It has developed famous windows
and application software like MS word, MS excel, MS power point etc. 

5. Summary

In this lecture we learnt: 
What software is? 
Types of software 
Users and functionality of software
What is meant be version of software? 
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Computer Proficiency License (CS-001) 
Lecture 08 

Internet

1. Objectives 

The objective of this lecture is to provide information about: 
What is meant be Internet?
Services available over internet
How to access internet? 

2. Internet 

Internet is network of networks. It doesn’t belong to any one and non one runs it. People around
the globe access internet via telephone line or satellite. 

How to access it? 
Internet Service Provider (ISP) is a company or organization that connects the users with internet. 
ISP is always connected to internet and people who want to access internet, connect it via their 
local ISPs.
It is used to share information and resources over internet.

3. Services over Internet 

1- World Wide Web 
2- Email 

World Wide Web 

Web meant net. It was originally designed to share information among scientific community. But 
now it is the most popular way of sharing information.

Web page is a resource of information written in html.

Web browser is software that is used to view webpage. Internet explore is one of the famous 
internet browser.

Web site is a collection of related web pages. Every website has a unique address to access it. It 
is called uniform recourse locator (URL). For example www.vu.edu.pk is the url for the virtual 
university’s website. 

Links provide us the access to other web pages in website. You may have seen links like home,
contact us, about us etc.

Advantage of web is availability of huge resource of information. For example temperature of 
different parts of world is available over the web and

How to reach the web? 
1- Connect telephone line to computer
2- Connect to ISP

a. Enter ISP phone 
b. Enter user name and password to connect
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3- Open browser
4- Enter URL and browse internet

Email

It is like regular mail just with a small different that you need computer to read, write or send
email. It is used for communication between people who are at some distance.  Its delivery is 
faster, safer than regular mail. Probability of losing t is very low and it can be viewed from 
anywhere in the world as it resides on internet.

Email address is used to send email from one pc to another. e.g info@vu.edu.pk is email address
to send email to Virtual University of Pakistan. 

Email client is software to compose, sent, receive or read email. You can access your emails
from anywhere in the world. All you need is email id and password provided. This ensures
authenticated access to your emails. Password is a secret word, used to uniquely identifies the 
user. Some famous email clients are MS outlook, Neo mail, Lotus notes.

4. Summary

In this lecture we learnt about: 
Internet, web, email 

 Web site, WebPages

Virtual University of Pakistan 
26



Computer Proficiency License (CS001) VU

Computer Proficiency License (CS-001) 
Lecture 09 

Security

1. Objectives 

The objective of this lecture is to provide information about: 
What is meant by security of computer?
Risk associate with computer.
Methods of protection against these risks

2. Security Risks 

There are risks associated with hardware, software, data etc that can cause a big loss to the 
owner. One should do preventative actions to avoid these security risks. 

Types of risks

1- Hardware theft
Save hardware/computer from stealing by placing it somewhere safe.

2- Virus 
Computer virus is software that damage computer. For example it may cause
your computer to restart when you open MS word. 
Antivirus software is used to eliminate virus from computer. It scans hard disk to
find virus and terminate them. It also stops entering new virus into computer.
New versions of antivirus, help to prevent viruses to damage computer or data.

3- Unauthorized access

If you don’t want someone else to access your data in computer, you can protect
your computer/data with password. It will reduce the risk of unauthorized access 
to your pc. Password is a unique word that identifies the user.

4- Backup 

Data saved in your computer may lose due to some reason. In case of having its
backup (same data at some other place/storage device) you can access and use
it. Backup is the process of copying data. For example you have prepared a
presentation and due to virus attack it got damaged or deleted. If you have its
backup file at some secondary storage media like floppy etc, you can restore the
presentation from that device.
Backup utilities help to organize backup data (that data being copied).

5- Software piracy

If some one copy and sells the software of any developer or company without its 
permission, than he is doing piracy. It is of the biggest problem, software industry
is facing now. Copying and selling software in such manner is against software 
copyright act.
According to the copyright act

If someone steals the software
 Or 
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Copies or sells it without the permission of the owner/developer
Legal action is taken against him. 

3. Summary

In this lecture we learnt: 
What is hardware security?
Different types of security risks
What is meant by computer virus? 
What is meant by anti-virus? 
What does data backup means?
What is software piracy?
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Computer Proficiency License (CS-001) 
Lecture 10 

Computer Environment 

1. Objectives 

The objective of this lecture is to provide information about: 
How to start, turn off and restart computer?
Basic windows structure and properties
View computer’s information

2. Starting the computer 

Press the power button on system unit to start the computer. The area you will see on the
monitor screen, after computer a start is called desktop. It is called desktop because you can
use it like the top of the desk to place the icon or shortcut to your favorite programs or soft wares.

Window is software developed by Microsoft which is usually called Microsoft windows. Window
has different versions like window 95, window NT, window 2000, window XP etc. Although these
versions are similar to each other but every new version is better than the previous with and
provides new features as well.

ICON is a graphical representation of files, folders, disk drives, toolbar buttons etc. Name of the
icon, file, folder etc is written just below it. The word icon came from the Greek word “eikon” which
means image. Still religious pictures are called Eikon in Greek. In windows, these icons are links
to software to open it with double click of the mouse. You can design such icons yourself as well. 

Taskbar is the bar at the bottom area of desktop (monitor screen). Icons of our tasks and
software being used will appear here. It is called taskbar because it shows the tasks being carried
out in computer. Start button reside at the left side of the task bar. At the right side of this button,
quick launch bar exist. Icons reside here open their respective programs with single click. System 
tray exist at the right side of the task bar, which may contains some icons like antivirus programs,
firewall software etc. Icons in system tray represent programs which work in background. For 
example an antivirus program works consistently in the background to protect your pc from
viruses and only icon display here. In the same system tray, there is a clock indicating the system 
time. It is called system clock.

3. How to shut down the computer? 

Click on start (located at the bottom left side of the task bar on monitor screen). A list of program 
names and commands will appear. Click on the option “Shut down”. A dialogue box of shut down
will appear in front of desktop. Desktop will turn into gray color. In a drop down menu there, you 
can see the options like Log off, Restart, Shutdown, and Standby by clicking at the arrow on the 
right side. There are three buttons Ok, Cancel, and Help at in the dialogue box. Clicking on OK 
button will shutdown your PC.
Old computers show shutdown message on screen that “It is now safe to turn off your computer”
Turning off your computer during work may damage your pc and all data will be lost.

4. How to restart computer? 

You may need to restart the computer.

Why we restart computer?
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There can be several reasons for restarting computer. Like new installation of any software can
ask for restart, or computer suddenly stop working (halt).
To restart your computer, click on start button at the taskbar. Click on shutdown to open the
shutdown dialogue box and select restart from the dropdown menu. It will shutdown the computer
and starts it again.

5. Window and its structure 

Basic windows properties

If you are using windows XP for the first time, you will see only one icon “Recycle bin” at the 
desktop. Right click on the start button and select properties. Choose “classic start menu” option.
New icons will appear on the desktop. 

Click on “My Computer” icon. A new screen will open. It is called window.
Title bar 
A bar at the top of the window is called title bar. It has 

1- Current window’s name 
2- Buttons to restore down Maximize/Minimize and Close the window.

Desktop can’t be seen when any window is maximized. Icon for closed windows does not appear
at the task bar.

Menu bar 
This bar resides below the title bar. It has few words like File, Edit etc, when you click at any of 
these, a list/menu will open.

Standard bar
It contains buttons to facilitate us during work. Due to their utility, these are called standard tools. 

Status bar 
It resides at the bottom of the window. It provides some information related to that window.

You will come across so many other windows while working with your computer. Every window 
will perform a new task for you.

12. Summary

In this lecture we learnt about the basic system properties

13. Exercise 

Task 1:
Look at the front panel of your system unit. There is a small button other than the power
button. Find out what is the use of this button.

Task 2:
Click on the Start button and then choose Shut Down. Find out what is the use of the
option “Stand by”. 

Task 3:
Using the help feature of Windows XP, find out what is the use of Hibernate option and
how to enable it on your system. 

Task 4:
Open My Computer window and press Alt + Spacebar keys. Observe what happens. Can
you see some useful change in the window?
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Computer Proficiency License (CS-001) 
Lecture 11 

 System properties

1. Objectives 

The objective of this lecture is to provide information about: 
View the computer’s desktop settings
Be able to format the floppy disk 
Use available help functions

2. Basic System Information 

Information like what hardware, software, operating system etc is used in system is called basic
system information.
Right click on “My Computer” and select “Properties”. You will find information like operating
system name and version, registration data, processing speed and RAM size. Your computer
may have different RAM size like 64 MB, 128 MB, and 256 MB etc. 

3. Changing date and time 

Double click at the system clock in the system tray at the taskbar of the desktop.
Date and time properties will open. You can change time and date. 

4. Changing the wallpaper

Right click on the empty area of the desktop. Select properties from the menu. Display properties
will open. Select the tab that display “Desktop”. Select the background and click on OK button. 
You can also choose wallpapers other than given in list by using the “Browse” button. Drop down
menu below Browse button, give you position options that are Center, Tile and Stretch.

Computer generated images are created by using several colors. More colors make an image
better.
To change the display settings, bring the same display properties window.
Right click on the empty area of the desktop, select properties, and select “Settings” tab. Now you
can change color quality (16 bit, 32 bit etc) and screen resolution (640 by 480 etc). 
There are two more buttons in this window.
Troubleshoot – we click on this button when we need some help from computer
Advanced – It is the option to change the internal hardware settings of the computer.

5. Changing the Screen saver 

At the old time, when monitors had no automatic shutdown system, screen savers were used to
save the screens. Picture tube surface has a permanent image embedded in it. This is called 
screen burn out and results if computer remains on for long time, and show the same
window/picture.
To change the screen saver, select the screen saver tab in display properties. In drop down
menu, you will find a list of names of screen savers. You can select any one from these with the 
wait option. This option will wait for the selected number of seconds/minutes and after that start 
screen saver if screen remains unused. You can preview the selected screen saver by clicking on
“Preview” button. To remove/stop screen saver, press any key on keyboard or move mouse.
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6. Help feature

Open “My Computer” and press F1 (functional key). A help window will open. You can find help
about any topic. For example, if you need to find out about the way to change the desktop color.
Enter desktop color in search option and press enter or click on the button in front of text area.
You will find the results against your search. Click on any option you find appropriate to get the 
complete information related. 

7. Formatting a floppy disk 

Insert the floppy into the floppy drive. Open My Computer and right click on the icon of the Floppy
Drive. In the menu, select the “Format...” option. Choose quick format and click on start button.
Floppy disk will be formatted and all data will be removed.

8. Summary

In this lecture we learnt: 
 Basic system properties

How to configure computer’s desktop
How to take help from computer 
How to format the disk

9. Exercise 

Task 1:
Open My Computer window. Right click on the icon of My Computer that appears in the
task bar. Choose the “Close” option from this menu. Observe what happens.

Task 2:
Is the floppy of 3¼ inches the only size available in the market? Search around and find
out which other sizes are available.

Task 3:
Use the Help and Support menu of Windows XP and find out how to customize your
computer. You will find a link labeled as “Customizing your computer”.
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Computer Proficiency License (CS-001) 
Lecture 12 
Desktop

1. Objectives 

The objective of this lecture is to provide information about: 
How to arrange desktop icons? 
Recognize and use of icons
How to resize and move the window?
Difference between active and inactive window
Understanding the terms: File and Folder

2. Working with Icons

You can see different icons on desktop. Every icon represents software. It means that associated
software starts working if icon is double clicked. Icons on a desktop are placed in a certain order,
but you if you want, order can be changed.

Moving an icon 

To move an icon, we have to select it first.
Click on icon and without releasing the button to the position you want to place
Release the mouse 

Auto arrange option 

If auto arrange option is selected for desktop icons, we can not change icon’s location. 
If icon is moved, it will go back to its place. 
To turn off this option, right click on empty area of desktop. 
Select “Arrange Icons” and go to “Auto Arrange” Option.
If you see an arrow before this option, click on it.
It will turn off “Auto Arrange” option 

Arrange icons

Icons can be arranged in four ways 
Right click on the empty area of the desktop. 
Move the mouse over the first option “Arrange Icons By”

A sub menu will open with four options 

Name  - It will arrange icons with respect to their names in alphabetic order
Size  - It will arrange icons with respect to their sizes 
Type  - It will arrange icons with respect to their types 
Modified - It will arrange icons with respect to their creation date 

3- Important desktop Icons 

My Computer – Access to computer drives, Basic computer information
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Recycle Bin – It resembles to the waste bin, and got a recycle logo on it. It got all the deleted files 
or folders from the computer. If we want, we can restore deleted files from recycle bin but if once 
these files are deleted from the bin, we can not have them back. 

To delete the file or folder, select it first by clicking on it once. Now press “Delete” button on 
keyboard. Click on Ok in the delete confirmation dialogue box. The file or folder is deleted now.

To restore the deleted file, select file and click on “Restore this item” option on the left side of the 
Recycle bin’s window. File will be restored and go back to its original place.

To delete the file permanently, open Recycle bin and click on “Empty Recycle Bin” option on the
left upper side of the Recycle bin’s window. File will be deleted and the space occupied by this file 
is available for use now.

4- Resizing and moving a window

To resize a window, select window’s bottom right edge and drag inside or outside without
releasing the mouse. We can resize a window by dragging any of its edge with mouse pointer.

To move a window click on the title bar of the window, and move it without releasing the mouse.

With the help of scroll bars, we can see the content of window, which wasn’t visible before. There
are two kinds of scroll bars in window.

1- Vertical scroll bar to scroll the window in up and down direction.
2- Horizontal scroll bar to scroll it left and right direction.

No matter how many windows you have opened, you can work only at one of them at a time. Title
bar color of the window that is in use is different from other windows. The window that is in use
has a dark colored title bar and is called active window. The window that is not in use has a light
colored title bar and is called inactive window.

5- Understanding files and folders 

In computer data is saved in form of files. We put these generated files in folders on hard disk. To
access our desired file, we have to open associated drive and than folder(s). This is called the 
path to the file. For example we have a file “song1.mp3” in folder “Songs” which is placed in drive 
C. To access song1.mp3, first we will open drive C, and than folder Songs. In this case
C:\Songs\song1.mp3 would be complete path. 

Window Explorer

With the help of this window, we can browse the folders and files in our computer.
Click on Start > All Programs > Accessories > Windows Explorer
It has two parts unlike any other window e.g. my computer’s window

1- List panel on left side 
2- Detail section on right side

In list panel we can see two kinds of signs

1- Plus (expand) sign – This sign only appears before hard drive and folder, incase they got 
more drive partitions, folders or files. Once clicked + sign, will change it into – sign. 

2- Negative (contract) sign
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File and folder tree- It is a list of folders, their sub folders and files in window explorer.

6- Summary
In this lecture we learnt: 

How to arrange desktop icons? 
Recognize and use of icons
How to resize and move the window?
Terms such as active, inactive window, File, Folder

7- Exercise 

Task 1:
On your own computer's desktop, try to arrange icons in different order i.e. by Name,
Size, Type and Modified. 

Task 2:
Right click on your desktop, click on the “Arrange Icons by” and then click on “Auto
Arrange” option. Try to drag and move the desktop icons now. Observe what happens to 
these icons.

Task 3:
Now turn off the “Auto Arrange” option from the same menu you used in the previous
step and then try again to move the icon.

Task 4:
Open WordPad window and click on its restore down button if it is maximized. If you look
at the bottom right hand corner of the window, you will find some gray dots. Using your
mouse pointer, click and drag this corner. Observe what happens.

Task 5:
Open at least 3 different software windows. Now carefully right click on the empty portion
and choose the option “Title Windows Vertically”. Observe the arrangement of windows.
Similarly try the options of “Tile Windows Horizontally” and “Cascade Windows”.

Task 6:
Open at least 3 different software windows. Now press the Alt and Tab keys from the
keyboard simultaneously. Observe that a small panel in the center of the screen will open
up. This feature is called Application Switcher. Keep the “Alt” key pressed and press Tab
key again to move between the icons shown in the panel. Choose any of the icons in this
panel and release both the keys. Observe what happens.
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Computer Proficiency License (CS-001) 
Lecture 13 

Organizing Files 

1. Objectives 

The objective of this lecture is to provide information about: 
Learn about files, folders, properties
How to rename, copy, paste files 
How to save, delete, search files 

2. Working with folders

To create a new folder, right click on the empty area of the desktop and select New < Folder
New folders are always named as “New Folder” by computer. Folders within folders can be
created. These are called sub-folders as they reside inside some main folder. The purpose of 
creating folders within folders is to organize our data in a structured form. 

To view the properties of a folder 
1. Select the folder. Go to File menu and click on Properties. A new window call Properties

Panel will open.
2. Right click on a folder. Go to Properties.

Window Properties Panel consists of three tabs. 
1. General Tab – It will have Folder name, type, location on computer, size and number of

files and subfolders, date and time folder was created on, attributes(read only, hidden) 
2. Sharing Tab
3. Security Tab

To rename a folder, right click on the folder, and select Rename. Enter new name in place of 
highlighted text.

3. Creating application files 

Computer based document is called file. You require application software to create files like 
notepad, word pad or MS word.
To create a new file, right click on the empty area of the desktop. Go to New and click on the file
type you want to create. For example to create a new word document, right click on the desktop,
Go to New and select MS Word Document.
To view the properties of software, right click on the file. File Properties window will open. 
To rename a file, right click on that file, and select Rename. Enter new name in place of
highlighted text.

To select a file, simply do a single click on it. 
To select multiple files

1. Click on area near to one file and than drag around all files you need to select.
2. Hold down Ctrl key and select all those files that need so be selected.
3. To select adjacent or icons in a row, press Shift Key and select those icons.

We may need another copy for any file/folder for backup or further use.
Copy would simply make another copy of the file/folder in memory, however the file will remain at 
its current location, and can be pasted(as another copy) at any other location by using the paste
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option, whereas cut would delete the file/folder from the current location  and can be pasted by
using paste option.
To copy a file/folder, select that file or folder and press Ctrl + C or right click on it and select
“Copy” option

To cut a file/folder, select that file or folder and press Ctrl + X or right click on it and select “Cut”
option
To paste a copied or cut file, press Ctrl + V in folder or drive or right click where you want to paste
the file and select Paste option.

To make backup files/folders
1. Copy the file/folder to another secondary storage device like floppy disk.
2. Right click on the file folder and move your cursor to “Send To” option. Select “3 1/2

Floppy” option.

To delete a file or folder
1. Select a file/folder and press “Delete” button on keyboard
2. Right click on the file and select Delete option from menu.

To search a file or folder click on the start button in task bar. Select “Search” option in the menu.
In the left side, there is a search panel that can help you to find a file with the following options.
You can find the file with the complete or partial file name, a word or phrase in the file or just
select the location to see all the files and folders in that location. 

4. Summary

In this lecture we have learnt: 
About folders and their properties
Commonly used files and their properties
How to rename files, folders
How to save, delete and search files, folders 

5. Exercise 

Task 1:
Open My Computer and then open C drive. Right click in the empty white space; choose
the “New” option and then the “Folder” option to create a folder. Name this folder as “VU-
CPL”. Now within this folder you have to create 5 more folders by the following names:
Exercise 2.1, Exercise 2.2, Exercise 2.3, Exercise 2.4 and Exercise 2.5. This folder
structure will be used in the next exercises.

Task 2:
Create a file on the desktop and then check its size ( hint: right click on file icon and then
choose properties ).

Task 3:
Put a floppy disk in floppy drive of your computer. Click on Start button and choose the
“Run” menu. Type “A:” (without the quotation marks) in the available text box and press 
OK button. Observe what happens.

Task 4:
Select a file or folder and then press F2 key (F2 is a function key that is located on the 
top row of buttons on your keyboard). Observe what happens to the icon. Explore what
you can do at this moment.

Task 5:
Open “My computer” and then open C drive. Click in empty white space with your mouse
pointer once. Press Ctrl and A keys from the keyboard. Observe the effect of this shortcut
combination.
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Task 6:
Create two folders on your desktop (Hint: Right click on the desktop and choose “New” 
from the menu ...). Give them appropriate names. Now open these folders and create a
file in each of these folders (hint: right click & choose “Text Document” from the “New”
option). Now select file from one of the folder and press Ctrl and X keys simultaneously
from the keyboard. Click in the other folder and press Ctrl + V from the keyboard.
Observe what happens.

Task 7:
Put a floppy in the floppy drive and then open My computer. Right click on the floppy
drive icon. Choose the properties option to check the capacity of the floppy. Also note the 
free space available. 

Task 8:
Select any file from the C drive of your computer. Right click on it and check its size. Can
you copy & save it in a floppy?

Task 9:
Open the search file window (hint: Click on Start button & choose search option ... ). Type 
“ *.txt ” (without quotation marks) in the first text box and press enter from the keyboard.
Observe the results of the search. What do you infer from this example?

Task 10:
Press F1 key from the keyboard to open Help window. Type “Wildcard” in the text box 
and press enter from the keyboard. Learn about the use of wildcards in searching files. 
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Computer Proficiency License (CS-001) 
Lecture 14 

Introduction to Text Editing 

1. Objectives 

The objective of this lecture is to provide information about text editing software.

2. Explaining Text Editor 

Text editor is software that helps in editing text. There are several Text editing soft wares
available on internet like Note pad, Text pad etc. 

Word processor is the advance form of text editing software. We use text or word processors to
create word document. If you are using windows operating system, than Notepad and WordPad
are installed by default in your system.

For more clear understanding, you should consult vu-cpl’s software available at Virtual University
of Pakistan. 

3. Summary

We learn about text editors and how to use them. 

4. Exercise 

Task 1:
Click on Start button & choose the RUN Menu. Type notepad in the space available and
press enter from the keyboard. Observe what happens. You can also try opening
WordPad in the same way.
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Computer Proficiency License (CS-001) 
Lecture 15 

Working with Text Editor 
1. Objectives 

The objective of this lecture is to provide information about Working with text editor 

2. Basic functions 

To open a notepad go to Start < All Programs < Accessories < Notepad
To save a new file go to File < Save as...

To save the text written (modifications) in already saved file go to File < Save

To save the file in a new location go to File < Save as… and save the file with another name.

For better understanding, you should consult vu-cpl’s software available at Virtual University of 
Pakistan.

3. Summary

In this lecture you have learnt:
How to type text in the text editor and how to save the file 
How to save file with a new name and new location 

4. Exercise 

Task 1:
Open All Programs menu and then click on Accessories. Locate the notepad option.
Single click on this icon and carefully drag this icon on to your desktop. This action will
create a shortcut of Notepad application on your desktop. You will be able to run Notepad
by double clicking this icon in future. 

Task 2:
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Open WordPad from the accessories menu (Hint: Click on Start button, go to All 
Programs and then Accessories menu). Type any text you like and then press Ctrl and S
keys simultaneously from the keyboard. A window will open up; recall what you can do
with this window. 
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Computer Proficiency License (CS-001) 
Lecture 16 

Closing an Application 
1. Objectives 

The objective of this lecture is to provide information about closing Text files and Editor 

2. Closing the File 

To close the file click on the Close button at the title bar

3. Closing the Editor 

To close the Editor follows any of these. 

1- Click on the Close button at the title bar 
2- Go to File < Exit

It will exit the Editor and close the opened files. For understanding the procedure, you should 
consult vu-cpl’s software available at Virtual University of Pakistan. 

3. Summary

In this lecture you have learnt how to close an application window

4. Exercise 

Task 1:
For this exercise we will need the VU-CPL folder that was created in the exercise of third 
lesson. If you haven't created the folder then complete the 1st task from the exercise of
third lesson. Now open WordPad and type any text you like. Press Ctrl and S keys from
the keyboard to save the file. In the “Save in” drop down box, try to locate a folder in C
Drive by the name of Exercise 2.4 in the VU-CPL folder. Save the WordPad file in this
folder.

Task 2:
Open Notepad and type some text in the file. Save this file in Exercise 2.4 folder. Now
press Alt and F4 key from the keyboard (F4 is a function key that is located on the top
row of buttons on your keyboard). Using this key combination will close the window. Try
this combination on any open window.
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Computer Proficiency License (CS-001) 
Lecture 17 

Saving files on Floppy
1. Objectives 

The objective of this lecture is to provide information about Saving files and folders on secondary
storage devices

2. Closing the File 

To close the file click on the close button at the title bar

To save the file on floppy 

1. Right click on the file and select Send To < 3 ½ Floppy Drive
2. Select file and press Ctrl + C, Double click on My computer. You can see Floppy drive’s

icon there. Double click on this icon to open the drive. Click on an empty area of the
drive and press Ctrl + V to paste the file there. 

You should consult vu-cpl’s dvd to view these steps in animation. 

3. Summary

In this lecture you have learnt how to save files and folders on floppy

4. Exercise 

Task 1:
NOTE: Before doing this task, you have to insert a floppy disk in your floppy disk drive.
Open WordPad and type a few lines in this file. Press Ctrl and S keys from the keyboard.
Give this file a name and then locate the option of floppy disk in the “Save in” drop down
box. Choose this option and then press enter from the keyboard. After the saving process 
is completed, open My Computer and double click on the floppy disk icon. Is your file
there?

Virtual University of Pakistan 
43



Computer Proficiency License (CS001) VU

Computer Proficiency License (CS-001) 
Lecture 18 

Print Management 

1. Objectives 

The objective of this lecture is to provide information about 
How to install a printer? 
Be able to take prints
Change the default printer
View job print status from the print manager

2. Printer 

Printer is hardware. It outputs hardcopy (print on paper) of some file on your computer.

3. Installation 

Installation or setup means to connect a printer with computer and copy necessary software on
the computer. It can be divided into (1) Hardware Installation and (2) Software Installation

Hardware Installation 

Connect the main power cable to power socket 
Put the USB cable into USB socket 
Switch the main power on.
LED on the printer panel will be on. It indicates the printer is on and ready for taking prints.

Software Installation 

Click on the start < Control Panel
Double click on the icon “Printers and other hardware” in control panel window.
A new window will open. Click on “Add a printer” option here to open the “Add hardware
wizard”
Click on next button once 
Select the radio button against “Local printer” option and also check following option of “Auto
detect”
Select the “Automatically install the printer (Recommended option)”
Insert the CD containing printer-driver in CD Rom and than click on the next button 
Computer will copy and install all the required driver files and set it as default printer. Incase you
want to use this printer as the default printer click on next button. 
If your printer is not connected to any network, use “Do not share” option and click on next 
button.

4. Printing from installed printer

You can use any of these to get the print of your document.

1. Open your word pad or MS word file. In the menu bar, you can see an icon with “printer
shape” Click on this icon to get the print.

2. Click on File < Print.. and press Ok.
3. Press Ctrl + P to get the print of your document.
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5. Print job status 

To view the print job status

1. Click on the start < Printers and Faxes
2. Click on the printer icon representing printer, you sent prints to 
3. A new window for this printer will open which will display the information such as

Document Name, status, Owner, Pages, Size, Submitted date/time and port etc. 

6- Summary

In this lesson you have learnt:
How to attach and install a printer with computer
How to take prints of any file 
How to use printer 
How to view job status

7- Exercise 

Task 1:
Visit some office and explore how they use printers in a network environment.

Task 2:
There are different types of printers available in the market. If you have to buy a printer,
which factors will you consider deciding which one is best for your requirement?

Task 3:
When the printer ink cartridge or laser toner is used up, what will you do with it?

Task 4:
Open a WordPad file which has some pages of text in it. Press Ctrl and P keys from the
keyboard simultaneously. Click on the radio button beside the Pages text box and type 
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“1-3” (without quotation marks). This setting will only print the first three pages of the
current document.

Task 5:
Open a Notepad file and choose the print option from the file menu. From the print panel,
increase the number of copies to be printed.
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Lecture 19 

Basic concepts of word processing 

1. Objectives 

The objective of this lecture is to provide information about 
Open and close a word processor
Open one and several documents
Create a new document based on a document
Save a document
Switch between open documents

2. MS word Application 

To open a MS word document move the mouse cursor to the following path

Start < All Programs < Microsoft Office < Microsoft Office Word 2003 

After clicking on the last option “Microsoft Office Word 2003” in the sub menu you will a dialogue
box with “Microsoft Office Word 2003” written on it. This dialogue box is called splash screen.
After few seconds splash screen will disappear and MS word will open. 

3. Explaining Screen Layout

Default screen layout is the layout of MS word when it is opened. We can change the default
layout according to our will.

In title bar, Name of the document with “Microsoft word” is written. If it’s a new document and not
being saved yet, it will have temporary name like Document1, Document2 etc 

A file created by word processing software is called document.

4. Different Toolbars 

At the right side of the title bar, you can see three buttons

1- Minimize button – This button is used to minimize (An open window will appear as icon
in task bar) the word document. To maximize this window, click on its icon at the taskbar.

2- Restore down button – This button is used to restore down the window to a smaller size
on desktop.

3- Close button – This button is used to close down the document.

Menu bar is a bar just below the title bar of the document. It contains menus (File, Edit, View etc) 
to give specific instructions to word processor. For example File menu contains commands like
Save, Close, Exit for the open document. Edit menu contains editing related commands like cut,
copy, paste for the text of word document.

Separator is a dotted vertical line between two adjacent toolbars in MS word.
To separate two toolbars, move mouse cursor over separator between these two toolbars. Mouse
cursor will change its shape into four headed arrow (cross). Without releasing the mouse button,
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drag this toolbar to desire location (Below the preceding toolbar, or in the document area).
Toolbar will automatically adjust it self and hidden icons will appear in both toolbars. 

Below Menu bar, there is another bar called Standard tool bar. It contains icons/buttons to 
perform all important (standard) task of word processor like cut, copy, paste, save, print etc.

Formatting toolbar resides next to Standard tool bar. It contains menus, buttons etc to format 
the text in word document.
Task Pane is a panel visible on the right side of the document in default layout. It contains
options like getting started, Open a document, create a new document etc. 

In the center of the document, you can see white area with blinking line. This white area is called 
page and the text we type will appear here. Blinking line is called cursor or typing pointer.

Zoom option in standard tool bar helps to increase or decrease the zoom option of a document.
To view the complete page, select “Page width” option from the zoom drop down menu.

There are two rules places in a document.
1- Horizontal ruler
2- Vertical ruler

These will give you a measure of width, length and margin of the page.

MS document also contains two scroll bars

1- Vertical scroll bar is used to view page(s) of a document
2- Horizontal scroll bar is used to move page in left or right direction

Status bar is a strip below horizontal scroll bar. It contains information like page no, section no,
total number etc 

5. Working with MS word

Saving document 

To save a document, go to menu bar
Click on File< Save
A new dialogue box will open with “Save As” title 
Select the drive/folder from the drop down menu ”Save In” 
Type the name of file; you want to save as, in File name text area
Click Ok.
Save as dialogue box will be closed.
File is saved and you can see its name on title bar

If the document is saved successfully, its name will change from document1 to file name we save
with. As new document is named Document with some number in title bar and once it will be 
replaced with the name of the file. 

Usually computer saves files in “My Document” but we can save our files in any other drive or 
folder we like.

Sometime we need the same file or text for reuse. We can write the whole text again or just have
another copy of the same file. Second option is more convenient so we will use it. 

To save the same file with different name, go to menu bar 
Click on File< Save As.. 
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A new dialogue box will open with “Save As” title 
Select the drive/folder from the drop down menu”Save In” 
Type the name of file; you want to save as, in File name text area
Click Ok. 
Save as dialogue box will be closed.
File is saved and you can see its name on title bar 

Closing document

To close a document
1- Click on File< Close 
2- Click on the close button on right side of title bar 

If you try to close an unsaved document, a dialogue box will appear.
It has three options

1- Yes – Click on this button, if you want to close the document after saving the file
2- No- Click on this button, if you want to close the file without saving the unsaved text
3- Cancel- click on this button, if you don’t want to close the file 

The documents we create using MS word are saved in form of files. These files are called 
document files.

Opening document

To open a document file 

1- Double click on the file 
2- Open MS word

a. Click on File < Open 
b. Browse to the location and file
c. Click on Open tab 

6. Open one and several documents 

Whatever we do on computer, can be saved, in form of files. These files can be opened with 
double click on their icons. At any time, more than one file can be opened. For example, you can
listen to some song and at the same time, you can work on multiple ms word files.

7. Switching among documents

We can open and edit more than one document at a time.

To switch to any file among the several open files, click on its name on task bar or press
combination of Alt+Tab. This is called window switcher or application switcher. It’s a small 
dialogue box which shows icons for all open files and allows switching among these files. 

8- Summary

In this lecture you learnt
Open and close a word processor
Open one and several documents
Create a new document based on a document
Save a document
Switch between open documents
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9- Exercise 

Task 1:
NOTE: Following steps will only work if Microsoft Word is installed in your computer.
Click on the Start button and then choose the Run menu option. A small window with a 
text box will open up. Type “winword” (without quotation marks) and observe what
happens.

Task 2:
NOTE: This task is for those who have Windows XP installed on their computers.
Right click on your Desktop area and then choose the Properties option. Display
Properties window will open up. Select the Appearance tab from the top and then look
foe a drop down list whose label is Color Scheme. Select the option of Olive Green. 
Press OK button to apply the setting. 

Task 3:
Creating Microsoft Word shortcut on the Desktop:
Click on the Start button and click on the All Programs menu option. Locate Microsoft
Word option (if you have MS Office 2000 or older) or Microsoft Office (if you have MS
Office 2003). Right click on the Microsoft Word option and drag it on to your Desktop
area. Release the right mouse button, a small menu will pop up. Select 'Copy here' option 
from the menu to create a shortcut.

Task 4:
Open Microsoft Word. Right click on the empty space that you see after the Help menu. A
long list will open up. You will find some option with check mark shown on their left side. 
Click on any one of the item that has a check mark on its side. Observe what happens.

Task 5:
Open Microsoft Office and see if the Task pane on the right side is also open. Close the
pane if you find it there. Now click on the view menu and click on the Task pane option to
open the pane again. 

Task 6:
Open a fresh word document and type some text in it. Press Ctrl + O from the keyboard.
A window for saving files will open up. Enter the required information and save the file 
you have just created. Now type some more text in the same file and press Ctrl + S from
the keyboard. This shortcut key will save your current document file. 

Task 7:
Open My Documents folder and locate any file that you have created earlier. Selected the 
file with a single mouse click. Do not double click on the icon. Now press F2 key from the
keyboard. F2 key is located in the top left corner of your keyboard, near Escape and F1
keys. After pressing the F2 key, you can type and change the name of the file. Same
steps can be followed for changing folder name. 
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Lecture 20 

Introduction of MS Word 

1. Objectives 
The objective of this lecture is to provide information about 

How to insert new text in existing document
How to select different portions of text in a document 
How to cut, copy, paste text in document
How to delete text 
How to use find, replace options

2. Opening a document 

To open the existing document, first you need to open the software.

Click on start < All Programs < Microsoft Office < Microsoft word 2003
A new document will open. Click on File < Open or press Ctrl + O to open a new dialogue box.
Select the drive or location from the drop down menu at the top of the dialogue box.
Select file you need to open and click on open button 

There is another method commonly used to open an existing file.

Go the folder/drive where your files exist.
Double click on its icon to open the file

3. Inserting text in document 

Suppose you have to add a line or paragraph in an existing document. First of all, you need to
open this file. There would be a blinking line at the start of document. This blinking line is called
cursor. It is similar to English alphabet “I”. Click at the point where you want to add some text. 
Cursor will be at that point now. Whatever you type will be written here.

4. Selecting text 

To edit or format text, it has to be selected first. Editing is the process of changing word or
sentences in any document. Formatting helps in making text more visible or attractive. Either its 
editing or formatting, you need to select the text to do either on it. Text selection may include a
single letter, a complete word, a sentence, a line, a paragraph or a complete document. We can
use mouse pointer and keyboard for text selection.

5. Selecting single letter 

Bring your mouse near the letter, you need to select. Press the left mouse click for once and
without leaving the button, drag to the end of letter. Letter has been selected.

You can select a letter with the help of keyboard as well, if you know how to use arrow keys.

6. Selecting a word

To select a word with mouse, bring your mouse cursor over the word and double click. It will
select the whole word.
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To select a word using keyboard, you have to bring the cursor, near the start of the word, press 
ctrl+shift and right arrow key. Word is selected.

7. Selecting a sentence 

To select a complete sentence, keyboard and mouse are used. Click at the start of the sentence
and then press Ctrl. Without releasing Ctrl key click once over the sentence. Whole sentence will 
be selected.

8. Selecting line 

To select a line, click at the start of the line and move the cursor little to left side, until it changes
its shape to mouse pointer. Now click once. Whole line will be selected.

Keyboard can also be used to select a line. Click in the start of the line. Press Shift+ end. 

9. Paragraph selection 

To select a paragraph, click at the start of the line and move the cursor little to left side, until it 
changes its shape to mouse pointer. Now double click. Whole paragraph will be selected.

To select a paragraph, using keyboard, click at the start of the paragraph. Press Ctrl, Shift and
down area key. It will select whole paragraph.

10. Body text selection 

To select whole document via mouse, click at the start of the document and move the cursor little
bit to the left side, until it changes its shape to mouse pointer. Now click 3 times at once. Whole
document will be selected.

To select whole document, using keyboard, click anywhere in the document and press Ctrl+A

11. Inserting text 

Document editing includes

1. Type new text in a document
2. Replace text with new text 
3. How to revert change in typed text 

Click anywhere you want to add new text or move cursor to that position using arrow keys. Start
typing required text. New text will be added.

12. Inserting symbols

Bring your cursor to the position where you want to add symbol using keyboard arrow keys or
mouse click. Go to Insert < Symbol 
A new dialogue box will open with lots of symbols and special characters. Select anyone of these 
and click on Insert button. 

13. Overtyping text 
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Overtyping mode is the typing mode in which new letters being typed replace the old letters. To
enable this mode, press Insert key on your keyboard.

14. Cut and paste text 

To cut select the text you need to cut, press Ctrl+X or Edit < Cut 
Click at the place where you want to paste the text, press Ctrl+V or Edit < Paste 

15. Copy and paste text 

To copy select the text you need to cut, press Ctrl+C or Edit < Copy
Click at the place where you want to paste the text, press Ctrl+V or Edit < Paste 

16. Deleting text 

Select the text, you want to delete and press Delete button on keyboard.

17. Undo and redo commands 

In case you make some mistake, you can undo it by pressing Ctrl+Z or Edit < Undo
To redo your undo action, press Ctrl+Y or Edit < Redo

18. Find text

Press Ctrl+F or Edit < Find to open the Find and Replace dialogue box. 
Enter word(s) you need to find in the text box and click on Find Next button. 

19. Find and replace text 

Press Ctrl+H or Edit < Replace to open the Find and Replace dialogue box.
Enter word(s) you need to find in the “Find what” text box.
Enter word(s) you need to replace with in the “Replace with” text box 
If you click on Replace button, it will replace first found text with the give option whereas  if you 
want to replace the text in the whole document, click on Replace All button 

20. Summary

In this lecture you learnt that: 
How to insert new text in existing document
How to select different portions of text in a document 
How to cut, copy, paste text in document
How to delete text 
How to use find, replace options

21. Exercise 

Task 1:
Open Microsoft Word. Press Ctrl + O shortcut keys from the keyboard. A window will
open up. From this window you can select and open your word documents.

Task 2:
Click on the Start button. Take your mouse pointer on the All Programs item. Locate the
'Open Office Document' option and click on it to open a window. This will take you to the 
My Documents folder from where you can select and open your created documents.
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Task 3:
Open a document that has some text in it.
Press Ctrl + A to select all the text in it.
Press Ctrl + C to copy the selected text.
Press Ctrl + N to open a new blank file.
Press Ctrl + V to paste the copied text in this new blank file. 
Press Ctrl + S to save this new file. Enter the relevant information and press the Save 
button.
Press Alt + F and then press C keys to close the newly created file. 

Task 4:
Open a fresh document and type the following signs given below. Observe as you type
these signs.
==>
-->
<==
(c)
(r)
(tm)
<=>

Task 5:
Open a document file and select some text. 
Press Delete key to delete the selected text.
Press Ctrl + Z to bring back the deleted text. 
Press Ctrl + Y to revert the last step of Undo.
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Lecture 21 

Text Formatting 

1. Objectives 

The objective of this lecture is to provide information about 
What does the formatting means?
How can we format our documents?
Which options are included in document formatting? 
How to use the format menu?
How to use formatting options?

2. What is formatting? 

Format means appearance of a thing whereas formatting is the process of changing or improving
that appearance. Document formatting includes page, font and paragraph settings. 

Keyboard shortcut is a combination of keys, when pressed simultaneously, perform some task
that ordinary requires use of mouse or other input device and may take longer to do. 

3. Document formatting 

Document has some empty space at the top, bottom, left and right side of the page. This empty
space is called margins. We can vary the size of margin according to our needs.

4. Header and footer option 

The text that appears in the top margin of the paper is called header. The text region that 
appears in the bottom of the paper is called footer. Changes made in header and footer of one
page appears in all pages of the document. With the help of this feature, we can automatically
have same header and footer in every page without hassle.
To set the header and footer text, open View menu and click on the “Header and Footer” option.
A “Header and Footer” toolbar and visible rectangle text box will appear in the document. This 
rectangle text box is document header and footer regions. You can enter any text in the header
region. Footer region is not visible at that moment. To go to footer region now, click on  “Switch
between header and footer” button.

We can type text or insert auto text in footer section. Auto text is the text that word processor can
add in document. For example to display page number, or document creation date, time etc we 
can use this feature. As you can see in the figure, there is option of Insert AutoText at the left side
of the toolbar. Click on the arrow along with it and ten options for auto text will appear.

5. Text formatting 

Text formatting includes formatting of a letter, word, sentence, paragraph or whole document. To
apply any kind of formatting, the text needs to be selected first. To apply different kind of 
formatting, we use formatting toolbar or keyboard shortcuts.
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6. Applying existing style

The highlighted drop down menu is style menu. By default it contains only six options: three for
heading style, one for clear formatting and one for normal style. 

7. Changing font 

lick on the drop down menu to see the list

. Changing font size
Every font style comes into different sizes. Click on the font size 

,

uttons for bold (Ctrl+B), italic (Ctrl+I) and underline

ta

C
of installed fonts in your pc. Click on any font
name to apply it on selected text. 

8

drop down menu’s arrow to see the available sizes. To enter font
size, click on the text area, and enter required font size like 8.5, 10
15, or 70 etc.

9. Bold, Italics and Underline 
You can see three b
(Ctrl+U) text in the following figure. First select text and than click on any
button to get the required formatting. You can also have a combination
lic text, formatting like Bold-i Bold-underline text or italic-underline etc.

10. Text alignment

elected text can be left aligned, center aligned, right aligned or justified

1. Line spacing

ine spacing is the distance/space between any two lines of the document. It 
e

.

2. Text indentation

the highlighted area of the formatting toolbar, first button is to “Decrease

eas,

3. Bullets and numbering 

o stylize your lists, select the text and click on any of these buttons. You can have

4. Border and shading

S
aligned using these four buttons in the formatting menu.

1

L
makes reading easy for us. By default line spacing is set to single line space. W
might give our document to editor for proof reading or to prepare some project,
proposal or thesis etc. In that case, we can change the space between two lines
arrow along the button shown in the figure, to see the options available for the line spacing.

 Click on the 

1

In
indentation” of the text and second button is to “Increase indentation”.
By decreasing indent, text will move towards left side of the page, wher
increase would move text to right side of the page. 

1

T
more options from Format < “Bullets and Numbering…” option.

1

Virtual University of Pakistan 
56



Computer Proficiency License (CS001) VU

You can put the border around text or picture using “Border” feature in formatting toolbar. There

5. Applying page border 

n also apply border around page. To apply border go to 

r and shading option.

6. Paragraph formatting

every document sentences join together and create a paragraph. We create paragraphs to

o view paragraph in our document we turn on the paragraph option. Click on the show/hide

the

f

7. Indenting paragraph

hen a document is created all the text is aligned to left margin. The settings that have already

New Roman 

are different by default styles available.

1

ust like text and paragraph, we caJ
Format < Borders and Shading…
A new window will open with borde

1

In
make our document more presentable and readable. A paragraph is created when we press
“Enter” key from the keyboard after typing some lines. Even if you press enter after typing a
single line, it will be considered as new paragraph.

T
button on the standard toolbar.
Some extra dots and 
symbols will appear in
document. There are dots
between words and the 
special symbol at the end o
know where extra spaces are and paragraph starts. To turn off these dots and paragraph marks
we click on the same button again. 

every paragraph. With the help of the dots and symbols you get to 

1

W
been made in the software are called default settings. Default settings of a document are
Text is left aligned 
Font style is Times

he ruler at the top shows width of the page and one on the left show length of the page.
there is

de with first

n the left side, upper triangle is to indent first line of the paragraph. Below first line indent, there

T
The dark area in this bar is actually the margin of the page. Between the dark portion,
white region in the ruler. At the edge of dark and white region, we see some geometrical shapes.
On the left there are three and on the right there is only one. These are called paragraph
indentation marks. We can change indentation of paragraph through these marks.

ocuments may have different formatting and paragraph indentation. Paragraphs maD
line indent are called semi blocked paragraphs. Paragraphs made without first line indent are
called blocked paragraphs. Blocked paragraph requires single line space between them so that
paragraphs can be easily identified. 

O
is another geometrical shape. It is hanging line indent and used to push the lines of the paragraph
except the first line. Just below it a triangle shape exists. It is called left indent and use to indent
the whole paragraph on the left side. 
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On the right side of the ruler, there is only one marker, and it is called right indent. It is use to
push a paragraph from the right side. 

18. Paragraph spacing

Space between paragraphs make document more readable. To change the spacing between
paragraph goes to Format < Paragraphs…
You will see the options for Indentation and spacing, Line and page break.

19. Summary

In this lecture you learnt: 
What does the formatting means?
Formatting options for document
Format menu for MS word
Text, paragraph and document formatting options

20. Exercise 

Task 1:
Open a fresh document.
Locate the ruler on left side of Microsoft Word window.
Double click on the white area of this ruler.
Page Setup panel will open up for document formatting.

Task 2:
Open the page setup panel of a document and explore the tabs before completing the 
following steps.
Change the paper size to Legal. 
Change page orientation to Landscape.
Set all the four margins to 1 inch.
Turn ON the 'Different first page' option.

Task 3:
Open a fresh document.
Click on View menu and choose the Header and Footer option. 
In the Header section type your name.
Scroll down using the vertical scroll bar on the right side of the page.
Press Alt + I and then press T from the keyboard. 
Choose a Date and Time format from the list. 
Press OK button to insert the selected Date and Time format.
Click on the Close button in the Header and Footer toolbar to apply the changes.
Scroll up and down the page to view the changes made by you. 

Task 4:
Open a document with some text in it. 
Select a line and then click on Format � Borders and Shading menus.
Select 'Shadow' option from the Settings section.
Select dotted line style from the 'Style' list. 
Select appropriate width of the line. 
Press OK to apply changes.
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Lecture 22 

Tables

1. Objectives 

The objective of this lecture is to provide information about 
How to create tables using MS word? 
How to change column width and height?
How to insert and delete columns and rows from table?
How to format borders and change colors? 
How to use images in documents?

2. Tables – An introduction 

We usually use text in our documents. We can also use charts, graphs and pictures in our
document file. Tabular data makes it easier for the reader to understand the information provided.

Example of tabular data can be 
Time table 
Employee contact list 
Product sales report

Drawing, charts and pictures can make a document look better and easy to understand.

3. Creating tables and inserting data 

To create table go to Table < Insert < Table
A new window for “Insert table” will appear as 
shown in the figure
Enter the number of columns and rows you need
in a table and click on OK button.

4. Modifying column and rows

The height of rows and columns are adjusted automatically. We can also adjust column height
and width of the row.
To change the height of the row, move mouse pointer to the bottom edge of the row. It will 
change its shape into a cross. Now click and drag the cursor to the height you want. 
To change the column width, repeat the same process with a difference. Keep cursor position on 
the vertical edge to drag it. 

5. Insert column and rows

It is recommended that we plan about number of column and rows before creating table. But in 
case we need more column and rows, we can add it in existing table. 
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To add a column in a table, click on the cell, you want to add column with and go to
Table < Insert < Columns to the left or Table < Insert < Columns to the right
6. Deleting column and rows

To delete any column or row, select any cell in that column or row and go to 

Table < Delete < Columns or Table < Delete < Rows

7. Modifying border color and shapes 

Table formatting includes border style and cell shading. To 
format a table, first you need to select it using it’s selector at
the top left side. It will select whole table with one click. Now
go to Format < Borders and Shading…
You can change style, color and width of the border line from the options given in the window
opened.

8. Working with pictures 

While preparing our document we usually emphasize on the text and its formatting but we can
make our document more presentable using pictures and images. To insert a picture in a 
document go to Insert < Picture < Clip art
A new window will appear in the document. Enter the name of the picture you want to search. For 
example type ”computer” and click on go button. Few pictures will appear in front of you. Double 
click on any picture and it will appear in your document. Picture toolbar will also appear.

 This icon will open the file browser to insert picture from your pc.

 It will change the color of selected picture.

 It is used to increase the contrast of the image. 
 It will decrease the contrast of the image. 
 This feature will increase the brightness of the picture. 
 You can decrease the brightness of the image by single click on this icon.
 Click on this icon to crop the picture.

 Click on this icon to rotate the picture at 90 degree.

 This icon will display options for line style.
 This feature is used to compress the picture.

 It is very useful feature to prepare the document. It makes pictures to align with text in the
    document.

 A new window will open once this icon is clicked. It is used to change the pictures properties
   manually. 

 This feature is used to set the transparent color. 
 This icon will undo the changes made on pictures using picture tool bar options.
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9. Summary

In this lecture you learnt: 
Creation of tables in word processor
Changing table columns width and height
Insertion and deletion of columns and rows of table 
Formatting of table borders
Use of pictures and images in document

10. Exercise 

Task 1:
Open a fresh document. Click on the Table � Insert � Table menus. Create a table of 6 
columns and 10 rows.

Task 2:
Select the first row of the table created in the previous step. 
Change the background color of this row.
Select the first column of the table. 
Change line style of this column. 

Task 3:
Bring your mouse pointer on the table created in previous step. You will see a small 
square at the bottom right corner of the table. Click on this box with left mouse button and 
drag it downwards. Observe what happens.

Task 4:
Create a table with 5 columns and 7 rows. Enter some text in the first row as columns
headings. The text should be of variable length so that the columns may have variable
width. Now select the whole table and right click on the selected area. Select the option
'Distribute Columns Evenly' from the menu.

Task 5:
Select the third column of the table created in the previous task. Pres Shift + Delete keys
from the keyboard to delete this selected column.

Task 6:
Select the fourth row of the table created in Task 4. Click on the Table � Insert � Rows 
Below. This will add a row below the selected row. 

Task 7:
Create a fresh document and type some text in it. Click in the center of a sentence to 
bring the cursor. Click on the Insert � Picture � Clip Art menus. A pane will open up on
the right side. In the upper portion of this pane there is a text box. Type the word
'computer' (without quotation marks) in it and press the 'Go' button next to it. Select a
picture and insert it in the document.

Task 8:
Right click on the picture you have just inserted in the document and select the option
'Show Picture Toolbar'. Click on the 'Text Wrapping' button and choose the 'Through'
option. Drag the corners of the picture to adjust the size according to your need.
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 Computer Proficiency License (CS-001) 
Lecture 23 
Mail Merge 

1. Objectives 

The objective of this lecture is to provide information about 
What is mail merge and why we use it? 
What are the important steps of mail merge?
How to create a mailing list? 
How to create a mailing list with a document?
How to prepare mailing envelopes? 
How to take print outs of a merged documents

2. Basic concepts 

In merged mail we have some information that is merged with other letters to be posted after 
words. This mail can be our postal mail or electronic mail send by our pc. We use the mail merge
feature provided by a word processor to merge out our information with letters and prepare them
for delivery. 
Mail merge comprised of two steps.

1. Prepare your letter or invitation. 
2. Prepare the list of people who will receive this letter. 
3. Merge the information from the list into main letter. 

For example we need to send university students a convocation letter. Such invitation or letter is
addressed to different person. Text of the invitation will be the same but the name of the students
and their addresses will be different.
To develop invitations using mail merge feature do the following steps

1. Create a letter/invitation with temporary labels like title, first name, last name, city
2. Go to Tools < Letters and Mailing… < Invitation. A panel for mail merge will open in the 

document.
3. Select “Letters” radio button in the document type and click on the next: Starting 

document in the bottom of the panel.
4. Select  “Use the current document” and click on the “Next: Select recipients”
5. Select “Type a new list” and click on Create…  A new window will open with text fields. 

Enter information in text fields and click on OK. It will ask you to save the list. Enter 
“Students” and press enter. Click on “Next: write your letter” 

3. Editing a merged list 

It is very easy to edit a list or add/delete
a record in list.
Click on the Mail recipient button in mail 
merge toolbar. A new window will open with list you develop. Select any entry and click on Edit
button in the window to do any changes. Once you enter into the edit mode for the particular list 
entry, you can delete, find, sort and add new entry.

4. Merging to a document 

Every record after merging with the main letter gives a personalized letter. Every student will get
the feeling that letter was especially made for him.
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To merge main letter with list of students, click on the “Merge to New document” button in the
Mail merge toolbar. A small window will open with following options for merging records.

1. Selecting “All” will merge and create letters for all records in the data list. 
2. “Current Record” will merge and create letters for only the record that is visible on the 

screen
3. “From _____ To _______” will merge and create letters for only the mentioned range of 

records

Select “All” and click on OK button. It will create letters for all students in no time. Now save this
document for future use.

5. Creating mailing envelopes 

Letters prepared through mail merge are delivered to the destination address. 
For our example, envelops will be made for same students. We have already 
prepared and saved an address list. 
To display the mail merge tool bar, go to View < Toolbars < Mail Merge 

Most of the buttons are disabled at the moment. Click on the first button “Main document setup”.
A small window will open. Select “Envelop” option and click on OK button. A new window will 
open for envelop development. Let the by default options (size 10) for envelop size and click on
Ok button. Size of the document will be changed. This is not a page anymore. It is envelop that 
we have selected in the previous step.

Click at the top left corner of envelop and write the return address. Now click at the center of 
envelop. A cursor will start blinking there. Click on the 2nd icon in the Mail Merge tool bar and
browse to the student’s record file.
The buttons in the Mail Merge tool bar are now enabled and 
can be used. Click on the “Insert Merge Field” button. A list will 
open with address list. We will use some fields to create
delivery address. Select the field you want to enter and click on 
insert. Like this insert all required fields and click on Ok. We can arrange these fields entered with 
space and enter.

To view the merged data, click on “View Merged Data” button in Mail Merge tool bar. Real record
will replace address fields. To view other record, click on the navigation buttons in tool bar. 

6. Printing a merged document

Click on the “Merge to Printer” button in tool bar. Select “All” from the Merge to Printer window to
take prints for all records. Soon after you click on the OK button, a new window will open for
printer. Click on Ok button to send print request to printer.
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7. Summary

In th le

mail merge 

cument

Taking print outs of a merged documents

. Exercise

Task 1:

rge exercise.doc
This file contains detailed instructions for a Mail Merge exercise.

is cture you learnt: 
What is mail merge and its use? 
Important steps use for
Creating a mailing list 
Creating a mailing list with do
Preparing mailing envelopes

8

Click on the menus and select the file mentioned below:
Start < All Programs / Programs < VU-CPL < Module 3 < Mail Me
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 Computer Proficiency License (CS-001) 
Lecture 24 

Preparing output 

1. Objectives 

The objective of this lecture is to provide information about 
How to review and proof read a document
How to use word processor to proof read
How to remove spelling and grammar mistakes
How to take print outs of a document
How to make use of different printing options

2. Reviewing a document 

When a document is prepared, it is thoroughly checked with different perspective. A document is 
checked for its layout and information provided in it. Documents are also checked for its spelling
and grammar mistakes. We should review our document made with the help of word processing
application.

A complete document review includes
1. Complete page layout 
2. Page margins and numbering
3. Header and footer settings 
4. Text and paragraph settings 

A very important part of document review is spelling and grammar check. A word processor gives
us a very important feature of spelling and grammar check. It indicates any spelling mistake in the 
document and points out any grammatical mistake as well. While writing in MS word, spelling 
mistakes are shown by red lines and grammar mistakes are shown by green lines. Using the 
spelling and grammar check feature, we can remove mistakes from our document.

There are two methods to correct such mistakes in document.
1. We can use the spelling and grammar check

feature. Go to the start of the document. Click o
button highlighted in the figure. It will open a 
new dialogue box with correct options. You can
do the correction, ignore it or add it to dictionary.

n

2. We can use the right click of our mouse. Right click on the word with red line below it to 
see the available corrected options.
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Words not included in computer dictionary are highlighted as mistakes. For example nouns like
Places; Muslim names etc are considered as spelling mistakes. We can add such words in 
dictionary so that they are not considered as mistake next time. 
Right click on the highlighted word, and select “Add to Dictionary”

The green wavy line under the sentence represents a grammatical mistake. Computer is
suggesting you to revise the fragment from the grammar perspective.

3. Printing a document 

We can take prints of a document prepared in word processor. The files created using software
and saved in computer called “soft copy”. It is a good practice to have the print preview of your

documents. Click on  print preview button to see the preview of the document file before print.
After viewing the preview, we can come back to the document by clicking on the close button.
To take the print you can do any of the following.

1. Click on the print button to take print. 
2. Go to File < Print
3. Press Ctrl + P

A dialogue box will open in case, either option is followed.

You will see different options available for print.
You can select All, only current page, or page range for prints
Multiple copies can be sent to printer at a time of a document with a single click.
Zoom and scaling options can be set for pages being sent to printer.
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4. Summary

In this lecture you learnt: 
Review and proof reading of a document
Using word processor to proof read 
Removing spelling and grammar mistakes
Taking print outs of a document
Different print out options 

5. Exercise 

Task 1:
Visit some office and explore how they use printers in a network environment.

Task 2:
There are different types of printers available in the market. If you have to buy a printer,
which factors will you consider deciding which one is best for your requirement?

Task 3:
When the printer ink cartridge or laser toner is used up, what will you do with it?

Task 4:
Open a Notepad file and choose the print option from the file menu. From the print panel,
increase the number of copies to be print.

Task 5:
Open a Microsoft Word file which has some pages of text in it (at least 7 pages). Press
Ctrl and P keys from the keyboard simultaneously. Click on the radio button beside the
Pages text box and type “1-3, 6” (without quotation marks). This setting will only print the 
first three pages and the sixth page of the current document. 
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Computer Proficiency License (CS-001) 
Lecture 25 

Basic concepts of MS Excel

1. Objectives 

The objective of this lecture is to provide information about 
How to start spreadsheet software?
Components of spreadsheet software
How to create and Close spreadsheets?
How to save spreadsheets?
How to open one, several spreadsheets?
How to switch among several spreadsheets?
How to save a spreadsheet under another name?
How to exit from spreadsheet?

2. Starting spread sheet software

Microsoft Excel is popular and widely used spread sheet software.

To open the excel file 
Click on start < All Programs < Microsoft Office < Microsoft Excel2003

In the start a screen will appear for few seconds. This is called splash screen. A new excel file will
open, after this screen would disappear. The by default arrangement of toolbars panels and
sheets is called default layout.

3. Screen components 

 Title bar: The most upper bar of window is called title bar. Its top left corner shows the
document default name like “Microsoft Excel Book1” which shows document is of type Microsoft 
Excel and its temporary name is Book1.When we save the document we can give another name
to document.

 A file created by spread sheet software is called work book. On the right side of title bar there are 
three buttons. Minimize button is used to minimize the workbook. Restore button is use to restore
down the workbook and close button is use to close it. 

 Menu bar: There is another bar after the title bar is called menu bar. Menu bar contains
different options to use features of excel like file, edit, view etc 

For using any main menu we just move the mouse cursor over it and it will show submenu.

 Toolbar: The strip next to menu bar is toolbar. Toolbar is shortcut of menu bar sub options.
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We can use these options by clicking icons. For knowing the purpose of these icons just take the 
mouse pointer over there and wait for a while you will see name of this icon in form of label. This
label is called tool tip text. 

 Task pan: When you start the spreadsheet software you will find a panel on the right side. It is 
called task pan. On the top of task pan “Getting started” is written and you will find options such 
as seek online help, open recently opened excel files and create a new work book etc. 

 Worksheet area: An excel workbook appears on 
the screen showing white cells, is called worksheet
area. Worksheet area is divided in rows and
columns and the area where the rows and columns
intersect is called a cell. Worksheet consists of 
different cells. Each cell has a name which is referred as its address.
In worksheet columns are shown in alphabets while rows are shown in numbers.

 Name Box and Formula bar: There are two bars at 
the top of excel sheet for active cell name and 
formula/content of the cell. These are called name box
and formula bar.
Name box shows address of the active cell name.
Formula bar shows the contents of the cell. 

 Sheet Tab:  In the end of worksheet there are few buttons; called sheet tab. Sheet tabs are
used to move between worksheets in a spreadsheet. You can work on three work sheets
simultaneously.

 Status bar: The bar at the bottom is called status bar which shows the status of document.

4. Creating a new spread sheet 

To create a new spreadsheet use “NEW” option from file menu. 

1- Go to File < New 
2- Click on “Blank work book” in the Task Pan in the right side of the MS Excel. 
3- A new work book will be opened.

Another way to open new file is use “New” icon from tool bar .

5. Saving a new spreadsheet 

After creating the spreadsheet the next step is to save them. We will use “SAVE” command of file 
menu to save worksheet. 

There are three ways to save existing file. 

1- Go to File < Save 
2- Press Ctrl+S
3- Click on Save Icon  in formatting toolbar.

6. Closing 

When we are finished with our work in spread sheet we need to close it.
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Two ways to close a file: 

1- Got to File < Close.
2- Click on the close button at the title bar.

7. Opening

When we want to display a spreadsheet that has already been saved we will use “OPEN” option
from file menu. 

Two ways to open a file: 

1- Click on File < Open. 
2- Press Ctrl + O. 

Either of the way will open a dialogue box. You can browse the file, needed to open and click on
Open button.

8. Switching

When more than one spreadsheet is open we can switch and edit among them. To view an open
spreadsheet we have to click on its name visible in the task bar and we can also switch among
spread sheet by clicking on “Window” option of file menu. 

To view open spreadsheets at a time: 
Go to Window < Arrange.

9. Rename 

When you want to make changes in existing file and to make another copy of existing file, we will 
use “SAVE AS” option of file menu. 

10. Exiting

By using “CLOSE” option we do not exit from spreadsheet software. If we want to exit from 
spreadsheet software we will use “EXIT” option from file menu. 

To exit from Microsoft Excel software:

Go to File < Exit

11. Summary

In this lecture we have learnt: 
How to start spreadsheet software?
Components of spreadsheet software?
How to create and Close spreadsheets?
How to save spreadsheets?
How to open one, several spreadsheets?
How to switch among several spreadsheets?
How to save a spreadsheet under another name?
How to exit from spreadsheet?
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12. Exercise 

In the coming exercise review your Excel skills to open, navigate, save and close a spreadsheet.

Task 1:
Creating Microsoft Excel shortcut on the Desktop:
Click on the Start button and click on the All Programs menu option. Locate Microsoft
Excel option (if you have MS Office 2000 or older) or Microsoft Office (if you have MS 
Office 2003). Right click on the Microsoft Excel option and drag it on to your Desktop
area. Release the right mouse button, a small menu will pop up. Select 'Copy here' option 
from the menu to create a shortcut

Task 2:
Starting Microsoft Excel :
Click on start button and then point to All program option. In the resulting menu, point to 
Microsoft office option. Then click on Microsoft Excel 2000 to start Microsoft excel. 

Task 3:
Creating and saving a spreadsheet :
Open a New Excel spreadsheet by pressing Ctrl + N from the keyboard. Type your name
in cell A1 and address in A2. Press Ctrl + S from the keyboard. A window for saving files
will open up. Enter the required information and save the spreadsheet you have just 
created. Now type some more text in the same spreadsheet and press Ctrl + S from the
keyboard. This shortcut key will save your current spreadsheet. 

Task 4:
Changing Spreadsheet Name :
Open My Documents folder and locate any spreadsheet that you have created earlier.
Select spreadsheet name with a single mouse click. Do not double click on the icon. Now
press F2 key from the keyboard. F2 key is located in the top left corner of your keyboard,
near Escape and F1 keys. After pressing the F2 key, you can type and change the name
of the spreadsheet. Same steps can be followed for changing folder name. 

Task 5:
Changing Zoom setting :
Create a new spreadsheet.  Note the number of columns and rows that appear in
worksheet area. Open view menu and click on Zoom option. In the dialog box select 75%
option and then click on Ok button. Note number of rows and columns that appear in
worksheet area. 

Task 6:
Opening spreadsheets :
Start Excel and open a spreadsheet that you have created recently. For this open file
menu and in the last of menu click on any spreadsheet name. It will be shown on screen.
Then click on open icon on the toolbar. It is in the shape of an open book. From dialog
box click any spreadsheet and then click on open button. finally  press Ctrl + O keys from
keyboard and double click on any spreadsheet in the dialog box. To see the list of open
spreadsheets click on window menu. In last of this menu check open spreadsheets.
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 Computer Proficiency License (CS-001) 
Lecture 26 

Introduction of Excel Sheets 

1. Objectives 

The objective of this lecture is to provide information about 
How to enter and edit different type of data in worksheets?
What is range and how to select cells, columns and rows in a worksheet?
How to insert blank cells, columns and rows in a worksheet?
How to delete cells, columns and rows in a worksheet?
How to change single or multiple column width and rows height?
How to copy and move worksheet data?
What is purpose of find and replace command?
Sorting of numbers and letters in ascending and descending order

2. Inserting data 

You can enter different types of data in spreadsheet like text and letters. In numeric data we enter
digits and perform different formulas on it. When we enter sentences or description of any item in 
a cell we can use text type. Some time we enter text and letters both in the computer terminology
this type of data is called alphanumeric.

3. Entering data 

When we enter data in cells of spreadsheet we have to follow these steps: 

1. First move cell pointer to the cell using mouse or keyboard.
2. Enter data (Text, Numbers etc) in a cell using keyboard.
3. After entering data finalize it, by pressing any arrow key.

We can align data as well. By default Text data is left aligned and numeric data is right aligned.

4. Editing data 

When we edit enter data in cells of spreadsheet we use single click or double click.

There are two methods to edit the data in excel sheet.

1. Select the cell; you want to edit, using arrow keys or mouse. Content of the active cell will
be visible in formula bar. You can delete/overwrite or correct the text here.

2. Double click at the cell you want to edit. Text will be highlighted. Press any key to delete
the text or overwrite it with new text. 

In edit mode you can edit and delete data. For deleting you can use delete button or backspace
to delete. 

5. Selecting cells 
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To work at more than one cell, entire row or column, you need to select it. Group of adjacent cells
is called range. We can define range by writing starting and ending address like A1:A4 etc 
6. Selecting rows

In a worksheet you can select single or multiple rows. To select a single row you have to click its 
row number. By dragging mouse on multiple rows we can select multiple rows.

7. Selecting worksheet

Using any of these methods we can select multiple columns or entire worksheet. 

1. Click once at the name of the column to select it. 
2. Select any column and press shift. Now select as many adjacent columns you want. 

To select entire worksheet click on the area, highlighted in 
the figure. It is called “Select All” button. You can also select
an entire worksheet using keywords like Ctrl+A. 

8. Summary

In this lesson you have learnt: 
How to enter and edit different type of data in worksheets
What is range and how to select cells, columns and rows in a worksheet

9. Exercise 

Complete each of the task in sequential order to review your excel skills to enter and edit data,
select data, insert and delete columns and rows. You will also learn how to undo and redo
changes, rearrange your worksheet, and fill ranges. 
In these exercises open any spreadsheet created earlier to practice these tasks.

Task 1:
Entering Data :
Start a new spreadsheet. Click on cell A10 in worksheet. Type your name and press right
arrow key of keyboard. Press up arrow to move to cell B10. Type any other name and
press enter key. In the same way, type some data in cell C10 to H10.

Task 2:
Editing Data :
Move to cell A10. Type a new name in the cell but do not press enter. Since you realize
that you want to enter name in A11 cell, press Escape key of keyboard. Move to cell A11.
Type Majid but do not press enter key. Press Backspace key twice to delete id. Then 
type eed to change name from Majid to Majeed and press enter key.

Task 3:
Selecting range of cells using keyboard :
In order to select a range of cells from C4 to C10 first move cell pointer to cell C4. Hold
the Shift key of keyboard and then press down arrow key to move to cell C10. Then
release the shift key. The range C4:C10 is selected by using keyboard.
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Task 4:
Selecting nonadjacent rows :
In order to select nonadjacent rows 2, 4 and 6 in this worksheet first select row 2. For 
this, click on row 2 heading when shape of mouse pointer is right pointing arrow. Then
press and hold Ctrl key of keyboard and click on row 4 and row 6 heading when shape of
mouse pointer is right pointing arrow.  Non adjacent rows 2, 4 and 6 are selected.

Task 5:
Selecting multiple columns using keyboard shift key :
In this worksheet select columns C, D and E using shift key of keyboard. For this first
click on Column C heading when shape of mouse pointer is down pointing arrow. Hold
the Shift key of keyboard and then press down arrow key of keyboard to move to column
E heading. Then release the shift key. The columns C, D and E are selected by using 
keyboard.
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Computer Proficiency License (CS-001) 
Lecture 27 

Working with cells 

Objective:
In this Lecture you will learn about: 

How to insert blank cells, columns and rows in a worksheet?
How to delete cells, columns and rows in a worksheet?
How to change single or multiple column width and rows height?
Use of undo and redo command
How to copy and move worksheet data?
What is purpose of find and replace command?
Sorting of numbers and letters in ascending and descending order

1. Inserting rows, columns 

While entering data in a worksheet, it may be possible that some entry of row or column is 
missed. In this situation we can insert blank row or column in a worksheet by using insert row or
insert column option. 
When row insert option is given, a blank row is inserted above the location of cell pointer. Row
numbers are automatically adjusted after inserting new row. In the same way when insert column
option is given, a blank column is inserted to the left of active column. We can also insert multiple
columns.

2. Deleting rows, columns 

We can delete columns and rows by using edit option of delete. 

3. Modifying column, row

When a new spreadsheet is created all cells have default size called standard width. Sometimes
entered data is too long that it is not visible in the cell. We will increase the length of column by 
dragging mouse on left side of column and same is with row.

4. Use the undo, redo command 

While using different options in a worksheet it is possible that you did not want to apply some
options but applies them inadvertently. In this situation you can use undo or redo options of edit
menu.

Redo can be applied when you applied undo command.

To undo any command, go to Edit<Undo
To redo any command, go to Edit<Redo

5. Copy data 
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When you want to use same data on some other location in worksheet, you can copy this data
instead of re-typing it. You can copy the data of cells, columns and rows from one location to any
other location.

To copy data

1. Go to Edit < copy
2. Select the cell, and press Ctrl+C.

6. Move data 

You can move data from one location to another in a spreadsheet called cut and paste. You can
cut and paste the data of cells, columns and rows.

We can use cut command by two ways:

1-Select data
2-Click on Edit < Cut or Press Ctrl+X.

We can paste data by two ways: 

1-Cut or Copy Data 
 2-Click on Edit < Paste or Ctrl+V. 

7. Auto fill tool 

By using auto fill tool, you can copy data of single cell to the cell on the right side, left side, 
upward and downward. It means data can be copied in any direction. Sometimes you may want
to create data in series like roll number, date, day, month etc. Auto fill tool is also used to
generate these types of series.

8. Search and Replace 

It is very difficult to search any value or text in a worksheet when it contains a lot of data. When
you have misspelled some text in a worksheet it becomes lengthy process to locate and correct
these entries. To efficiently search and replace data in a worksheet we will use search and
replace option.
When you want to search some entry Click Edit < Find will open a dialogue box, enter data here 
to search.
When you want to correct some entry you will use replace option Click Edit < Replace will open a
dialogue box, enter data here to replace.

9. Sort data 

Sort means to arrange data. In spreadsheets we can sort data in alphabetical or numerical order.
Alphabetical means data is sorted from A to Z and numerical order means to display numbers in
sequence.
Data can be sorted as following

1- Select the date, you need to sort. 
2- Go to Data < sort

This will open a dialogue box which shows some options for sorting data. 
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10. Summary

In this lesson you have learnt: 
How to insert blank cells, columns and rows in a worksheet?
How to delete cells, columns and rows in a worksheet?
How to change single or multiple column width and rows height?
Use of undo and redo command
How to copy and move worksheet data?
What is purpose of find and replace command?
Sorting of numbers and letters in ascending and descending order

11. Exercise 

Complete each of the task in sequential order to review your excel skills to enter and edit data,
select data, insert and delete columns and rows. You will also learn how to undo and redo
changes, rearrange your worksheet, and fill ranges. 
In these exercises open any spreadsheet created earlier to practice these tasks.

Task 1:
Selecting multiple columns using keyboard shift key :
In this worksheet select columns C, D and E using shift key of keyboard. For this first
click on Column C heading when shape of mouse pointer is down pointing arrow. Hold
the Shift key of keyboard and then press down arrow key of keyboard to move to column
E heading. Then release the shift key. The columns C, D and E are selected by using 
keyboard.

Task 2:
Deleting contents of row 5 and row 7 using keyboard Delete key :
To delete contents of row 5 and 7 first select row 5 and row 7 by using Ctrl key and 
mouse as we discussed earlier.  When row 5 and 7 are selected press delete key of 
keyboard. You will see that only the contents of row5 and row 7 are deleted, data is not 
shifted.

Task 3:
Reverse Changes :
Add two blank rows before row 5. For this first select row 5 and row 6. Open Insert menu
and click on rows option. After inserting these rows, you realize that you want to add two
blank columns instead of rows. So press Ctrl + Z to reverse your changes. If you want to 
redo your changes press Ctrl + Y key of keyboard.

Task 4:
Copy Data :
To copy contents of cells A1, C1 and F1 to cells A20, C20 and F20 first click on cell A1. 
Then press and hold Ctrl key of keyboard and click on cell C1 and F1. Cells A1, C1 and
F1 are selected. Press Ctrl + C keys to copy data to clipboard. Move cell pointer to A20 
and press Ctrl + V keys to paste the copied data. 

Task 5:
Modify columns width and rows height using column and rows option :
To change width of columns C, E and F first select these columns by using Ctrl key and
mouse. After selecting these columns, open Format menu and point to column option.
Then click on width option in submenu. A window will be shown, type desired width in
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window and click on ok button.  Width of columns C, E and F will be different from other
columns.

Task 6:
Using Series option dialog box to generate a series of date :
In a worksheet type 1/1/2006 in cell A4. Then select cells A4 to A10. To generate a series
of next dates with month increasing by 2 each time open Edit menu. Point to fill option
and then click on Series option in submenu. In the dialog box, click on Date  from series
section. In step value type number 2. As you want to increment of 2 in months so click on
Month in Date unit section. Finally click on OK button and see the series of date 
generated.

Task 7:
Using Series option dialog box to generate a series of multiplication type :
In this activity type 2 in cell A4 of any worksheet. Select cells A4 to A8 to generate series
2,4,8,16,32. Then open Edit menu and Point to fill option and then click on Series option 
in submenu. In the dialog box click on Growth from Type section. In step value type
number 2 to multiply each number by 2 in the series. Finally click on OK button and see
the series of numbers generated.

Task 8:
Sorting :
Open a new spreadsheet. Type numbers 1,4,2,1,3,2,4,2  in cells A1, A2, A3, A4, A5, A6,
A7 and A8. Then type numbers 2, 4,6,1,4,5,2,3 in cells B1, B2, B3, B4, B5, B6, B7 and
B8. Select these cells and open Data menu. Choose sort option from then menu. In sort
by drop down list select column A. In then by drop down list select column B. Finally click
on Ok button and you will see Column A and Column B in sorted order.
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 Computer Proficiency License (CS-001) 
Lecture 28 

Work sheets 

1. Objectives 

The objective of this lecture is to provide information about 
 Worksheets

How to select worksheets?
How to insert worksheet?
How to rename worksheet?
How to delete worksheet? 
How to duplicate worksheet?
How to move worksheet?

2. Selecting work sheets 

Workbook consists of many worksheets. When a new spreadsheet is created we can work in
three worksheets named as sheet1, sheet2, sheet3. You can store different but related data in a 
worksheet of spreadsheet like student morning session result in one sheet and evening session
in other sheet. When you work in any of three sheets you can select it just by clicking sheet
number and the selected worksheet will show in bold letters. 

You can select multiple worksheets at the same time by clicking on one sheet tab and then press
Shift button and click on second sheet tab will select both sheets and shows their background as 
white instead of grey. When you want to deselect these selected sheets you just click on third
sheet tab and you will find sheet1 and sheet2 will be deselected.

3. Inserting work sheet 

In a spreadsheet we can work on three worksheets simultaneously and it can be increased also.

To insert a new worksheet:

1- Define the location
2- Click on Insert<worksheet

 You will see a new worksheet with a new name.

To insert multiple worksheets 1) select them 2) Go to Insert < Worksheet
It will insert desired sheets.

4. Renaming work sheet

Default names of worksheets in any spreadsheets are sheet1, sheet2, sheet3. 

Naming rules while renaming any worksheet are: 

1- Name should not be greater then 31 characters
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2- Name should not contain special characters
3- Any two worksheet names should not be same 

You can change worksheet name just by double click

And rename it.

5. Deleting work sheet 

Just like inserting a new worksheet we can also delete a worksheet. It should be remember when
you delete any worksheet you cannot undo this action.

To delete a worksheet

1-Select the worksheet
2- Click Edit < Delete Sheet

You will see selected sheet has deleted.

Another way to delete a worksheet is: 

1- Do a right click on the worksheet’s name.
2- Select Delete from the menu. 

6. Duplicate a work sheet 

When we want to make another copy of worksheet we use duplicate
worksheet.

 To duplicate a worksheet

1-Select worksheet by click on any cell
2- Click on Edit <Move or Copy Sheet. Will show you a dialogue box
3-Select the position for copy 

This will create a copy of worksheet 1 in the end of sheet3 by name
sheet 1(2).

7. Move a work sheet 

We can move worksheet from one location to another. Move option is 
helpful when we want to arrange sheet numbers in sheet tab. 

 To move a Worksheet:

1- Select worksheet.
2- Click on Edit < Move or Copy Sheet  will show you dialogue box
3- Select position

This will move sheet 4 in worksheet 1 at the end of sheet 3. 
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8. Summary

In this lesson you learnt: 
 Worksheets

How to select worksheets?
How to insert worksheet?
How to rename worksheet?
How to delete worksheet? 
How to duplicate worksheet?
How to move worksheet?

9. Exercise 

In coming exercise you will practice to select multiple worksheets, rename worksheet, insert and
delete worksheets. You will also practice copying and moving worksheets

 Task 1: 
Selecting Noncontiguous Worksheets :
Open any spreadsheet, to select noncontiguous worksheets sheet1 and sheet3 first click 
on sheet 1 tab. Press and hold Control key of keyboard and then click on sheet 3 tab. 
You will see that background color of Sheet 1 and Sheet 3 tabs are changed from gray to
white. It means sheet1 and sheet3 are selected.

Task 2:
Inserting a new worksheet using keyboard :
Open any spreadsheet and now we will add two new worksheets before sheet1 using
keyboard.  To do this, first select sheet 1 and sheet3. Click on sheet 1 tab and then press
and hold the shift key and click on sheet 2 tab.  Sheet1 and sheet2 are selected; now 
press Alt+ Shift+F1 keys of keyboard simultaneously. You will see that two new
worksheets are inserted before sheet 1. 

Task 3:
Rename a worksheet using format-sheet submenu :
Let us change the name of sheet1 in a new spreadsheet. To do this first click on sheet1
tab. Open format menu and point to sheet option. Select rename option from resulting
submenu. Selected sheet name will be highlighted.  Type any new name in sheet1 tab.
Finally, to save this name press enter key of keyboard.

Task 4:
Affecting Multiple worksheets :
To affect multiple worksheets at a time open a new spreadsheet.  Select sheet 1 and
sheet 2 in this spreadsheet. Click on sheet1 tab and type some data in column A and B of 
sheet 1. Then click on sheet 2 tab, it will also contain the same data in column A and 
column B which you entered in sheet1. Click on sheet 1 tab. Select row 4 and open insert
menu. Choose rows from the menu. Blank row will be inserted before row 4. Click on 
sheet 2 tab. Blank row is also inserted before row 4 in sheet 2. To deselect sheet 1 and
sheet 2, click on sheet 3. 

Task 5:
Deleting Noncontiguous Worksheets :
To remove sheet 1 and sheet 3 in a spreadsheet first select sheet 1. Press Control key of 
keyboard and click on sheet 3 tab. Open edit menu and choose Delete sheet option from 
menu. Sheet 1 and sheet 3 are deleted.
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Task 6:
Copying Worksheets using mouse :
Let’s create a copy of sheet 1 in a new spreadsheet using mouse. To do this first click on
sheet 1 tab. Hold down Control key of keyboard and Drag sheet 1 tab with mouse. Notice
plus sign on the icon which is used to indicate that worksheet is copied. Drag this plus
sign to last of sheet tab and then release the Control key of keyboard. A copy of sheet1 is
created with name Sheet1(1) in last of sheet tab. 

 Task 7: 
Moving a worksheet to another Spreadsheet using mouse :
First open any two spreadsheets. To show both Spreadsheets open window menu and
select arrange option. Click on  vertical from dialog box so both spreadsheets are shown
vertically. To  move sheet 1 from first Spreadsheet to another first click on sheet 1 tab. 
Drag the sheet 1 tab and notice that an icon will also move with it. In this way, drag this 
icon to end of second Spreadsheet. You will notice that from first Spreadsheet sheet 1 is 
moved to second Spreadsheet.

Task 8:
Change sheet tab color :
Let us change the color of sheet2 tab in a new spreadsheet. To do this first click on
sheet1 tab.  Open format menu and point to sheet option. Then choose tab color from 
resulting menu. A list of colors is shown. Select desired color and click on OK button.
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 Computer Proficiency License (CS-001) 
Lecture 29 

Formulas and Functions 

1. Objectives 

The objective of this lecture is to provide information about 
Formula and how it is used in worksheets.
How functions are used in worksheets?
How to use If function?
Difference between absolute, relative and mixed referencing?
About error codes and which type of error codes are generated using formulas?

2. Generate formulas

Formula is distinguishing feature of spreadsheet. In absence of formula, it is called a worksheet
which contains text and numbers in tabular form. Formula contains numbers, cell addresses and
operators to perform calculation on these numbers. To perform simple calculations like add,
subtract, multiply etc we will use arithmetic operators.

3. Priority of operators 

When more than one operator is used in the formula, they are evaluated in some specific order.
Precedence of operators is as follows:

Operator/Symbol Order of
precedence

Operations

() 1st Parenthesis

^ 2nd Exponentiation

* and  / 3rd Multiplication/division

- and + 4th Addition and subtraction

Operators having same precedence are calculated from left to right. 

4. Working with functions 

When calculation is lengthy and complicated
in spreadsheets we use functions.

Format of function is:
=FunctionName (List of Arguments)

Function name sows the purpose of the 
function.
Argument list can be numbers, cell
addresses and any range.

Formula can be entered using built-in 
functions and spreadsheet consists of many
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functions like mathematical, statistical and logical etc. 

To enter function

Go to Insert < Function

This will show you a dialogue box from where you can choose your functions.

5. Generate formula using IF 

IF function is very useful logical function in spreadsheets. We use relational operator with logical
operators.
Relational operators: compares any two values that are greater, equal or not equal from each
other. These are:

=
<
>

<=
>=
<>

Format of If Function:
=if (condition, value if true, value if false) 

6. Absolute, relative, mixed cell reference 

When cell addresses are changed in copying a formula it is called relative cell referencing like 
= sum  ( A1 ,  B1 ). 
When cell addresses are not changed in copying a formula it is called absolute cell referencing
like = $ A $ 2 + $ B $ 2. 
When we do not want to make some value as absolute reference and some as relative then it is 
called mix cell reference.

7. Error associated with formulas 

It is possible when you are typing some formula you may make a mistake, due to these common
mistakes error codes are shown in cells.
Some of errors are: 
#Name: error is shown when any function or cell address is misspelled.
#Div / 0: error is shown when any data is divided by zero or blank cell. 
#NULL: error is shown when more than one value are separated by spaces in function. 
#Value: error is shown when wrong data type is entered in formula of function. 

8. Summary

In this lesson we have learnt:

What is formula and how it is used in worksheets?
How functions are used in worksheets?
How to use If function?
Difference between absolute, relative and mixed referencing.
About error codes and which type of error codes are generated using formulas.
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9. Exercise 

You will explore ways to create and copy formulas and functions, use of absolute, relative and 
mixed cell references. You will also learn how error codes are generated by using formulas and
how to avoid from them. 

Task 1:
Using AutoSum :
Create a new Spreadsheet whose first column contains name of monthly expenses and
second column contains amount of each expenses. To calculate total monthly expenses
select the cells which contains amount of each expenses. On the toolbar click on Auto
sum button ( ).  You will see the sum of amount column in last cell.

Task 2:
Adding column values :
Open a new spreadsheet and enter some numbers in Column A and Column B. To add
values in Column A and B and then multiply by 2, first move cell pointer to cell C2. 
Type=A1+B1*2 in cell C2 and press Enter key of keyboard. You will see that number 2 is 
multiplied by value of B1 and then value of A1 is added in it. Now change formula and
type= (A1+ B1) *2 in cell C3. You will notice that first values of A1 and B1 are added and
then result is multiplied by 2. 

Task 3:
Entering formula before entering values : 
Open a new spreadsheet and click on cell C1. Type =A1+B1 and press enter key. You
will see value 0 in cell C1. Now enter value 4 in A1 cell and 6 in B1 cell.  Value of C1 cell 
will be changed to 10. Click on cell C1. Press Ctrl + C keys and select cells C2 to C3. 
Press Ctrl + V keys. Type value 2 in cell A2 and 5 in cell B2. Value of C2 cell will be 7. 
Type value 6 in cell A3 and 9 in cell B3.  C3 will be 15.

Task 4:
Modifying a formula :
Open the Spreadsheet we used in previous exercise. Move cellpointer to C1. Press F2 
key of keyboard. Place cursor to   plus sign by clicking on plus sign. Press delete key of 
keyboard. Type minus sign and press enter. Now formula used in cell C2 is recalculated.

Task 5:
Changing cell references to Absolute :
Open spreadsheet, used in previous exercise, click on cell C1. In C1 cell formula, to 
make A1 and B1 from relative to absolute, first presses F2 key. Click before A1 in formula
bar and press F4 key of keyboard. Then move cursor before B1 and press F4 key of 
keyboard.  You will see a dollar sign before A1 and B1.

Task 6:
Use of sum function by dragging :
In monthly expenses spreadsheet, we will calculate the total monthly expenses using
sum function. Type = sum ( in cell C1 . Drag to select the range C2:C10. You will see
this range in cell C1 = sum (C12: C10 ). Finally press “enter” key of keyboard. Excel will 
total the specified range.

Task 7:
Using Function Average :
In this activity you'll use function to determine average expense of each item and total 
number of expense. Use same worksheet which we used in previous exercise. Move to 
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cell D1 and type Average Expense. Move to cell D2 and click on FX on formula bar.  In 
the dialog box, open select a category drop down list and click statistical from the list. 
Then search for function Average under the select a function list. Click on average and
then click on ok button. Select amount values column in worksheet. You will see that
C1:C7 appears in front of number 1. Finally click on ok button. You will see average 
expense per item in cell D2.

Task 8:
Using Function Count :
Open spreadsheet used in previous exercise,  Type heading total number of items in 
cell B12, and click on C14. Type = sign and click function box arrow which is on left of 
cross button in formula bar. Click on count function and then select cells which contains
amount. In dialog box, range c3: c7 will be added in front of number 1. Finally click on ok 
button; you will see total number of items in C14.

Task 9:
Using Function Date :
Open spreadsheet used in previous exercise To enter date in cell E3, click on cell E3.
Type = sign and click function box arrow which is on left of cross button in formula bar
and click date. If date does not appear, click more functions. In paste functioned box
open category drop down list and choose date and time function. Then choose date
under select a function list and then click ok button. In date dialog box, enter 2006 for
year, 8 for months and 3 for day, click ok. You will see date in cell E3. To enter current 
date in cell E4, click on cell E4. Click on FX on formula bar and open select a category
drop down list and click date and time function. Then search for function Now () under the
select a function list finally click on OK buttons and you will see current date in cell E4. 

Task 10:
Calculating total on multiple Worksheets at simultaneously :
Open a spreadsheet which contains monthly expenses for the month of January. Add 
monthly expenses for the month February in sheet 2. Select Sheet 1 and sheet 2. Now 
click on sheet1 tab and select values of monthly expenses of January. . Click on auto 
sum button on toolbar. Then click on sheet 3 to deselect sheet 1 and 2. Click on sheet 1
and you will see total amount for month of January. Then click on sheet 2 and you will
notice total expenses for month of February are also calculated. 

Virtual University of Pakistan 
86



Computer Proficiency License (CS001) VU

 Computer Proficiency License (CS-001) 
Lecture 30 
Formatting

1. Objectives 

The objective of this lecture is to provide information about 
What is formatting and number formatting?
How to apply different formatting to cell contents? 
How to change foreground and background of cell contents?
How to add border effects to a cell, cell range?
How to set alignment of cell contents?
How to change direction of cell contents?
How to show data of single cell in multiple lines? 
How to center a title over a cell range?
How to apply cell formatting from one location to another?

2. Worksheet Format 

Format means appearance of a thing and formatting 
means to change and improve appearance of a thing. We 
improve appearance of picture by formatting it. When we 
create something we try to improve its layout. We format t
improve it presence and appearance.

o

ormats include commas, symbols and

o apply number formatting:
cell.

This will open a dialogue box in which you can see different tabs. Number tab show you numeric

. Currency Format 

this format a symbol is added in start of number.

o apply currency format:
ange

Currency

. Percent Format

Worksheet formatting includes:
Number formatting 
Text formatting
Date formatting 

Number formatting: To change the appearance of 
numbers different numeric formats are available. Numeric f
percent sign in numbers. Numeric format change only appearance of numbers. 

T
1- Select range or active
2- Click on Format < Cell 

format options.

3

In

T
1- Select number or r
2- Click on Format < Cell <

4
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this format number is muIn ltiplied by 100 and percent symbol is also shown.

range
Percentage

. Change Font of cell contents

 Ariel and size is 10. you can change the font of

o apply any font format:

at < Cell < Font tab. 

. Apply cell formatting to cell contents 

Cell < Font tab < Font Style 

. Apply different color to cell 

und color of cell contents.

o apply foreground color:

at < Cell < Font tab < Color

o apply background color:

at < Cell < Pattern tab 

. Add border

nd a cell or group of cells.

ell < Border tab.

ou can select border style from line option and color from color option.

d numbers are aligned on right side. 

s to align left, right or center.

0. Adjust cell orientation

nts can be changed.

o apply percent format: T
1- Select number or
2- Click On Format < Cell <

5

riting style of data is called font. Default text isW
data before and after entering the data. 

T
1- Select text 
2- Click on Form

6

o apply cell formatT

- Select text1
2- Click on Format < 

7

ou can change background and foregroY

T
1- Select Cells
2- Click on Form

T
1- Select Cells
2- Click on Form

8

order is a line arouB
To create border around cell: 
1- Select cell or cells
2- Click on Format < C

Y
9. Align contents to cell

y default text is aligned on left side anB
To align cell contents: 
1- Select cell or cells

n2-Select tool bar optio

1

y using cell orientation direction of cell conteB
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To apply cell orientation:

1- Select text.
at < Cell < Alignment tab < orientation

1. Apply text wrapping to cell contents 

o display text in multiple lines text wrap options is used.

- Select text or cells
ell < Alignment tab < Text control < Text Wrap 

2. Center a title over a cell range

e can also center a title over a cell range.

- Select cell range
Cell < Alignment tab < Text control < Merge Cell

 to align left, right or center.

2- Click on Form

1

T
To apply text wrap:

1
2- Click on Format < C

1

W
To apply cell title:

1
2- Click on Format <
3- Select Text 

4-Select tool bar options

13. Copy Formatting

e can also copy formatting like font, bold, border, color 

heet

o paste formatting: 

-Select another sheet and move mouse pointer in any

ck on Edit < Paste Special

This will open a dialogue box from which you can select paste opti

4. Summary

this lesson we have learnt:
number formatting?

ents?
contents?

cation to another?

W
etc from one location to another.
To copy formatting: 

1- Select works
2- Click on Edit < Copy

T

1
cell.
2- Cli

ons.

1

In
What is formatting and
How to apply different formatting to cell cont
How to change foreground and background of cell
How to add border effects to a cell, cell range?
How to set alignment of cell contents?
How to change direction of cell contents?
How to show data of single cell in multiple lines? 
How to center a title over a cell range?
How to apply cell formatting from one lo
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5. Exercise

hile unformatted worksheets communicate information, a formatted worksheet adds interest

ask 1:
 Numeric format :

1

W
and can highlight important data. In coming exercise explore how to apply numerous types of 
formatting to text and values such as changing font styles to bold, italic and underline. You will
also practice adding symbols to numeric data and changing color of cell contents and the 
backgrounds of cells. 

T
Apply
Open a new spreadsheet. Select cells A1 to A5 with the mouse. Click on Format menu
on menu bar and choose Cells option. In the dialog box click on Number tab and select
Currency from category list and open drop down list of Symbol. Search for symbol €
(Basque) in the list. In Decimal places section set value 0 and click on OK button. Type
123 in cell A1 and press Enter key. Ten type 123 in cell B1 and see the difference.

pply Date format :
Task 2:

A
t, select cells C1 to C5. Open Format menu and choose Cells 

Task 3:
ge Font characteristics :

In a new spreadshee
option. In the dialog box click on Number tab and select Date from category list. Select
second style from Type section and click on Ok button. Type 1/1/05 in cell C1 and press 
Enter key. See the style of date you entered.

Chan
s A1 to A5 in it. Click on Format menu on menu bar

Task 4:
 conditional formatting :

Open any spreadsheet and select cell
and choose Cells option. In the dialog box click on Font tab and search for Verdana in 
style list under font section. Set size to 16 and then open drop down list of Underline
section. Select Double from the list and then click on alignment tab. Open drop down list 
of horizontal section and choose center from it. Click on OK button and type some data in
cells A1 to A5. See the format of entered data. 

Apply
rksheet and open Format menu. Choose Conditional

Task 5:
 Auto format :

Select cells E1 to E5 in any wo
formatting option from the list, a dialog box is shown. Click drop down list of second entry
box and click on greater than. Type the value 10 in third entry box. Then Click on format 
button and choose Bold from Font style. Open color drop down list and choose red color.
Click Pattern tab and choose violet color square (in third row and seventh column of color
palette). Then click OK to close Format cells box and again click ok to close conditional
formatting box. Type 25 in cell E1 and 10 in cell E2. See the effect of conditional
formatting.

Apply
t which contains some data. Select the data in worksheet and click

Task 6:
Painter and Fill color :

Open any spreadshee
on format menu on menu bar. Choose Auto format option a dialog box is shown. Scroll
the style list and click on colorful1 style from the list. Click on OK button and see the
effect of auto format. 

Use Format 
ins data like A1 to A4. Select some cells which

contain data and click on bold icon and italic icon. Click on format painter icon on toolbar,
Open any spreadsheet which conta
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shape of this icon is like a paint brush. Now select cells C1 to C4 which also contain
some data and see how format of cells A1 to A5 is copied to cells C1 to C4.

Task 7:
ide columns and rows :H
any spreadsheet, to select column E first click on column E heading. After selecting,

ing and choose hide from the resulting menu. Now select row

Task 8:
eeze columns and rows :

In
right click on column E head
4 and 5 using mouse. Open format menu and move mouse pointer to row option and
then click on hide option in submenu. Now column E, row 4 and 5 are hidden. To show
column E, select columns D and F and right click on selection. Choose unhide from
resulting menu. Similarly to show row 4 and 5, select row 3 and 6. Right click on selection
and choose unhide option.

Fr
pen any spreadsheet and to freeze column A place cell pointer in cell B1. Open window

es. Scroll to right until you can see column J. Notice that 

Task 9:
pply different patterns to cells :

O
menu and choose freeze pan
you can still see the column A. Then click unfreeze pane from window menu. To freeze
row 1, place cell pointer in cell A2 and choose freeze pane from window menu. Scroll 
downward and you can still see row 1 although you are in row 30. Now select unfreeze
pane from window menu. Finally to freeze row 1 and column a place cell pointer on cell
B2. Choose freeze pane from window menu and notice that when you scroll to right you 
can see column a and when you scroll downward you can see row 1. 

A
spreadsheet select column A. Open format menu and choose cells option. Click on

of pattern section. Select any style and choose any

Task 10
nderstanding  text formatting :

In any 
Pattern tab and open drop down list
color from the window. Click on border tab and choose inside and outline options from
Preset section. Finally click on Ok button and see the style of column A. 

:
U

a spreadsheet, select cells C1 to C5. Open format menu and choose cells option From 
ory section. Click on Ok button and type 1 in cell A1.

In
Number tab chose Text from categ
Then type 2 in cell B1. Finally type =A1+B1 in cell C1 and see the result. Formula is
shown as you entered due to text format
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 Computer Proficiency License (CS-001) 
Lecture 31 

Charts and Graphs 

1. Objectives 

The objective of this lecture is to provide information about: 
What are charts and its different types? 
How to create chart using chart wizard? 
How to add title, legend, and label to the chart?
How to change chart type? 
How to change background color in chart?
How to format title, legends, and data labels in chart?
How to change bar, line, pie slice colors in chart?
How to duplicate and move charts within a worksheet between spreadsheet?

2. Understanding chart types

Pictorial representation of data is called graph or chart. Graphs are represented by horizontal and
vertical axis, showing constant and values thereof respectively.

Different types of charts are: 

Column chart: Column chart contains vertical columns called bars which show values of item. 
This type is used when we want to create chart of multiple data series.

Bar Chart: Bar chart is represented horizontally.
Line Chart: In line chart, values are connected through lines and upward and downward 

trends are explained explicitly. 
Pie Chart: When data is subdivided into parts, it is more appropriately shown by pie chart

which is circular in shape.
XY Chart: In XY chart numeric vales are used at both the horizontal and vertical sides.

3. Creating simple chart 

To create chart:
Go to Insert < Chart 

This chart wizard create chart in simple four 
steps.
1. Select chart type 
2. Define range
3. Define features like title, legends
4. Define location in spreadsheet

4. Creating pie chart 

To create pie chart:

1-Select range
2-Click on Insert < chart 
3. Select chart type 
4. Define legends, labels etc 
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5-Change the chart type

To change existing chart 

1-Select chart
2- Right click < chart type 
3- Select chart type 

6-Add/remove chart title, legends 

To change chart title 
 1-Select chart

2- Click on Chart < Chart option 
You can change chart title, axis, legends, and labels from 
here.

7-Change background color in chart 

To change background color in chart
1- select chart
2- Click on Format  < selected chart area

8-Formatting chart 

We can change chart data, labels etc after making the chart .We can format chart data together
or separately.

To format the chart

1- Select chart.
2- Click on Format < selected chart area

This will open a dialogue box from which we can change font, color, style etc. 

9-Change pie slices, line, bar color 
Lines, bars, slices used in the chart are called data markers. We can also change color of data 
markers.

To change color of pie chart slices are 

1- Select chart.
2-Selec pie slice
3-Click right < Format data point

This dialogue will open and you can choose any
color for pie slices.

10-Move chart using mouse 

We can move chart in a worksheet. We can 
move chart using mouse or by using cut and paste option.
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To move chart using mouse

1- Select chart.
2- Take mouse on the chart and press left button and by dragging change location of chart. 
3- Release mouse button on desired location.

11-move/copy chart using cut/copy

To copy chart

1-Select chart
2- Click on Edit < Cut or press Crl+X

To paste Chart 

1-Select chart
2- Click on Edit < Paste or press Crl+V

12-Resize/Delete charts 

After creating a chart we can also resize it. 

To resize chart
1-Select chart
2-Click on Selection handles to resize

To delete chart
1-Select chart
2- Press delete

13-Summary

In this lesson we have learnt:
What are charts and its different types? 
How to create chart using chart wizard? 
How to add title, legend, and label to the chart?
How to change chart type? 
How to change background color in chart?
How to format title, legends, and data labels in chart?
How to change bar, line, pie slice colors in chart?
How to duplicate and move charts within a worksheet between spreadsheet?

14- Exercise 

While worksheet provides an effective way to organize information, charts are the best way to
display numbers. In the coming exercise review your spreadsheet skills to create different types 
of chart, add different features and edit charts 

Task 1:
Create a 3-D Visual effect bar chart:
Create a worksheet and enter some items in column A with heading titles and their
January expenses in column B with heading Jan expenses. Select Jan expenses and title
columns. Open insert menu and click on chart option. Select Bar type from first step and
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then select 3-D Visual effect from its subtype. Click on Next button and choose rows from
series in section. Follow the steps of chart wizard and place chart as an object in 
worksheet.

Task 2:
Change Data series :
In monthly expenses spreadsheet add a column named Feb Expense and enter some
values in it. To change data series from January expense to February expense right click
in chart area. Choose Data source from shortcut menu and click collapse icon at right
end of data range box. Click on A1 cell and then select cells A1 to A6. Hold down control 
key and select cells C1 to C6 cells. Then click Expand icon in Source data-Data range
box. Finally click on OK button and see the cart with new data series.

Task 3:
Create a default chart :
Open Monthly expenses worksheet and select cells A1 to B6. Right click on any toolbar
and if a tick mark is not shown in front of chart option then click on it. Search for Chart
type icon on chart toolbar and click on its drop down arrow. Search for line chart icon
which is on the start of fourth line. A line chart is shown on screen; drag the chart so that 
it is centered under worksheet area. 

Task 4:
Apply a Chart Title and change font :
Open monthly expenses worksheet with line chart on it. To add titles in the chart right 
click in chart area. Click chart options on shortcut menu. Then click titles tab and add
headings in it. Click on OK button. To format these titles, again right on chart area and
choose format chart area from menu. Select font tab from the dialog box and choose
Arial font. Set size to 11 and click on color drop down list. Select green color and click on
OK button 

Task 5:
Change color of lines in Line graph :
While monthly expenses still open with line chart, to change color of each line in line 

chart click on any line in line chart to select all lines. Then click on the desired line whose
color you want to change. Right click on selected line and choose format data point from
shortcut menu. From dialog box open color drop down list of line section. Click on yellow 
color. Then in Marker section, click on Background color and select green color. Click on 
Ok button and see the effect. To change weight of all lines and color of markers click on
any line. Right click and choose Data series. Open drop down list of weight in line
section. Select desired weight. Then click on Background color in Marker section and
choose any color. Finally click on Ok button and see the effect. 

Task 6:
Add an arrow and text box to a chart :
Open monthly expenses worksheet and select line chart in it. Click arrow button on
drawing toolbar and draw a line in front of third data marker by dragging the mouse.
When you release the mouse pointer an arrow will appear. Click on text box button on 
drawing toolbar. Click under base of arrow in the chart to insert a text box. Type item 
name and select it. Change its font and size. 

Task 7:
Insert and Move clip Art object :
With monthly expenses spreadsheet still open and chart selected, click the insert menu. 
Point to Picture and click From ClipArt. Select any picture and close clipart window. Click
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the upper right selection handle and drag to lower left corner until the image is 
approximately one inch wide. Click the object and drag it above the left side of the text 
box. Right click the object and click format picture on shortcut menu. Set different options
to format the picture. 
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 Computer Proficiency License (CS-001) 
Lecture 32 

Prepare Outputs 

1. Objectives 

The objective of this lecture is to provide information about: 
How to change margin?
How to change page orientation?
How to add header and footer?
How to add page number?
What are different printing options?

2- Worksheet setup: 

When we start working in the worksheet we take care of some points like page size, page
margins, page orientation etc. Letter and A4 are the standard page sizes. We can choose page
size according to our need. When working in page we left some blank space on left and right side 
These are called margins. Margin size can also be varying. Page orientation can also be
changed. Page orientation is of two types: landscape and portrait. We usually use portrait
orientation.

3- Preview a worksheet:

Whenever we want to take check our worksheet we use print preview option. By using print
preview we can check how it is shown on the paper.

To preview worksheet two methods are there: 
1- Click on File < Print Preview

2. Click on  button. 

4- Change margins and Orientation:

To set page margins:

1- Click on File < Page Setup < Margins

To set page orientation:

2- Click on File < Page Setup < Page 

5- Add/Remove header footer: 

A feature with which same information is not typed 
repeatedly called Header and Footer.
Header: Information on top of every page is called
header.
Footer: information on bottom of every page is c
footer.

alled
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To add header or footer:

Click on View < Header and Footer 

6-Type data in header footer 

To add text in header and footer:

1- Click on View < Header and Footer < Custom Header/Footer

This dialogue box help you in entering data in left, right and center.

7-Turn on/off gridlines in printing: 

Horizontal and vertical lines in worksheet
are called gridlines. We have options to print
row numbers, column headings and
gridlines.

To use gridlines:

Click on File < Page Setup < Sheet 

This dialogue box will help you in printing. 

8-Printing:
We can take print out of our worksheets
prepared using spreadsheet software. File 
created using a software and saved in computer are called softcopy and print out of soft copy is 
called hard copy. 

Three methods are there for printing:
1- Click on File < Print 
2- Press Ctrl+P

3- Press print button 

9- Print charts in worksheet:

We can take print out of charts with data and without data. If we print worksheet without selecting
chart then data and chart both are printed.
We can take print out charts only. 

To print charts:

1- Select chart
2- Click File < Print

To print data of charts only:

1- Select chart
2- Right Click < Format chart area < Properties < Deselect Print object
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10-Summary:

In this lesson we have learnt:
How to change margin?
How to change page orientation?
How to add header and footer?
How to add page number?
What are different printing options?

11-Exercise

In the coming exercise you can improve the appearance and usefulness of your printouts by 
changing the page margin, specifying a target print area, adding headers and footers. You will
also learn how to take printout of your worksheets

Task 1:
Select a print range :
In monthly expenses worksheet, select range from A1 to B6. Open file menu and point to 
print area and select click on Set Print Area on submenu. Click Print preview on toolbar to
view the print range. Click on close button on print preview toolbar. To clear print range
open file menu. Point to print area and click on Clear Print Area on submenu.

Task 2:
Insert and Remove Page breaks :
With monthly expenses still open, to print items name on one page and expenses on
other page select column B and C. Open Insert menu and select Page break. A dotted
line is shown after column A. Click on print preview icon and you will see the names of 
items on page 1. Click on Next button on toolbar to view the next page. You will see
expenses on the next page. Click close button on toolbar and open Insert menu. Choose
Remove page break from the menu to clear the page breaks.

Task 3:
Setting orientation, Margins and center worksheet on a page :
In monthly expenses worksheet, open file menu and click page setup option. Click on
page tab and choose landscape from orientation section. Set print quality to highest
option. Click Margin tab and set top margin and bottom margin to 1.25. Click horizontally
and vertically options in center on page section of page setup dialog box. Click print
preview button.

Task.4:
Create a header and footer : 
Open monthly expenses Worksheet and select sheet1 and sheet 2 tabs. Open view 
menu and choose the option header and footer. Click on customer header option and 
then click in center section. Click sheet icon from toolbar which is third last icon on
toolbar. Then press ok button and then click on customer footer. Click in center section. 
Type page and click on # icon in toolbar, then type “of”   and click on plus sign in toolbar.
Click ok button and then click on print preview button. Sheet1 is shown on top and page 1 
at bottom, click on next icon on print preview toolbar and you will see sheet2 on top of 
page.

Task.5:
Applying and printing formula used in Cells :
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Open any spreadsheet in which formulas are used. Click on tools menu and then on 
options. In dialog box, click view tab and then select formula option in windows options
section. A checkmark will appear in front of formula and finally click ok button. You will 
see formula within the cells Click file menu and select page setup Click on landscape
option in orientation section and fit in scaling section. Click print preview button, then click
zoom button to adjust the view. Click print button and ok. Finally press Control + ~ keys 
to deselect formula option.

Task.6:
Previewing and printing multiple sheets :
Open a spreadsheet in which sheet 1, sheet 2 and sheet 3 contains some data.  To print 
all three sheets at once first click on sheet 1 tab. Hold the shift key and click on sheet 2 
and sheet 3 tab. Click print preview button. Click zoom button to magnify image. Click 
next button on toolbar two times to cycle through three selected sheets. Click print button 
in print preview window and then click ok.

Task.7:
Hide some columns and rows in WS :
Open an already created spreadsheet. Since you want to print a report that does not 
include column C. Right click on column C heading and click hide. Click on print preview,
column C is not shown so print the worksheet. To again display the hidden column C first 
select Col B and D. Right click on the selection and click unhide. Column C will be shown
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 Computer Proficiency License (CS-001) 
Lecture 33 

Advance Topics

1. Objectives 

The objective of this lecture is to provide information about 
What is pivot table?
How to create pivot table? 
What is data consolidation and how to consolidate the data among worksheets?

2. Pivot tables 

Pivot tables are interactive tables which automatically extract, organize and summarize the data.
Pivot tables are used to prepare summary reports.

3. How to create pivot tables 

1. Open the workbook where you want to create the Pivot table report.
o If you are basing the report on a report template, Office Data Connection file, or 

query file, retrieve the data into the workbook, and then click a cell in the 
Microsoft Excel list containing the retrieved data. 

If the retrieved data is from a database, or the Office Data Connection returns the 
data as a blank PivotTable report, continue with step 6 below.

o If you are basing the report on an Excel list or database, click a cell in the list or 
database.

2. On the Data menu, click PivotTable and PivotChart Report.
3. In step 1 of the PivotTable and PivotChart Wizard, follow the instructions, and click

PivotTable under What kind of report do you want to create?
4. Follow the instructions in step 2 of the wizard.
5. Follow the instructions in step 3 of the wizard, and then decide whether to lay out the 

report onscreen or in the wizard.

4. Worksheet consolidation 

1. Examine your data and decide whether to consolidate it with 3-D references in formulas,
by position, or by category.

Formulas   You can use 3-D references in formulas for any type or arrangement of data. 
This is the recommended method.

Position If you're planning to combine data that's in the same cell in each of several
ranges, you can consolidate by position.
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Category  If you have several ranges with different layouts, and you're planning to
combine data from rows or columns that have matching labels, you can consolidate by 
category.

1. On the consolidation worksheet, copy or enter the labels you want for the
consolidated data. 

2. Click a cell that you want to contain consolidated data.
3. Type a formula that includes references to the source cells on each worksheet

that contains data you want to consolidate.

For example, to combine the data in cell B3 from worksheets Sheet 2 through
Sheet 7 inclusive, you could type =SUM (Sheet2:Sheet7!B3). If the data to 
consolidate is in different cells on different worksheets, enter a formula such as
this: =SUM (Sheet3!B4, Sheet4!A7, Sheet5!C5). To enter a reference such as
Sheet3! B4 in a formula without typing, type the formula up to the point where
you need the reference, click the worksheet tab, and then click the cell. 

4. Set up the data to be consolidated.

 Make sure each range of data is in list format: each column has a label
in the first row and contains similar facts, and there are no blank rows or
columns within the list.
Put each range on a separate worksheet. Don't put any of the ranges on 
the worksheet where you plan to put the consolidation.
If you're consolidating by position, make sure each range has the same 
layout.

If you're consolidating by category, make sure the labels for columns or 
rows that you want to combine have identical spelling and capitalization.

Name each range: select the entire range, point to Name on the Insert
menu, click Define, and type a name for the range.

5. Click the upper-left cell of the area where you want the consolidated data to
appear.

6. On the Data menu, click Consolidate.
7. In the Function box, click the summary function you want Microsoft Excel to use 

to consolidate the data.
8. Click the Reference box, click the sheet tab of the first range to consolidate, type

the name you gave the range, and then click Add. Repeat this step for each
range.

9. If you want to update the consolidation table automatically whenever data in any
of the source ranges changes, and you're sure you won't want to include different
or additional ranges in the consolidation later on, select the Create links to 
source data check box.

10. If you're consolidating by position, leave the boxes under Use labels in blank.
Microsoft Excel does not copy the row or column labels in the source ranges to
the consolidation. If you want labels for the consolidated data, copy them from 
one of the source ranges or enter them manually.

If you're consolidating by category, select the check boxes under Use labels in
that indicate where the labels are located in the source ranges: either the top
row, the left column, or both. Any labels that don't match up with labels in the 
other source areas result in separate rows or columns in the consolidation.
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5. Summary
In this lesson, we have learnt

What is pivot table?
How to create pivot table? 
What is data consolidation?

Exercise

Task 1:
 Create a pivot table :
Create a SS which contain sales figure of every product your company makes.
Worksheet contains columns for year, type, salesperson, sale, units, and region. Open 
Data menu and click Pivot table and Pivot chart Report. From step 1 select Microsoft 
Excel and click on Next. In step 2 ranges is already selected for you click on Next. In third 
step New Worksheet is already selected click on finish button. Drag region icon from
pivot table field list to row field section. Drag Type icon from pivot table field list to column
field section. Drag Sales icon from pivot table field list to Data field section.
 Finally a Pivot table is created on the screen.

Task 2:
Add or remove field :
To add or remove columns click on pivot table created in previous exercise. To remove 
region field from row section, click on region heading. Drag it to outside the pivot table 
report. To add columns in pivot table Click on show field list icon in pivot table toolbar,
and drag sales person field icon from pivot field window to row section you will see 
names of salespersons in pivot table row section.

Task 3:
Show just the detail :
To show selected field data in pivot table open pivot table created in previous exercise. In
pivot table, click arrow besides any field heading. From the list deselect any item which
you do not want to show. Click on Ok button and deselected items will not be shown in
pivot table. 

Task 4:
Data consolidation :
Create a Spreadsheet whose sheet 1 contains monthly expenses of different items for 
month of January, Sheet 2 contains monthly expenses for month of February, and sheet
3 for month of March. In sheet 4 calculate average expense of each item. Add headings
Items name and Average expenses in starting cells. Select cells under average expenses
heading. Open Data menu and select consolidate option. Click function drop down list
and choose function name average. Click icon of miniature spreadsheet in reference
field. Next click on sheet 1 tab. Select values under amount column and again click on
miniature spreadsheet icon. Click add button to save it, repeat this process and add
sheet 2 and 3 data. Finally Click creates to link to save data box. Finally click on ok
button.
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 Computer Proficiency License (CS-001) 
Lecture 34 

Introduction of Power Point 

1. Objectives 

The objective of this lecture is to provide information about: 
Open and close presentation software. 
Open one, several presentations.
Create a new presentation based on an available presentation.
Save a presentation to a location on a drive. 
Save a presentation under another name.
Switch between open presentations.

2. Open and Close Power point application 

To open the presentation file, first you need to start software. 
Go to start < All Programs < Microsoft Office < Microsoft Office PowerPoint l2003
In the start a screen will appear for few seconds. This is called splash screen. A new presentation
file will open, after this screen would disappear. The arrangement of toolbars panels and sheets
is called default layout. 

3. Screen Layout: 

Title Bar:
The most upper bar of window is called title bar. Its top left corner shows the document default
name like “Microsoft PowerPoint presentation1“ shows document is of type Microsoft PowerPoint
and its temporary name is presentation1.When we save the document we can give another name
to document

A file created by presentation software is called presentation. On the right side of title bar there
are three buttons to minimize, restore and close the excel file. 
Minimize button is used to minimize the document. Restore is use to restore down and close
button is use to close the document.

 Menu bar: There is another bar after the title bar is called menu bar. Menu bar contains
different options to use features like file, edit, view etc 

For using any main menu we just move the mouse cursor over it and it will show submenu.

 Toolbar: The strip next to menu bar is toolbar. Toolbar is shortcut of menu bar sub options.
We also called it standard toolbar because it has buttons to perform important tasks.
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We can use these options by clicking icons. For knowing the purpose of these icons just take the
mouse pointer over there and wait for a while you will see name of icon in form of label. This label
is called tool tip text. 

 Task pan: When you start the presentation software you will find on the right side a panel
called task pan. On the top of task pan there is written by “Getting started” and you will find
options to search from online help, to open recently opened presentation files and to create a new
presentation etc. 

 Slide area: In the center of presentation you see a white area called slide. Another area down
to slide is notes area. We can add notes for explaining the matters discussed on the slide in notes
area. On the left side of slide, index of all the slides in the presentation can be seen. We use this
area to view several pages in the presentation.

Drawing toolbar: Bottom of page a bar called drawing toolbar, which is used for making
different shapes.

4. Creating and saving new presentation 

To create a new presentation:

1-Click < File < New.

The New Presentation Task Pane will appear on the 
right side of the window.

2-From the New Presentation Task Pane, click Blank 
Presentation.

Two ways to insert a new slide:

1- Click < Insert < New Slide.

2- Press Ctrl+M.

 To save a presentation:

After creating the presentation the next step is to save them. We will use “SAVE” command of file 
menu to save presentation:

Three ways to save a file: 

1- Click < File < Save
2- Press Ctrl+S
3- Click on Save Icon  in formatting toolbar

5. Run a presentation 

Three ways to run a presentation:
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1- Press F5 key
2- Click < Slide Show < View Show
3-  Click view button

6. Save a presentation with another name 

When you want to make changes in existing file and to make another copy of existing file, we will
use “SAVE AS” option of file menu. 

7. Closing a presentation 

You can close a presentation at any time. Note that although this closes the presentation window,
it does not exit PowerPoint.
To close a presentation, follow these steps:

1- Click File < Close or 
2- Click the presentation’s Close (X) button.

8. Open one, several presentations 

Files are saved on disk we can open it by any time. 
To open a presentation file there can be three ways:

1- Click File < open 
2- Click on the Open icon
3- Double click left mouse button on the presentation file. 

9. Switching among open presentations 

There can be two ways to switch among open files: 

1- Click file name visible in the taskbar.
2- Press Alt+Tab. 

10. Exercise 

Task 1:
Creating Shortcut on the Desktop:
Click on the Start button. Click on All Programs menu option. Locate Microsoft Power
Point option. Now drag the icon of MS Power Point on the desktop. The shortcut of MS 
Power Point is now on the desktop.

Task 2:
Starting Microsoft Power Point:
Click on Start button in the bottom left most corner of the screen. Now point to the All 
Program option. Now click on the Microsoft Office option. Locate Microsoft Power Point & 
left click on it. In this way Power point will get started.

Task 3:
Creating & Saving a new Presentation:
First start the MS Power point. Click on File menu from Menu bar. Click on New option.
The shortcut key for this purpose is Ctrl + N.
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Now enter the some text in the text boxes of the presentation slide(s). Click on File menu 
from Menu bar. Click on Save option. A window titled Save As appears. Select the 
location where you want to save the presentation. Write the name you want to save file 
with. The shortcut key for this purpose is Ctrl + S. In this way we will create and save a 
power point presentation 

Task 4:
Finding & Replacing Text in the Slide:
Click on Edit menu from Menu bar. Click on Find option. A window appears titled Find.
Write the text in the text box which you want to find. Click on Find Next button. If that 
particular text exist then it will be highlighted otherwise error message will be displayed. If 
you want to replace the found text then click on Replace button. Write the new text in the
new text box appeared & click Replace or Replace All button according to the 
requirement. We can also restrict our search to “case sensitive” or “search complete
word” by checking the check boxes Match Case and Find whole words only. The
shortcut key for opening this Find window is Ctrl + F. The replacement can also be done
by selecting the Replace option from the Edit menu. The shortcut key for this purpose is 
Ctrl + H

Task 5:
Changing of Font style:
Select the text of which font style is to change. Select the particular font style from the 
dropdown Font style list located in formatting toolbar. In this way the font style of selected
text will be changed.

Task 6:
Insert Table into the Presentation slides:
Create / open the presentation slide. Click on the Insert menu from Menu bar. Now click
on the table option from Insert menu. Enter the number of rows and columns required in 
the window appeared. Click OK button to create table.
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 Computer Proficiency License (CS-001) 
Lecture 35 

Developing a presentation 

1. Objectives 

The objective of this lecture is to provide information about: 
How to view a presentation in different ways? 
What is slide layout and how to add slide in presentation?
How can we use design template to improve a presentation?
How to use slide master to manage a complete presentation?

2. Presentation views 

A view is a way of displaying and working with your 
presentation and it is possible to display a presentation in a 
number of different ways. Each view displays the slides in a 
different way and emphasizes a different aspect. PowerPoint 
has four different views which you can work in. 

Each of the different views can be selected from the View
drop-down menu as:

Normal – Displays your slides one at a time for easy editing. 
Slide Sorter – Displays slide thumbnails for all the slides in the presentation.
Slide Show – Displays your slides one slide at a time filling the whole screen. 
Notes Page – Displays your slides one at a time with space for you to add additional notes.

You can switch to a different view either by using the View drop-down
menu or by using the buttons in the bottom left corner of the 
application window.

2.1 Normal view:

This is the default view and opens automatically when PowerPoint is started. This is also referred
as the tri-pane view. 
The large pane in the middle is the slide editing 
pane. This allows making the necessary f
changes. In this view you can edit your slides one
at a time 

ormatting

This view lets you work with a combination of 
features simultaneously including editing the slide, 
outline/slides and the Notes pane. The pane on 
the left hand slide is called the Outline/Slides 
pane. The Notes pane is displayed at the bottom 
and the main pain is called the Slide Pane.

You can adjust the sizes of the individual panes.
Each of these panes has its own scroll bar so you can move around in the different panes
independently.
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2.2 Slide Sorter view:

This allows you to easily rearrange your slides
by dragging the slide thumbnails. It also 
indicates any slide transitions, text animations
and displays their times.

The slide number is displayed below each
slide and any transitions and animations are 
indicated. You can reorder, delete cut and
paste slides, add animations, transitions and 
set timings in this view. 

2.3 Slide Show:

Display the slides as an on-screen presentation taking
up the full screen. This runs your presentation from the 
first slide .This view displays any slide transitions and
timings

2.4 Notes Page view:

This displays your slide in the top part of the window and
displays any notes in the bottom part. While the notes for 
each slide are available in the Normal view, this view 
displays the notes as they will be printed. These notes do 
not appear during a slide show.

The Notes page will only be displayed if you print the 
Notes page from the printing options.

3. Adding new slides

There are several ways you can insert a new slide into a 
presentation:

1) Selecting Insert > New Slide.

2)   Using the New Slide button on the standard toolbar
3)   Using the Slides shortcut menu.
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4) Using the Slide Sorter shortcut menu.

5)   Using Outline view.
6)   Use the shortcut key Ctrl + M.
7)   New slides are always added after the currently displayed slide.

4. Using design template 

To change design of slide:
Click Format < Slide design. This will open a task pan on right side.

There are several designs in this list that can be applied on our slides with a single click. 

5. Using master slide 
 We can create a new slide master to modifying the default slide master.

To create slide master click View> Master > Slide Master
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Then click the New Master icon (highlighted in the figure)

A second slide master appears in the Slides pane. Modify this slide master to you’re your 
requirements.

Applying a slide master 

To apply one of the slide masters to all slides in your presentation
 Click on it in the list.

To apply a different slide master to one or more selected Slides: 
1) In the Slide Pane, select the slides you want to change.
2) In the Tasks Pane, right-click on the slide master you want to apply to the selected 
slides, and click Apply to Selected Slides on the pop-up menu. 

Exercise

Task 1:
Creating a slide:
Open the PowerPoint program. The PowerPoint dialog box appears. In the PowerPoint
dialog box, click the Blank Presentation option button. The New Slide dialog box appears.
It asks you to choose an Auto Layout format. Click the Title Slide layout. It's the first in the 
list. The name Title Slide appears in the preview box. Click OK. A Title Slide appears,
ready for you to work with. 

Task 2:
Adding text to a slide:
The Title Slide layout contains text boxes for a title and a subtitle. Try typing text into 
these boxes. Click in the Title text box. A thick gray border appears around the text box 
indicating that it is selected. Type a title. Click the Subtitle text box and type a subtitle.

Task 3:
Adding another slide:
Click the New Slide button on the Common Tasks toolbar. The Auto Layout dialog box 
will appear. Choose a layout for your next slide. 

Task 4:
Moving from slide to slide:
To move to a previous slide:
Click the upper double-arrow button on the lower right corner of the PowerPoint
window. The previous slide will appear. To move to the next slide: Click the lower double-
arrow button on the lower right corner of the PowerPoint window.

Task 5:
Creating a presentation using templates:
If you have just launched PowerPoint, click the Template option button in the PowerPoint
dialog box to start a new presentation. If you are already working in PowerPoint, follow 
these steps: Click the File menu, then click New. The New Presentation dialog box
appears. Click the Presentation Designs tab, and then click an appropriate template. The 
design will appear in the preview box. Click OK. The New Presentation dialog box will 
close.
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Computer Proficiency License (CS-001) 
Lecture 36 
Formatting

1. Objectives 

The objective of this lecture is to provide information about: 
How to create text boxes and create texts in them? 
How to change font style, size and color of text in slide? 
How to apply bullets and numbering in a slide? 
How to add relevant pictures and adjust them? 
How to cut copy and paste in slides?

2. Adding Text: 
To add text to a title of a slide: 

 Click in the box that says "click to add title" Just type in the text you want. 

3. Adding New Text Box 
To insert a new textbox: 

Select Insert > Text Box or use the button from the Drawing toolbar.

The cursor will change to a cross, letting you to click where you want the new textbox and drag 
the mouse diagonally to create it. Type the text immediately, if the textbox is left blank and then
de-selected the textbox will be deleted automatically. 

4. Deleting Text Box 

Click the border of the text box that you want to delete, and then press DELETE.

Make sure that the pointer is not inside the text box, but rather on the border of the text box. If the 
pointer is not on the border, pressing DELETE will delete the text inside the text box and not the 
text box. 

5. Rotating Text Box 

To rotate a text Box: 

Select the text box you want to rotate. 
You find a green circle on the top of text box; it is actually a rotate tool of text box, when you take
mouse over the circle its shape change to circle. Then rotate the text box as you want. 

6. Border and Fill Color to Text Box 

1-Right-click on the text box
2- Select Format Text Box or select Format menu > Text Box.
You can select your desired fill color and border from this dialogue box. 

7. Change Font Style and Size 
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We can also change font and font size. 

To change Font and font size: 

Click Format > Font 

This dialogue box will appear, select text 
font and size.

8. Bold, Underline, Italic and 
Shadow

To change font style: 

1- Select text.
2- Click Format > Font > Font Style 

9. Text Alignment 

Alignment means how we can display text on the slide. PowerPoint offers four types of paragraph
alignment: Left, Right, Centre and Justify.
To apply text alignment:

 C lick Format > Alignment

10. Bullets and Numbering 

We can add bullets and numbering by two ways: 

Bullets:

1- This button is a toggle. Press it once to add bullets and then press it again to remove the 
bullets.
2- Click Format > Bullets and numbering.

Numbering:

1- This button is a toggle. Press it once to add numbering and then press it again to remove the 
numbering.
2- Click Format > Bullets and numbering.

11. Making Sub Points 

We can also make sub point by adding bullets and numbering.
To make sub points: 

1- Select text lines 
2- Press Tab key.

12. Increasing and Decreasing Font Size 

We can change font size of any text
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To increase Font size: 
1- Select text
2-  Press increase font size button.

To increase Font size: 
1-Select text 
2- Press decrease font size button. 

13. Changing Font Color
We can also change font color .Any of two methods can be chosen: 
1-  Press this once to change the selecting text.
2- Click Format > Font > Font color 

14. Adding Pictures 

We can add picture and images in slides.

To insert picture:

1) Using a Clip Art Placeholder.
2) Using a Content placeholder.
3) Using the Clip Art Task Pane.
4) Using Insert > Picture > From File. 

15. Copy and Paste Objects 

You can copy and paste data between different slides and presentations using the clipboard.
To Copy Text:

1- Select Text
2- Click Edit < Copy or Press Ctrl+C

To Paste Text:
1- Select Location to paste. 
2- Click Edit < Paste or Press Ctrl+V 

16. Cut and Paste Objects 

You can cut and paste data between different slides and presentations using the clipboard.
To Cut Text: 

3- Select Text
4- Click Edit < Cut or Press Ctrl+X

To Paste Text:
3- Select Location to paste. 
4- Click Edit < Paste or Press Ctrl+V 

Exercise
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Task 1:
Adding Text to the Presentation Slide:
Open the new presentation. A slide will appear containing two text boxes. Each text box 
has some instructions written into it. Left click in the text box and add text which you want
through keyboard.

Task 2:
Adding new Slide into the Presentation:
Open the presentation in which you want to enter the new slide. Click on “New Slide”
option from formatting toolbar. A new slide will be inserted into that presentation. 

Task 3:
Adding Text Box to the Presentation Slide:
Open the slide where you want to enter the text box. Click on the Insert menu from Menu
bar. Click on Text box option from Insert menu list. The shape of mouse pointer will 
become like  . Now drag this pointer where you want to insert the text box in the slide.
The same option of text box can also be selected from “Drawing toolbar”.

Task 4:
Duplicating the Slide:
Open the presentation. Select the slide which you want to make duplicate. Click on the 
Insert menu from menu bar. Click on option “Duplicate Slide” to create its duplicate.

Task 5:
Password Protection of Presentation:
Open the presentation on which you want to apply password protection. Click on Tool
menu from menu bar. Click on Options link. A widow will appear titled Options. Click on 
Security tab. Enter the password with which you want to open the presentation. Also
enter the password for modifying the presentation. Click Ok button to implement these
changes.

Task 6:
 Automatically Save Presentation:

Click the Tool menu from Menu bar. Now click on the option named Options. A window
will appear titled Options. Click Save tab. Check the check box named “Save auto 
recover every” and then select the time after which you want to save the presentation.
Click Ok button to implement the changes.
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Computer Proficiency License (CS-001) 
Lecture 37 

Charts and Objects 

1. Objectives 

The objective of this lecture is to provide information about: 
How to add graph in presentation?
How to create and edit organizational chart?
How to draw different objects and format them? 

2. Creating charts and graphs 

One way to add a chart to a presentation is to apply a slide layout that contains a chart
placeholder. There are several layouts on the Slide Layout task pane that can be used.

1) Use the Content Palette 
2) Use the Chart Placeholder
3) Use Insert  > Chart 

All these methods use the Microsoft Graph application to allow you to insert charts directly.

3. Editing charts 

We can change data values and labels at any time. 

To change a graph or chart just change its data values in data sheet.
To delete a data, just select it and press delete will delete data from chart. 

4. Formatting charts 

The lines on the edges of the chart are referred to as the axes. The X-axis is the line along the
left edge of the chart. The x-axis usually indicates categories .The actual data values are plotted
on the y-axis. Microsoft Graph will automatically provide labels for the axes but these can be
changed manually.

To format or change any portion of graph, double click on it with left mouse pointer. Formatting
dialogue box related to particular portion will open up for making changes.
We can change color, text, labels, font etc

5. Changing chart type

To change chart type: 
1-Right click on an empty white space of graph. 
2- Click Chart Type 
A dialogue box named as “chart type” will open, select desired chart type. 

6. Changing chart label 

To change chart labels
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1- Right click on empty white space of chart. 
2- Click Chart Options 
The dialogue box show you chart options, you can change data labels, legends etc from here.

7. Organization chart

A graphic representation of data of an organization is called organizational chart. We can also
show structure of any project in the form of chart. 

To create organization chart:
1- select slide layout as organization chart
2- Apply layout with single click.
3- Double click on diagram.

It will open a dialogue box, select appropriate diagram type. 

8. Drawing Objects 

We can use and work with different objects on a slide. Anything created on a slide is called 
object. We can draw any object on empty slide. For drawing purpose, drawing tool bar is 
available to draw different shapes.

9. Drawing lines 

To draw a line:

 Select line tool from toolbar  . 
 Click left mouse button and drag the mouse to click a shape.

10. Drawing arrows

To draw arrow:

 Select arrow tool from toolbar  . 
 Click left mouse button and drag the mouse to click a shape.

11. Drawing rectangle 

To draw rectangle

 Select rectangle tool from toolbar  . 
 Click left mouse button and drag the mouse pointer diagonally downward.

12. Changing orders 

We can place object over each other and also can changed their order. 

To Change order:
 Right Click > Order
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It shows you further four options. Select them according to your need.

13. Summary

In this lesson we have learnt:
How to add graph in presentation
How to create and edit organizational chart
How to draw different objects and format them 

13. Exercise 

Task 1:
Adding a shape:
PowerPoint lets you add a variety of shapes to the slides of your presentation. Try adding
a star shape to your slide, using the AutoShape tool on the drawing toolbar. Click the
AutoShapes button, point to Stars and Banners, and then click the 5-point star shape.
The pointer will change into a cross. Click anywhere on the slide. A star of predefined
size will be inserted. To make the shape larger (or smaller), drag a resizing handle. To
resize the shape proportionally, hold down the SHIFT key as you drag.

Task 2:
Adding color and texture to a shape
First, try adding the color yellow to the star. Click the star shape to select it. Click the
arrow beside the Fill Color button, and then click More Fill Colors. A Colors dialog box
appears. Click the Standard tab, then under Colors, click a shade of yellow. Click OK to
close the Colors dialog box.

Task 3:
Adding a chart:
To add a chart to any slide, click the Insert Chart button on the Standard Toolbar. When
you insert a chart, a sample data sheet and corresponding bar chart will appear on your
slide. PowerPoint has included some sample data in the first four columns. The bars in
the chart are the graphical representation of the numbers in the data sheet. Notice how a
higher number in the data sheet results in a taller corresponding bar. To create your own
chart, you can replace the data in the sample data sheet with your own. Try adding a 
number to the chart to see how it changes the corresponding bar on the chart. On the 
data sheet, click in the first row of column A. Type in the number 50, then press Enter.
The corresponding bar on the chart increases in height. Try adding other numbers into
the data sheet to see how they affect the bars. 

Task 4:
Adding and deleting information:
The default chart has four sets of bars, and its data sheet has four columns of information
filled in. What if your presentation requires more than four columns/bars? It's simple. Fill
in additional columns on your data sheet. Go to the next empty column on the data sheet 
and click inside a cell. Type the numbers 50, 60, and 70 in the first three rows. Notice
how a new set of bars appears in the chart.
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Task 5:
Changing the type of chart:
The default chart in PowerPoint is a bar chart. If you think your information would be 
better as a different type of chart, you can change the chart type. The following steps
show you how to convert the bar chart to a pie chart: Double-click the chart you want to
change. A heavy border appears around the chart, and the data sheet appears. Click the
Chart menu, and then click Chart Type. A Chart Type dialog box appears. In the Chart
Type list, click Pie, and then click OK. The information in your data sheet will now be
displayed in a pie chart.
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 Computer Proficiency License (CS-001) 
Lecture 38 
Animations

1. Objectives 

The objective of this lecture is to provide information about: 
How to apply animation scheme on presentation slides?
What is animation and how is it related to presentation?
What is purpose of slide transition?
How to apply animations effect in slides?

2. Concepts 

Moving sequence of image is called animations. An animation is based on sequence of objects
appearing quickly one after another. Examples of animations are cartoons. We can animate
different objects in our slides. Using animation in our slides we can provide better control. We can
also use mouse click or keys of keyboard to control the slides in our presentation.

3. Slide transition

These are animations affect applied to the whole slide show. These effects are shown when we
move from one slide to another.

To add slide transition

Click Slide Show > Slide transition. 
 Select transition style from the list

4. Animation scheme

Slide transition only deals with the animations of the slides. It does not deal with the animation of 
objects on the slide. 

To apply animation on text box 

 Click Slide Show < Animation scheme
Select animation scheme from list. 

5. Custom animation 

To apply custom animation

 Click Slideshow < Custom animation 
 Select text or picture etc 
 Apply transition

6. Changing order 
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When ever we apply animation to slide it numbered the transition effects. We can change order of 
the item presented in the list. This action will be done on mouse click.
To change order:

 Select item 
 Press “Reorder “button upward or downward according to need.

7. After Previous option 
You can animate list of things automatically without mouse click.

Click. Press Shift +item.

8. with previous effect 
With previous means object will start its motion along with its preceding object.

9. Summary:

In this lesson we have learnt:
How to apply animation scheme on presentation slides?
What is animation and how is it related to presentation?
What is purpose of slide transition?
How to apply animations effect in slides?

10. Exercise 

Task 1:
Change the Slide Design:
Open the presentation for which you want to change the slide design. Click on Design
option from the Formatting toolbar. A task pane containing a list of design templates will
be opened. Click on the design template you want to implement particular design.

Task 2:
Apply Animation Scheme on the Presentation Slides:
Open the presentation. Click on Design option from the Formatting toolbar. A window
(task pane) will appear on the right side of the presentation slides. Click on “Animation 
Scheme” option. Now click on the animation from the animation list. Now click on the
button “Apply to All”. Animation will be applied to all slides.

Task 3:
Disable Password Protection:
Click on the Tools menu from Menu bar. Click on option named Options. A window will 
appear. Click on the Edit tab. Click on the check box named Password protection in the
option list of Disable new features. Click Ok button to implement these changes.

Task 4:
Changing in Slide Design Color:
Open the presentation for which you want to change the slide design color. Click on 
Design option from the Formatting toolbar. A task pane will be opened. Click on “Color
Scheme option”. A list of color schemes will be opened. Click on the color scheme you
want to apply on slide design.

Task 5:
Changing the Slide Layout:
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Open the presentation slide. Click on Format menu from Menu Bar. Click on “Slide
Layout” option. A task pane containing different layouts will appear. Click on the layout 
which you want to implement on the slide.

Virtual University of Pakistan 
122



Computer Proficiency License (CS001) VU

Computer Proficiency License (CS-001) 
Lecture 39 

Printing a Presentation 

1.Objectives

The objective of this lecture is to provide information about: 
How to remove spelling mistake from slides?
How to add reference notes to our slides?
How to hide and delete a slide?
How to change page setup for printing presentation?
How to take presentation and use different printing options?

2. Spelling Check 

There can be three ways to use spell check:

1-Go to the Tools menu and select Spelling.
2-By right click mouse button

3-using

If a misspelled word is found:
Select Change to use PowerPoint's suggested spelling or to change the word to the spelling of 

your choice; type your own spelling into the window.
Select Add to add the word to your spell-check dictionary, so that PowerPoint won't think it's 

misspelled next time

3. Adding Notes 

We can add short text points on slide in 
notes area. The notes are not shown during
the presentation. To use these notes we
have to take their print out separately. We 
can view notes pages by clicking View <
Notes Pages.

To take print out of Notes pages:

1-Click File < Print Preview. This will open a 
window.
2-Select “Notes Pages” from Print What option.

3- Click Print  Button 

4. Hide and unhide slide 

After preparing presentation we can check its order and sequence. It is also possible that that you 
hide some slides for presentation.

To hide a slide:
1- Select the slide in index area which you want to hide
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2-Right Click on slide and Select “Hide Slide” option or Click Edit < Hide Slide 

To unhide a slide: 
1- Select the slide in index area which you want to unhide
2-Right Click on slide and Select “Hide Slide” option or Click Edit < Hide Slide 

5. Page setup

We can take the print out of our slides and
notes but for this we have to change its 
page setup. Page setup can be landscape
or portrait. Standard page is of portrait. 

To change page setup:
Click File < Page Setup 

This dialogue box will open, you can make changes according to your requirement.

6. Printing slides 

We can take print out of our slides prepared using Microsoft Power point. File created using a
software and saved in computer are called softcopy and print out of soft copy is called hard copy.
Three methods are there for printing:

4- Click on File < Print 
5- Press Ctrl+P

6- Press print button 

7. Summary

In this lesson we have learnt:
How to remove spelling mistake from slides
How to add reference notes to our slides
How to hide and delete a slide
How to change page setup for printing presentation
How to take presentation and use different printing options

8. Exercise 

Task 1:
Checking your spelling:
It's a good idea to check the spelling in your presentation before the audience sees it. Let
PowerPoint's spelling checker check the presentation for you. When you activate the 
spelling checker, it checks the spelling in all of your slides. On the Standard toolbar, click
the Spelling button. If a spelling error is detected a Spelling dialog box appears. The
Spelling Checker suggests an alternative spelling in the Change To box. An additional list
of suggestions may also appear below the box. If you want to continue without changing
the spelling, click Ignore. If you want to change the spelling, enter one of the suggested
alternatives in the Change to box, and then click Change.

Task 2:
Turning the automatic spelling checker off
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Click the Tools menu, then click Options. The Options dialog box appears. Click the
Spelling tab. Under Check spelling as you type, click the Spelling check box to deselect
it. The check mark disappears. Click OK to close the Options dialog box. The automatic
spelling checker is now deactivated.

Task 3:
Printing your presentation:
Follow these steps to print your presentation. Click the File menu, and then click Print.
The Print dialog box will open. To print all the slides in your presentation, click all. In the
Print what list box; select what slide contents you want printed.  In the Number of copies
list box, enter the number of copies you want printed.  Click OK to print the presentation

Task 4:
Selecting a new bullet style for points:
Click anywhere in the bulleted text to select it. Click the Format menu, then click Bullet.
The Bullet dialog box will appear. Click the square bullet in the symbol grid. If you want,
select a new color for the bullet in the color list box. Click OK. The new bullet style will
appear in your bulleted text.

Task 5:
Hiding and unhide Slide
Right click on the slide in slide pane. Click hide slide in the opened menu. Slide will be
hiding. To unhide the slide. Right Click slide in slide pane and click hide slide so slide will
be unhide.
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 Computer Proficiency License (CS-001) 
Lecture 40 

Internet

1. Objectives 

The objective of this lecture is to provide information about: 
Difference between internet and www? 
What is webpage, web browser and website?
What is meaning of search engine, ISP, FTP, HTTP and URL? 
How to open and close a web browser?
How to change home page and open a web page in new window?
What is the purpose of refresh, stop and history in the web page?

2. Internet and WWW 

WWW: stands for World Wide Web, It was introduced in 1991 and is the application of internet.
World Wide Web means collection of online documents, which are stored in computers as 
services connected to internet and is the way to collect information from internet 
All of the websites in the world, taken together, make up the World Wide Web. We can get 
information from the World Wide Web through browsers.

Internet: The Internet is the worldwide network of interconnected computers, including both web
servers and computers like the one on your desk that run web browser software and share
information, Instant messaging , email etc. The Internet also carries other kinds of network traffic 
unrelated to the web.

3. Web page, web site and web server 

Website: website is the way to get information on internet and it provide lot of information related
to any topic. A website is a collection of web pages maintained by a single person or 
organization. A website has a distinct domain name, such as www.vu.edu.pk. Everything on
www.vu.edu.pk, such as this page, is considered to be part of the www.vu.edu.pk website.

Web Page: every website is made up of one or more web pages. Web page contains text with 
hyperlinks, tables, and other formatting and also contains images, sound, movies etc 

Web Server: web servers are the computers that actually run websites and are connected to 
internet. Each website has its own web server and it stores all web pages on server. web server 
control web site and it has special software to store collection of websites. The most common
web server software is Apache, followed by Microsoft Internet Information Server.

4. Hyper text link: Hyper text was first introduced by Ted Nansen. In hypertext, text is not 
represented in sequence. It is non sequential writing. To connect non sequential pages links are
created. Links are basically the connection to next pages or area. It means hyper link are links
which lead us to next page on mouse click. Numerous type of material can be accessed by 
hyperlinks. When links are created on picture, graphics, and audio and video then these are
called hypermedia links.

5. Web Browser: Browse means to see through some object or thing. When we visit some
website it means we are browsing that site. To see some website on internet we need some
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browser. Browsers are those programs that let you explore information on www or programs to 
view a website is called web browser. Many of web browser are available in the market like
internet explorer, mosaic etc. purpose of all these browsers are only to browse WebPages but all 
the web browser provides different features along it like bookmark , history etc.

6. Http, Ftp and URL 

Data is transferred from one computer to other through some rules, these rules are called
protocol. Different protocols are used on internet like HTTP, FTP and TCP/IP etc.

HTTP: stands for hypertext transfer protocol. It is protocol to transfer WebPages from web server
to web browser. Basic purpose of http is to transfer those pages which contain hyper text links. All 
web pages URL start with http. For example: http:// vu.edu.pk

FTP: stands for file transfer protocol. Using this protocol we can access files from the ftpserver.
Ftp server are those computers on internet which store different type of files. These servers are
maintained by universities, college or agencies etc. Some files on the ftp can only be accessed by 
some specific users, to copy these types of files we have to enter their password. For anonymous
ftp sites, files are accesses without any password. These file can have any extension like .doc,
.jpeg, .txt etc. 

7. Understand makeup & structure of URL 

URL stands for Uniform Resource Locator. A URL can be thought of as the "unique address" of a
web page and is sometimes referred to informally as a "web address." URLs are used to write
links linking one page to another; for an example, http:// vu.edu.pk.

Structure of URL:

A URL is made up of several parts.

For example http:// vu.edu.pk/cgi-bin/neomail.pl

The first part is the protocol, which tells the web browser what sort of server it will be talking to in 
order to fetch the URL. In this example, the protocol is http.

The Second part is its name, which tells about the organization, it is associated like vu.edu.pk.

The third part of the example URL is the path at which this particular web page is located on the 
web server. http:// vu.edu.pk/cgi-bin/neomail.pl

8. Search Engines 

Search means to find some thing. Search engines are program that searches documents for
specified keywords and returns a list of the documents where the keywords were found. Like
Google, AltaVista etc 

Search engines used software called spider to search documents on internet. Documents are
sent to search indexing software. Indexing software extract information from documents storing in
database, then database is search fro that documents that match to our word search. Search
engines assembles web page that shows the result as hyper text link. 
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9. ISP, How to connect internet

ISP stands for internet service provider. ISP are always connected to internet, is basically a
company or organization which facilitate user by taking some fee. User can connect to internet 
through ISP’s. Most of ISP’s let you connect to internet through by dialing a local phone number.

To connect through internet we need computer, modem and telephone line. steps involved to
connect internet are: 
1-Connect telephone to computer through modem
2- Run software of internet to connect
3- Enter username, password and ISP number

ISDN: stands for integrated service digital network. It is a digital phone line. Data transfer speed
is faster than modem. Now a day we can connect to internet by cable, DSL etc.

10. First step with the web browser

To open internet explorer:

 Click on Start < Programs < Internet Explorer or Click  from desktop

11. Basic layout and closing a web browser

All browser contain menu bar, title bar, tool bar, status bar, scroll bar etc. Basic component of 
Internet Explorer are title bar, menu bar, status bar, tool bar, scroll bar etc 

Tool Bar: The most upper bar of window is called title bar. On the right side of title bar there are
three buttons to minimize, restore and close internet explorer.
Minimize button is used to minimize the window. Restore is use to restore down and close button
is use to close the internet explorer

Menu bar: There is another bar after the title bar is called menu bar. Menu bar contains different
options to use features like file, edit, view etc 

For using any main menu we just move the mouse cursor over it and it will show submenu.

Toolbar: The strip next to menu bar is toolbar. Toolbar is shortcut of menu bar sub options.
We also called it standard toolbar because it has buttons to perform important tasks.
We can use these options by clicking icons. For knowing the purpose of these icons just take the
mouse pointer over there and wait for a while you will see name of icon in form of label. This label
is called tool tip text. 

Address bar: displays URL of open web page. 
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Status indicator: is basically a graphical icon which shows that status of internet explorer.

Progress Bar: A standard Windows control that displays the percentage of completion of a 
particular process as a graphical bar

Browser pan: The area in middle of screen shows some text, hyperlinks and graphics are called
content area or browser pan.

To close Browser there are several methods like 
1- Click File < Close 
2- Press Cross button (X) on title bar 

12. How to change home page in web browser

When we start internet explorer, the first page we see on the screen is called home page or start
page.
To change home page: 

 Click Tools < Internet Options < General < Address

13. Display web page in new window

We want to open web page without closing other or copy a web page then: 
 Click File < New < Window

14. Stop a web page from downloading

In many situations, we stop web page from opening for example when a web page take a lot of 
time to open, click on wrong link , some portion of web page open and we just stop for further
processing.

We can stop a web page either of two ways: 
1- Click View < Stop 
2- Click on Stop button 

15. Refresh a web page 

Refresh means to view web page with latest changes. Using this option we do not have to enter 
URL in address bar again.

We can refresh a page by three ways: 

1- Press F5 key 

2- Refresh button
3- Click View < Refresh

16. Display previously visited sites 

When we visit some sites in browser, the browser keep its address of sites which we opened
before. Browser saves these sites in history.
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To view history:
 Press Ctrl+H or Click Tool < History or History button

17. Changing number of days in history list 

We can set number of days that our history
should be kept. To change history days:

Click Tools < Internet Options

This dialogue box will open.
Select history section to change days.

18. Deleting single entry, clear list 
of history

It is possible to delete history item or history
list.

To delete single item: 

1- Right Click on Item
2- Select delete

To delete list:

1- Click Tools < Internet Options
2- Select History section to delete history

19. Summary:

In this lesson we have learnt:
Difference between internet and www 
What is webpage, web browser and website?
What is meaning of search engine, ISP, FTP, HTTP and URL? 
How to open and close a web browser?
How to change home page and open a web page in new window?
What is the purpose of refresh, stop and history in the web page?

20. Exercise 
In the coming exercise review your Internet skills to start a browser, open any web page and 
close a browser 
Task 1:

Starting browser:
Start computer and Click on Launch internet explorer browser button on Quick Launch
toolbar. If necessary click connect to dial up your ISP. 

Task 2:
View a Web Page :
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First of all connect internet and start browser. In address bar type web page address and
click Go or press Enter. Another way is t click the address bar drop down arrow and
selects a web page address you've opened in the current session.

Task 3:
Enter an Address using Auto complete :
In the browser begin to type an address that you have recently entered. Auto complete
remembers previously entered addresses and tries to complete the address for you.

Task 4:
Browse Folders and Open files from the Address bar:
Type location of hard disk you want to open in the address bar like C:\ or d:\ or e:\. To
open any folder of drive types like c:\ my documents etc. Then click Go on the address
bar or press Enter. Menus and toolbar change to the ones used in windows explorer.  If 
you want click Views button on toolbar and select the view option you want to use.

Virtual University of Pakistan 
131



Computer Proficiency License (CS001) VU

 Computer Proficiency License (CS-001) 
Lecture 41 

Web Navigation 

1. Objectives 

The objective of this lecture is to provide information about: 
How to go to any URL? 
How to activate a hyperlink/image link? 
How to move backward and forward in visited websites?
How to place a bookmark on web page and how to view it? 
How to create a book mark folder and add web page in it? 
How to delete a book mark?

2. Go to a URL 
To visit any website, we should know its URL, URL is typed in 
address bar of browser.
There are several ways to open a web page:
1-write URL in address bar
2-Click File < Open
This will open a dialogue box, enter desired URL in it and 
press ok.
3- Press CTRL+O

3. Navigating backward and forward in a web page 

We can move backward and forward in any website.

To move backward:

 Click Backward button

To move forward: 

 Click forward button

To move home page: 

 Click Home button

We can also move to visited web pages by clicking View < Go < “site name” 
We can move backward and forward using key board e.g. ALT+LEFT and ALT+RIGHT

4. Activate a hyperlink

When we click with mouse on hyper link it is activated means it moves you to next page you click.
Some links bring to download a file, broadcast TV or radio. 

A web page can have three types of links: 
1- Image maps links
2- Text links 
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3 – Picture links

Some links are opened in same window or some are in other window.
To open link in other window:

 Right click on link
 Select open in new window

5. Book mark a web page 

When we visit some site and we like it, we can save it. For saving any site it mean we are making
bookmark means we are putting mark on this site that we can open it again. We can make list of 
those sites which we like, some browser say it Book mark and some browser say it favorite. 

To put site in favorite, we can have several methods:
1- Click Favorite button from toolbar 
2- Click on Favorite < Add to favorites

6. creating a book mark folder and add page in it 
When list of favorites grow long, we can make it short by 
making folder and also we can organize them. 
To organize:
1-Click on Favorite < Organize Favorite

A dialogue box will open, Click on New Folder.
This will create a folder. 

To add page in this folder: 
1-Click Favorite < Add to Favorite 
A dialogue box will open. 
2- Select Folder from Create in option.
3- Add page in it. 

7. Delete a book mark 

We can delete web pages or folders from favorites list. 

To delete folder:
Click on favorite < organize favorites 
Select Folder / page 
 Select delete button to delete folder.

8. Display book marked page on toolbar 

To display favorites in tool bar as shortcut:
Click View < Toolbar < Links

9 Viewing favorite list on screen 

We can also see favorites item on the left side of screen.
To view on left side of screen:

Click on Favorites button from toolbar.
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10. Summary:

In this lesson we have learnt:
How to go to any URL? 
How to activate a hyperlink/image link? 
How to move backward and forward in visited websites?
How to place a bookmark on web page and how to view it? 
How to create a book mark folder and add web page in it? 
How to delete a book mark?

11. Exercise 
In the coming exercise you will learn how to retrace your steps and return to a web page. Also 
how to save your favorite web pages list separately

Task 1:

Move back in a  browser :
In a browser you can move to previous web page by clicking on Back icon on toolbar, by 
choosing Back from go menu within view menu, by pressing Alt + Left arrow of keyboard
or pressing right mouse button and selecting back option

Task 2:

Create a favorite list :

To add a web page in favorite first of all opens the desired web page in browser. Then
right click anywhere in the background of a web page. Click Add to favorites on the
shortcut menu. Type name for the site in dialog box Name section. If you want, click 
Create in to add the site to a folder within the favorite folders

Task 3:

Move a favorite to a folder :
In the browser click favorite menu and then click organize favorites. Click the favorite you
want to move to another folder. Click Move to folder. Click the folder where you want to 
move the favorite. Click Ok When you're done, click Close

Task 4:

View your hard disk and add a folder to your list of folders :
Display contents of your hard disk by typing c:\ in address bar and then press enter. Then
open view menu and move mouse pointer to explorer bar and select favorites to display
favorite list in left pane. Drag a folder from right pane to favorite’s pane. Release your
mouse button when folder icon is positioned correctly within favorite list. When you're
done click close button. 

Virtual University of Pakistan 
134



Computer Proficiency License (CS001) VU

Task 5:

Setup a website for offline viewing :

Open the website you want to add. Click favorite menu and click Add to favorite. Click to 
select the make available offline check box. Then click customize option and Next to
configure your page for offline viewing. Click Yes option button to allow viewing of entire
web site. Click Next to continue. Choose synchronization schedule option you want and
then click Next to continue. Then if web site requires user authentication enter your user
name and password and click finish. Finally choose folder and then click ok.
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 Computer Proficiency License (CS-001) 
Lecture 42 

Search Engines 

1. Objectives 

The objective of this lecture is to provide information about: 
What are search engines and how to select a search engine?
How to search a specific in formation with the help of keyword?
How to use selection criteria in a search? 
How to copy image text or URL from a web page to the document?
How to set page size, page orientation or margins in a web page?
How to print web page or specific web pages or selected text etc?

2. Search Engines 

World wide web contain million of web pages that its difficult to tell their exact figure, so to find out 
required information is possible through search engines. Search engines help us to find
information on the web and store the information about web pages. It usually search web pages
according to any phrase or keyword. Search engines used software of Spider, it is called spider
because spider visits many websites in parallel at the same time and also visit different web
servers. When the Spider search Web server it make central repository to save related websites
URLS’s. This repository of web server is called database or index. After specific intervals, spider 
store new and updated websites URLS’s in database.

3. How to use any search engine 

There are many search engines on net like Google, AltaVista and Ask etc

To search any website: 
 Write keyword in entry box

Search Specific site:
 Write keyword in double quotations.

When we search any web site, relevant websites are on front page.

4. Combine selection criteria in search 

With simple search, we can get variety of results. We can refine and narrow these results. 

To use selection criteria:
 Click on Advanced Search options.
 Use Boolean operators to search combine words.

We ca also search Title, URL and Domain search of any website.

5. Different search engines 

AltaVista: is the most popular and biggest search engine. Its URL is www.altavista.com . We can
use Boolean operators, domain search, title search and URL search. It is very useful engine for
complicated search.

Virtual University of Pakistan 
136



Computer Proficiency License (CS001) VU

Google: Google gives most relevant results. We can perform simple as well as advanced search.
Its URL is www.google.com . 
Excite: It is most comprehensive search engine. Its URL is www.excite.com .It has large 
database approximately 10 million sites can be stored. 

Lycos: It is also a comprehensive search engine. Its URL is www.lycos.com . It can search
picture, city guides and road maps easily.

Yahoo: it finds information on web quickly. It is better to use yahoo when your search term is 
large because yahoo add any website in database after great search.

HotBOt and Lycos database is bigger than yahoo and search long terms is possible efficiently.
There are some other search engines like WebCrawler, open text and galaxy.

6. Copy a text from a web page to a document 

Duplicate means to copy same data on different location. We can copy or duplicate any text or
image data. 

To copy Data:
1- Select data
2- Click Edit < Copy or press Ctrl+C

To paste Data:
1- Select target location
2- Click Edit < Paste or press Ctrl+V 

7. Copy image from web page to a document 

To copy image: 
3- Select image
4- Click Edit < Copy or press Ctrl+C

To paste image:
3- Select target location
4- Click Edit < Paste or press Ctrl+V 

8. Copy URL from web page to a document 

We can also copy URL from browser to a document. 

To copy URL:
5- Select URL from browser
6- Click Edit < Copy or press Ctrl+C

To paste URL: 
5- Select target location
6- Click Edit < Paste or press Ctrl+V 

9. Save a web page on hard disk 
We can save a web page on hard disk. We can open web page data without connecting internet. 
To save a web page on hard disk: 
1-Click File < Save As
2- Select target location on disk to save 
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10. Save a graphic 

We can save a graphic as file. 

To save graphic:
1- Right Click on graphic
2-Select Save Picture As option
3- Select target location and Enter Name of graphic

11. Download text file, image 

Downloading is process of transferring file from remote computer to user computer.

To download a file: 
1- Select File
2- Right Click on file 
3- Select Save Target As

You can also save an image in the same way as file. 

12. Web page orientation, margins, header, footer 

Web page may be wider than paper, so some text could be wrap. First save page to hard disk
than take printout. We cam also use color printer to take colored printing.

To set a web page orientation for printing:
1- Click File < Page Setup 
2- Set Header and footer
3- Set page orientation

14. Printing web page 

To print a web page: 
Click File < Print 

15. Summary:

In this lesson we have learnt:
What are search engines and how to select a search engine?
How to search a specific in formation with the help of keyword?
How to use selection criteria in a search? 
How to copy image text or URL from a web page to the document?
How to set page size, page orientation or margins in a web page?
How to print web page or specific web pages or selected text etc?

16. Exercise 
In coming exercise you will learn how to search from a list of search engines for web sites that 
match your criteria and also learn how to print web pages

 Task 1: 
Search the Internet using the search button :
Open the browser. Click search button on standard toolbar. Internet explorer chooses a 
search engine at random. Type the information you want to use for the search. Click the
search, find or seek button as each search provider label its search button differently. If 
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you don't find the web site you want click the next button. To perform a new search, click
the new button under the search heading on top. Finally click cross button to right of 
search heading or click search button on toolbar. 

Task 2:
Download a file from a public ftp site :
In address bar type the URL for public ftp site. If site offers it, double click the link to the 
Pub directories to display the list of files you can download. Right click the link for the file 
you want to down load, and then click copy to folder. Select the folder in which you want 
to save the file. Click Ok.

Task 3:
Create a style sheet :
Open the web page you want to use as style sheet. Click tools menu and then click 
internet explorer. In general tab, click colors. Select colors to be used for text and
background and for visited and unvisited links. Then click ok and click file menu, select
save as to save web page to your local disk. Type file name and click webpage, html only 
from save as type drop down arrow. Finally, click “save”.

Task 4:
Print current page :
Open desired page to print. First open file menu and click page setup option. From dialog
box click size drop down arrow and select a paper size. Enter header like &w for window
title and footer &u to print page address. Click portrait or landscape option. After clicking
ok again open file menu and choose print. Set current page in this dialog box and finally 
click ok to print it. 
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Computer Proficiency License (CS-001) 
Lecture 43 

Electronic Mail 

1. Objectives 

The objective of this lecture is to provide information about: 
What is email and what is structure of email address?
How to open and close email application?
How to open email inbox for specific user? 
How to open several mail messages at a time? 
How to close mail messages?

2. Concepts 
In ancient times, people use letter as way of communication and they send it through post offices
but it took long time to reach destination. In modern days way of communication have been
changed because of internet and new ways were adopted to send information quickly e.g. 
telegram, fax, telephone and email etc. 

Email is abbreviation of electronic mail. With the help of email we can exchange information
around the world. Only difference between email and other letter is that email is written through
key board and sends through internet while letter is written by hand and send through postoffice.
It is the fastest way of communication than letters and it can be sending at any time when it is
convenient.
When we send email messages from one computer to another then email client SMTP and POP3
are used. Email clients are those programs used for writing, sending, receiving and displaying
email messages like yahoo mail, hotmail, and outlook express.

SMTP: is simple mail transfer protocol and used to send and receive email messages.
POP3: is post office protocol and used to receive email messages. Email client interacts with 
POP3 server to discover and download new email messages.

3. How email works

First you compose a mail and send it. Message is sent to your internet service provider’s email
server. Message is then sorted in recipient’s electronic mail box. To read message, log on to
email server and retrieve message. To read message, first you have to enter password.

4. Email system using email client SMTP and POP3 

Steps to send email messages:
1- Message is prepared using email client. 
2- Email client sent it to SMTP server( if receiver is local then mail goes to POP3) 
3- Receiver computer picks it at his/her computer
4- If mail is sent to SMTP than SMTP server send it to local computers POP3 and receive it

5. Understanding the structure of email address 

Whenever we send any mail we should know the address of recipient.
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Structure of Email address: Email address consists of two parts separated by “@ “symbol.
First part identifies the name of user account and second part contains URL of persons account
on internet like awais@yahoo.com

6. Open and close email application 

To open Email client Out Look Express:
 Click Start < All Programs < Microsoft Office < Microsoft Out Look Express

To Close Out Look Express: 
 Click File < Exit

7. Layout of email application 
Any email program contains components to write, send and receive email messages.

8. Create an email account

To use an email program its important to have email 
account.
To create an account on yahoo: 

1- Type www.mail.yahoo.com in browser 
2- Click on Sign Up

3-Fill the Form by entering user name and password and more

9. Open a mail box for specific user 

You can open email account which you have created before by user name and password. Enter 
User name and password and Click Sign In. 

10. Open one and several messages 

When ever we got any email, it goes to our inbox .we can read and write mail here.
To read mail: 

 Click on Inbox 
 Click on ay message to read 

To compose a mail: 
 Click on Compose
 Write and send mail 

11. Close a mail message 

To close a mail message:
 Click on Close (X) button of window

10-Summary:

In this lesson we have learnt:
What is email and what is structure of email address
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How to open and close email application?
How to open email inbox for specific user? 
How to open several mail messages at a time? 
How to close mail messages?

11-Exercise

In the coming exercise you can improve the appearance and usefulness of your printouts by 
changing the page margin, specifying a target print area, adding headers and footers. You will
also learn how to take printout of your worksheets

Task 1:
Select a print range :
In monthly expenses worksheet, select range from A1 to B6. Open file menu and point to 
print area and select click on Set Print Area on submenu. Click Print preview on toolbar to
view the print range. Click on close button on print preview toolbar. To clear print range
open file menu. Point to print area and click on Clear Print Area on submenu.

Task 2:
Insert and Remove Page breaks :
With monthly expenses still open, to print items name on one page and expenses on
other page select column B and C. Open Insert menu and select Page break. A dotted
line is shown after column A. Click on print preview icon and you will see the names of 
items on page 1. Click on Next button on toolbar to view the next page. You will see
expenses on the next page. Click close button on toolbar and open Insert menu. Choose
Remove page break from the menu to clear the page breaks.

Task 3:
Setting orientation, Margins and center worksheet on a page :
In monthly expenses worksheet, open file menu and click page setup option. Click on
page tab and choose landscape from orientation section. Set print quality to highest
option. Click Margin tab and set top margin and bottom margin to 1.25. Click horizontally
and vertically options in center on page section of page setup dialog box. Click print
preview button.

Task.4:
Create a header and footer : 
Open monthly expenses Worksheet and select sheet1 and sheet 2 tabs. Open view
menu and choose the option header and footer. Click on customer header option and
then click in center section. Click sheet icon from toolbar which is third last icon on
toolbar. Then press ok button and then click on customer footer. Click in center section.
Type page and click on # icon in toolbar, then type “of” and click on plus sign in toolbar.
Click ok button and then click on print preview button. Sheet1 is shown on top and page 1
at bottom, click on next icon on print preview toolbar and you will see sheet2 on top of 
page.

Task.5:
Applying and printing formula used in Cells :
Open any spreadsheet in which formulas are used. Click on tools menu and then on
options. In dialog box, click view tab and then select formula option in windows options
section. A checkmark will appear in front of formula and finally click ok button. You will 
see formula within the cells Click file menu and select page setup Click on landscape
option in orientation section and fit in scaling section. Click print preview button, then click
zoom button to adjust the view. Click print button and ok. Finally press Control + ~ keys 
to deselect formula option.
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Task.6:
Previewing and printing multiple sheets :
Open a spreadsheet in which sheet 1, sheet 2 and sheet 3 contains some data.  To print
all three sheets at once first click on sheet 1 tab. Hold the shift key and click on sheet 2
and sheet 3 tab. Click print preview button. Click zoom button to magnify image. Click 
next button on toolbar two times to cycle through three selected sheets. Click print button 
in print preview window and then click ok.

Task.7:
Hide some columns and rows in WS :
Open an already created spreadsheet. Since you want to print a report that does not
include column C. Right click on column C heading and click hide. Click on print preview,
column C is not shown so print the worksheet. To again display the hidden column C first
select Col B and D. Right click on the selection and click unhide. Column C will be shown
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 Computer Proficiency License (CS-001) 
Lecture 44 
Messaging

1. Objectives 

The objective of this lecture is to provide information about: 
What is a flag? How to flag a mail message and remove a flag message? 
How to mark a mail message as read or unread?
How to open and save a file attachment in a local hard disk? 
How to create a new message and how to reply to more than one person?
How to attach email with a message?
How to copy, move and forward message?

2-Flag mail message 

After reading the mail you have two options. Some mails are replied urgently and some are
replied late. It is possible we forgot to reply some urgent messages, so for this reason flag feature
is introduced.

To apply flag on the message of inbox folder: 
1- select a message 
2- Click On Actions < Follow Up < Red Flag

To remove flag: 
1- Right click on message 
2- Select Clear Flag Option 

3- Mark message as read/unread 

Messages which we have read called read messages and messages which we have not read are 
called unread. It is possible top make read messages as unread and unread messages as read.

To make a message as read:
1- Select message
2- Right click on message 
3- Select Mark as read

If we marked a folder then all its messages are marked as read /unread

4- Open and save file attachment on hard disk 

Attachment is a file which is attached with mail and we can download this attached file. We can
also attach data file with mail. We can also attach other files like audio, graphics etc

To download a file: 
1- open message
2- select attach file
3- right click on file 
4- Select Save Target As(download on hard disk) or Select Open (to see in same

application)

5- Use Reply/ Reply All 
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Reply means answering to one person but reply all mean answering multiple persons.
To reply a message:

1- open message to reply 

2- Select Reply Button
3- Than type/attach message and send

6- Reply with or without original message
It is possible we send message with original message or 
erase that message.
To send message without original message:

1- Click Tools < Options ( it will open a dialogue box)
2- Press Email Options button from email section

3- Select On Replies and forward section for adding
and removing original message

7- Add a contact in list
You can make a record of your email addresses.
To add a contact:

1- Click on contact folder. 
2- Click  on new contact

   3-   Add related info 

8- Create a new message 
To write a mail:
1-Click on New < Mail Messages
2- Write mail and send. 

9- Insert a mail address in To field 

Whenever we send an email we insert address in To box. It is also possible we don’t write email
address but add it from contact list. 
To add address from contact list: 

Click on TO field

10- Carbon copy (CC), Blind Carbon Copy (BCC) 

CC: is abbreviation of carbon copy and from this option we can send email to more than one
email address.
BCC: is abbreviation of blind carbon copy and from this option we can send email copy to more 
than one person but the message will be secret message means email address of BCC is not 
shown to TO and CC addresses.

11- Use spells checking in email 

Email message window works same as word processor. Like word we can also use spell check in 
email messages.

To spell check:
1-Select word
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2-Click on Tools < Spelling and Grammar

12- Forward message

We can forward same message.
To forward email message:

 Click on Forward button

13- Cut and copy text within or between messages 

We can copy text between messages.

To copy: 
1-Select text 
2- Click Edit < Copy or Press Ctrl+C

To paste:
1- Select target location
2- Click Edit < Paste or Press CTRL+V

14- Attach a file to a message 

We can attach a file with our email message and any type of file can be attached.
To attach a file: 

 Click on Attach button 

15-Summary:

In this lesson we have learnt:
What is a flag? How to flag a mail message and remove a flag message? 
How to mark a mail message as read or unread?
How to open and save a file attachment in a local hard disk? 
How to create a new message and how to reply to more than one person?
How to attach email with a message?
How to copy, move and forward message?

16-Exercise

In the coming exercise you can improve the appearance and usefulness of your printouts by 
changing the page margin, specifying a target print area, adding headers and footers. You will
also learn how to take printout of your worksheets

Task 1:
Select a print range :
In monthly expenses worksheet, select range from A1 to B6. Open file menu and point to 
print area and select click on Set Print Area on submenu. Click Print preview on toolbar to
view the print range. Click on close button on print preview toolbar. To clear print range
open file menu. Point to print area and click on Clear Print Area on submenu.

Task 2:
Insert and Remove Page breaks :
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With monthly expenses still open, to print items name on one page and expenses on
other page select column B and C. Open Insert menu and select Page break. A dotted
line is shown after column A. Click on print preview icon and you will see the names of 
items on page 1. Click on Next button on toolbar to view the next page. You will see
expenses on the next page. Click close button on toolbar and open Insert menu. Choose
Remove page break from the menu to clear the page breaks.

Task 3:
Setting orientation, Margins and center worksheet on a page :
In monthly expenses worksheet, open file menu and click page setup option. Click on
page tab and choose landscape from orientation section. Set print quality to highest
option. Click Margin tab and set top margin and bottom margin to 1.25. Click horizontally
and vertically options in center on page section of page setup dialog box. Click print
preview button.

Task.4:
Create a header and footer : 
Open monthly expenses Worksheet and select sheet1 and sheet 2 tabs. Open view 
menu and choose the option header and footer. Click on customer header option and 
then click in center section. Click sheet icon from toolbar which is third last icon on
toolbar. Then press ok button and then click on customer footer. Click in center section. 
Type page and click on # icon in toolbar, then type “of”   and click on plus sign in toolbar.
Click ok button and then click on print preview button. Sheet1 is shown on top and page 1 
at bottom, click on next icon on print preview toolbar and you will see sheet2 on top of 
page.

Task.5:
Applying and printing formula used in Cells :
Open any spreadsheet in which formulas are used. Click on tools menu and then on 
options. In dialog box, click view tab and then select formula option in windows options
section. A checkmark will appear in front of formula and finally click ok button. You will 
see formula within the cells Click file menu and select page setup Click on landscape
option in orientation section and fit in scaling section. Click print preview button, then click
zoom button to adjust the view. Click print button and ok. Finally press Control + ~ keys 
to deselect formula option.

Task.6:
Previewing and printing multiple sheets :
Open a spreadsheet in which sheet 1, sheet 2 and sheet 3 contains some data.  To print 
all three sheets at once first click on sheet 1 tab. Hold the shift key and click on sheet 2 
and sheet 3 tab. Click print preview button. Click zoom button to magnify image. Click 
next button on toolbar two times to cycle through three selected sheets. Click print button 
in print preview window and then click ok.

Task.7:
Hide some columns and rows in WS :
Open an already created spreadsheet. Since you want to print a report that does not 
include column C. Right click on column C heading and click hide. Click on print preview,
column C is not shown so print the worksheet. To again display the hidden column C first 
select Col B and D. Right click on the selection and click unhide. Column C will be shown
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 Computer Proficiency License (CS-001) 
Lecture 45

Mail Management 

1- Objectives 

The objective of this lecture is to provide information about: 
How to create a new address list and add or delete mail address in it? 
How to search a message by subject and a sender and mail contents?
How to create a new folder and how to move messages to a new folder?
How to sort and delete the messages?
How to undelete the deleted messages and how to empty delete item folder? 

2- Managing email 

When we receive many mail messages, it results into over abundance of email messages in 
inbox or sent email folder. As a good practice, these should be managed. To manage your email
there can follow options.

1. Create new folders for messages
2. Save your messages in hard disk
3. Delete unwanted or read messages

3- Create an address book 

In real life, you can use diary to record the name and address of your friend. It is good to use
diary to remember the details of your friends. It is difficult to remember to remember many email 
addresses. Email program makes life easy by providing a facility to record email ids of all 
contacts in address book. You can save name, phone number, email ids and some related
information in an address book. Address book works like a diary.

4- Add a mail address to address list 

1. Click on the contact tab in the right side of the MS Outlook.
2. Go to File < New < Contact
3. A new window will open. Enter name and email id of the contact and click on Save and 

Close button below the menu bar. 

5- Delete a mail address to address list 

The way we have added the contact in address book, we can delete the contact with few clicks.

1. Select the email contact (s) from address book by single click. 
2. Click on the Remove button or right click on the contact name and select delete from the 

drop down menu.
3. Contact(s) will be deleted. 

6- Update an address book from incoming mail 

To save the email id from the inbox 
1. Right click on the name of the sender of email in the inbox 
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2. Click on the move to the folder
3. Select contacts from the list 
4. Click on the contacts folder to view the newly added contact 

7- Search message by sender, subject or mail contacts 

It is very difficult to search in the lengthy email messages. You can easily search messages in 
outlook using find option. 

Go to Tools < Find < Find or press Ctrl+E

Select Inbox from the drop down menu of “Search In” 
In “Look for” we type the word we want to search
Click on “Find Now”

We can restrict our search to sender
name, email subject or email id etc by 
using advance search option.

Go to Tools < Find < Advanced find or 
press Ctrl + shift + F 
Enter the words you need to search
for and restrict the search to the 
selected field from the drop down 
menu.

8- Create a folder 

It is good to organize messages in 
different folders. Email program usually save messages
in separate folders. You can create as many folders you 
want.

To create a new folder

Go to File < New < Folder… or press Ctrl+Shift+E 
Enter the name of new folder
Select the type of content folder will contain and 
location.

9- Move messages to folder 

To save a message in a new folder 

Select the message in the inbox
Go to Edit < Move to folder or press Ctrl+Shift+V
Select the folder where you want to move the message
and click on the Ok button.
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10- Sort messages 

We can sort email message by date, subject and sender name. Let us sort these messages by 
date wise.
Open inbox and go to View < Arrange by < Date 
Using from option we can sort email messages according to sender.
Using To option we can we can arrange messages ascending to recipient’s name.
We can sort email messages in ascending or descending.

11- Delete a message 

You can easily remove any message. Right click on the message you want to delete from inbox
and select Delete from the menu. Email message will be deleted from inbox right away and sent
to folder “Deleted items”.

12- Undelete a message from mail bin 

You may delete important message. When you delete a message, it is moved from inbox to 
deleted items folder. Open “Deleted items” folder and right click on the message you want to 
undelete. Select “Move to folder” option and select Inbox.

13- Empty mail bin

Messages you delete are saved in Deleted items folder.
To delete one message from the Delete items folder, select the message and click on the cross
icon (Delete button) 
Message will ask for the confirmation for deleting the message. Click Ok to delete this message
permanently.
To empty the folder, right click on the “Deleted Item” folder and select “Empty Deleted Items” 

14-Summary:

In this lesson we have learnt:
How to create a new address list and add or delete mail address in it? 
How to search a message by subject and a sender and mail contents?
How to create a new folder and how to move messages to a new folder?
How to sort and delete the messages?
How to undelete the deleted messages and how to empty delete item folder? 

15-Exercise

In the coming exercise you can improve the appearance and usefulness of your printouts by 
changing the page margin, specifying a target print area, adding headers and footers. You will
also learn how to take printout of your worksheets

Task 1:
Select a print range :
In monthly expenses worksheet, select range from A1 to B6. Open file menu and point to 
print area and select click on Set Print Area on submenu. Click Print preview on toolbar to
view the print range. Click on close button on print preview toolbar. To clear print range
open file menu. Point to print area and click on Clear Print Area on submenu.

Task 2:
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Insert and Remove Page breaks :
With monthly expenses still open, to print items name on one page and expenses on
other page select column B and C. Open Insert menu and select Page break. A dotted
line is shown after column A. Click on print preview icon and you will see the names of 
items on page 1. Click on Next button on toolbar to view the next page. You will see
expenses on the next page. Click close button on toolbar and open Insert menu. Choose
Remove page break from the menu to clear the page breaks.

Task 3:
Setting orientation, Margins and center worksheet on a page :
In monthly expenses worksheet, open file menu and click page setup option. Click on
page tab and choose landscape from orientation section. Set print quality to highest
option. Click Margin tab and set top margin and bottom margin to 1.25. Click horizontally
and vertically options in center on page section of page setup dialog box. Click print
preview button.

Task.4:
Create a header and footer : 
Open monthly expenses Worksheet and select sheet1 and sheet 2 tabs. Open view
menu and choose the option header and footer. Click on customer header option and
then click in center section. Click sheet icon from toolbar which is third last icon on
toolbar. Then press ok button and then click on customer footer. Click in center section.
Type page and click on # icon in toolbar, then type “of” and click on plus sign in toolbar.
Click ok button and then click on print preview button. Sheet1 is shown on top and page 1
at bottom, click on next icon on print preview toolbar and you will see sheet2 on top of 
page.

Task.5:
Applying and printing formula used in Cells :
Open any spreadsheet in which formulas are used. Click on tools menu and then on
options. In dialog box, click view tab and then select formula option in windows options
section. A checkmark will appear in front of formula and finally click ok button. You will 
see formula within the cells Click file menu and select page setup Click on landscape
option in orientation section and fit in scaling section. Click print preview button, then click
zoom button to adjust the view. Click print button and ok. Finally press Control + ~ keys 
to deselect formula option.

Task.6:
Previewing and printing multiple sheets :
Open a spreadsheet in which sheet 1, sheet 2 and sheet 3 contains some data.  To print
all three sheets at once first click on sheet 1 tab. Hold the shift key and click on sheet 2
and sheet 3 tab. Click print preview button. Click zoom button to magnify image. Click 
next button on toolbar two times to cycle through three selected sheets. Click print button 
in print preview window and then click ok.

Task.7:
Hide some columns and rows in WS :
Open an already created spreadsheet. Since you want to print a report that does not
include column C. Right click on column C heading and click hide. Click on print preview,
column C is not shown so print the worksheet. To again display the hidden column C first
select Col B and D. Right click on the selection and click unhide. Column C will be shown
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